
Welcome! 

  

  

Welcome to the documentation hub for eM Client, a fully-featured email client for 
Windows and macOS. 

eM Client also offers features for calendars, tasks, contacts, notes, and chat in one seamless 
package for professionals and home users alike. 

The documentation material describes and explains everything about eM Client - from getting 
started, accounts management and settings, through the entire functionality, to advanced features. 

  

  

Where to begin  

  

• What's New - Check out the list of new features for this version of eM Client. 

• Key Features - Take a look at some of the features that are unique and important. 

• Tour of the Interface- Become familiar with eM Client's user interface first-hand. 

• Getting Started - Now that you downloaded and familiarized yourself with eM Client, get 

started. 

  

Boost your email and skyrocket your productivity with eM Client! 
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What's New  

The list of implemented features is constantly growing. Here are just a few new features that have 
been added in version 8.2:  

  

General 

- Support for showing only the fields that are supported by a particular service vendor, all across 
the application 

- New option to disable the 'Unsubscribe' link 

- Search filter when selecting a folder, for faster navigation and better folder management 

- Snooze the update checks  

  

Email 

- Giphy support, new Emoticons and beautiful new eM Stickers 

- Change 'Reply-to' address 

- Change the format of an email (plain text / HTML) 

- New rules options and conditions for the ‘From’ field 

- 'Change spellcheck language' button is available as an optional toolbar menu now 

  

Calendar 

- New invitation design 

- 'Reply'/'Reply all'/'Forward'/'Send email' to all attendees of an event 

- Visual tweaks and rewritten large DPI/small monitors logic in Calendar 

  

Online Meetings 

- Connect eM Client with your favorite videoconferencing tools (Zoom, MS Teams, Google Meet). 

- Set new Online Meetings in your Calendar with one click, and invite your contacts thanks to the 
new integration with Zoom, MS Teams and Google Meet 

- Choose an online meeting instead of a standard event when you create a new event.  

- eM Client is also able to detect (some) online meeting links in invitations 

  

Improved cloud storage attachments support 

- Upload attachments from eM Client directly to your cloud storage 

- Cloud attachments can be listed as regular attachments in eM Client so you can view and manage 
them easily 

- Toggle between read only and editable mode for documents of supported providers (for .rtf, .doc, 
.docx, .xls, .xlsx, .ppt, and .pptx files) 

- Add password protection to your files 

- Set an expiration date for your files 

- Manage cloud storage services in eM Client settings 

  

And much more 
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Key Features 

  

eM Client’s key features offer a unique mix of functionality for efficient work and communication, 
suitable for individuals as well as for teams. 

  

Email 

  

This product is first and foremost an Email client, it supports all the standards email servers, and 
provides you with all the functionality of a modern Email client. In addition it also provides you with 

innovative ways to organize and explore your Email communications with tools such as the Sidebar. 
Moreover eM Client enables you to view your messages in three different conversation modes, to 

learn more about them go to Conversations. 

  

Rules 

One of the most important and powerful tools which will help you organize and manage your Emails 

is the use of Rules. Rules are a set of logical conditions acting as filters; with Rule Based Filtering 

you can construct rules containing various conditions to separate and categorize all your incoming 
Emails according to their origins, subjects and time stamp; and apply different actions to each 
incoming Email accordingly, such as blocking spam mails or moving them to different locations. 

Follow these links to find out more about Rules, how to construct rules, or how to apply rules. 

  

Contact Managing 

One of the staple roles of most modern Email clients is to act as a virtual contact book for all your 

contacts. This product being more than "most modern Email clients" takes the role of virtual contact 
book several steps further. Following its commitment to be the communications center for its users, 
the application has the ability to merge your email contacts with your chat contacts, creating a 
unified roster of contacts. And based on this central roster, this product parses all your emails and 
IM messages and recompiles them into communications history logs for each contact. This way you 
can read all your email and IM chat exchanges that have taken place between you and a particular 
contact in one chronological log, and all this is done in real time in the Sidebar. 

Follow these links to find out more about contacts, how to add new contacts, and the use of 

Communications History. 

  

Calendar 

This product's Calendar service is more than a simple calendar, it has the ability to maintain 
multiple types of calendar events, separating your professional and private engagements, keeping 
track of the different activities and aspects of your daily life. 

The Calendar has the additional ability to help you arrange meetings and activities with its 
integrated event invite system that can automatically send invitations to and collect responses from 
the participants of your events. 

Follow these links to learn more about the Calendar, how to use the Calendar or how to share 
your calendar events. 

  

Tasks 

While the Calendar can help you organize your daily activities, Tasks function can act as your 

virtual personal assistant and help you manage all your important daily tasks. Tasks will provide you 
information on your tasks and keep track of their progress. 

Follow these links to find out more about Tasks. 

../../../Content/Getting%20Started/Sidebar.htm#Communic


  

Chat 

The Chat tool will let you talk to all your contacts in all your Chat/Instant messaging networks, 
without leaving the interface. 

Find out more about Chat, file transfer, privacy management and more. 
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Shortcuts 

You can modify shortcuts by your own choice and preference. To learn how visit section Shortcuts 

in Settings section.  

  

F1 - Help  

F5 - Send and Receive + Refresh 

Ctrl + N - Create new Mail / Event / Task / Contact. Depends on the opened (selected) section. 

Alt+ N - Create new Mail / Event / Task / Contact. Depends on the opened (selected) section. 

Ctrl + P - Print 

Ctrl + S - Save As 

Ctrl + X - Cut 

Ctrl + C - Copy 

Ctrl + V - Paste 

Ctrl + A - Select All 

Ctrl + Shift + F - Find 

Ctrl + Shift + V - Move to Folder 

Ctrl + Shift + C - Copy to Folder 

Ctrl + D - Delete to Trash 

Delete - Delete to Trash 

Shift + Delete - Delete Permanently 

Ctrl + < - Previous Message 

Ctrl + > - Next Message 

Ctrl + R - Reply 

Ctrl + Shift + R - Reply All 

Ctrl + F - Forward 

Ctrl + Alt + F - Forward as Attachment 

Insert - Follow Up 

Ctrl + Q - Mark as Read 

Ctrl + U - Mark as Unread 

Ctrl + J - Move to Spam 

Ctrl + B - Select Contact dialog 

Tab - Go to Next Section 

Shift + Tab - Go to Previous Section 

Alt + S - Send Mail (in New Message Dialog) 

Alt + M - Hide Completed (in Tasks) 

Alt + C - Send and Receive + Refresh (in Mail) 

Ctrl + shift + 1 (2,3,4 ... ) Insert Quicktext according to the order you have set for 

your quicktexts.   

Ctrl + 1 (2,3,4 ...) Insert Signature to the order you have set for your signatures.   



  

Alt  - Go to Menu 

Alt + M - Go to Menu 

Alt + F - Go to File in Menu 

Alt + E - Go to Edit in Menu 

Alt + V - Go to View in Menu 

Alt + T - Go to Tools in Menu 

Alt + H - Go to Help in Menu 

  

In Calendar 

Home - Go to Today   

Page Up - Go to Previous Week  

Page Down - Go to Next Week 

Alt + Y - Go to Day View  

Alt + W - Go to Week View  

Alt + O - Go to Work Week View 

Alt + M - Go to Month View  

Alt + G - Go to Agenda 

  

In Contacts 

Alt + S - Phone List 

Alt + C - By Company 

Alt + L -  By Location 

Alt + U - Custom View 

Alt + B - Business Cards   

  



Getting Started 

First steps 

After you run eM Client for the first time, you will be asked if you want to import your data from 
other applications detected on your device (Mozzila Thunderbird, Windows live Mail, Microsoft 
Outlook etc.). Following screen will appear: 

  

 

  

Select an application from which you want the data to be imported and click on Next  

  

In the case of importing the data from Microsoft Outlook, please notice that data migration from 

IMAP4 servers will be synchronized automatically, but in the event of importing data from local 
servers (or if you choose to import from IMAP4 server locally), you can choose from importing up to 
5 types of data (icons in the upper right corner) - messages, calendars, tasks, contacts, tags. If you 
want to skip some of these five areas, just simply click on the icon and it will disappear.  

  

The process of importing data from other applications is similar to the one described above.  

  



Creating a New Account 

Account wizard will help you to easily create a new account, giving you all the necessary information 
to successfully complete the process in few steps. 

To learn more about creating a new account visit: Create New Account 
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Interface 

eM Client offers an industry standard environment that is found on most mainstream email clients, 
such as MS Outlook. This tried and true layout is well-arranged, easy-to-use and intuitive. 

This product's user interface consists of various sections: 

  

Left side panel: 

 

  

Menu and Toolbar: 

 

  



Central panel: 

 

  

At the top is the Menu and New button. From there, all the important functions can be accessed.  

Also at the top is the Main Toolbar which allows you to quickly take actions. 

 

  

On the left side panel is the list of Accounts, Favorite folders (link), and Local folders (link) and 

their folders/subfolders which you will use to navigate between all of your added accounts and 
saved data. This side panel is shown as the Mail View in the picture, but similar left side navigation 
panels occur for all the other services (Calendar, Contacts, Tasks, etc.) in eM Client as well. 

  

New in eM Client 8: The side panels contain icons and can be collapsed to save screen space! 

  

If you right-click on any folder (for example "Inbox") you will bring up the context menu, which 
gives you additional options. 



 

  

Show in new Window - This will open a new eM Client Window which is focused on the selected 

folder. Opening multiple windows in eM Client is useful for multi-tasking so you don’t need to switch 
back and forth between things in the application. 

New Folder - creates a new folder 

Rename - renames the folder 

Copy Folder - copies the folder to another location/account 

Move Folder - moves the folder and its contents to another location/account 

Delete - deletes the folder and its contents 

Mark All Message as Read - All messages in the folder will be marked as Read 

Apply Rule - runs a chosen rule on that folder 

Collapse All - will collapse the entire left side panel folder structure to save screen space 

Show - the folder will be shown in the left side bar 

Show if unread - serves for the situation when you do not want the particular folder to be displayed 

unless there are some unread messages. If there are none, the particular folder will be hidden 
under the More folder 

Hide - the folder will be hidden under the More folder 

Add to Favorites - the folder will be linked to the favorite folder  

Properties - Gives more information on the folder and allows for additional options/settings for that 

specific folder 

  

Navigation Panel 

The Navigation Panel can be found in the lower left corner of eM Client and allows you to navigate 
to different functions of the eM Client application. Based on the size of the left side panel and which 
customization options you chose, the display will show different icons representing each section. If 
an icon for a section doesn’t appear due to limited space, it still always be accessible by clicking on 
the three dots 



  

  

The Mail icon is used for navigating among your email folders and managing mail. 

 The Calendar icon provides you with access to your Calendar events. 

The Task icon provides you with access to your Tasks. 

The Contacts icon provides you with access to your Contacts. 

The Widgets icon can be used to access your Widgets. 

The Attachments icon can be used to access your Attachments. 

The Notes icon can be used to access your Notes. 

  

You can add or remove any of these items by right-clicking them and selecting the Customize 
Navigation Panel option. 

 

  

The central panel of the interface can display various contents according to which navigational 

bookmark you are currently working under in the left vertical panel. In this panel you can find the 
contents of your emails, your calendar events, your tasks or your contact details. 

  

Right Sidebar 



On the right hand side there is the Sidebar. It is a powerful tool in your communication toolbox. It 
provides dynamic contents which will help you manage your contacts, send instant messages, and 
make sense of your email communication. For a full description of what you can do with the Sidebar 
click here. 

  

Sidebar also contains Search bar: 

 

  

Using the search bar, you can simply search for your emails. A list of several useful command tools 
will appear in the context menu when you type a question mark in the search bar. 

Click on the pointing down arrow to bring up the context menu for search bar: 

 

  

Here you can select or deselect area or areas that you want to be searched. 

  

Context menu 

The Context Menu is a flexible and useful way to interact with the contents of the application. It is 
useful because you can depend upon it to provide you with the most appropriate options according 
to where you are in the program and what you are currently doing. 

Context menu is accessed simply by right-clicking on any desired item (email, calendar event, task 
etc.). A simple menu will pop up, contained within is a list of all the actions you can perform on the 
selected item. In the Context Menu left-click an action to select it. 



The content of the Context menu changes according to the type of the selected item or the location 
of your right-click. For instance email messages will have different options in their context menu 
than calendar events. Right click on an email would give you the option to reply to the email, 
whereas right click on a calendar event will give you the option to edit the event. 

  

Grouping 

This product allows you to group your items (messages, contacts etc.) in the central panel according 
to the column that is currently being used for sorting. This feature was designed to make navigation 
easier for you. It is enabled by default, but if you wish to disable it, just right-click the column 
header and choose Show in Groups from the context menu (the tick next to this option will have 

disappeared when you right-click the column headers again). 

 

  

You can configure your columns by clicking Columns Configuration - you will see the following 

window: 

 

  

If you click on Customize Current View, you will be redirected to the Mail tab of the Appearance 

section in Settings, where you can customize your appearance settings. 

  



You can easily expand / collapse all groups by right-clicking the group header and selecting Expand 
All Groups or Collapse All Groups from the context menu. 

 

  

Grouping also works for your Chat contacts listed in the Sidebar. 

  

You can simply apply your column configuration also to the other folders, just right-click the column 

header, choose Apply Column Configuration to Other Folders... from the context menu and then 

select the folders to which you would like the column configuration to be applied. 
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You can easily expand / collapse all groups by right-clicking the group header and selecting Expand 
All Groups or Collapse All Groups from the context menu. 

 

  

Grouping also works for your Chat contacts listed in the Sidebar. 

  

You can simply apply your column configuration also to the other folders, just right-click the column 

header, choose Apply Column Configuration to Other Folders... from the context menu and then 

select the folders to which you would like the column configuration to be applied. 
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Main menu and toolbar 



Toolbar 

 

  

Toolbar provides you with different quick-access options depending on which section of the 
application you are currently working in. When you are in the email section, the email toolbar is 
displayed, which provides you with quick access to various email operations. The same toolbar will 
provide you with different options to perform different operations when you are in calendar mode or 
task mode. 



Menu 

 

  

The Menu contains six further options- File, Edit, View, Message, Tools, and Help. 

Those further options can be brought up only by clicking on the menu button first.  

  

File 

 

  

Menu File has many items: 

Open - You can open a saved email (an eml file). 

Save as - You can save a chosen email to an eml file. 

Import - You can import data to the application. 



Export - You can export data from the application. 

Print - you can directly print your messages, calendar, events or contacts. 

Print Preview - brings up the preview where you can adjust many aspects of the final layout of 

the page about to be printed.  

Backup - You can backup your data. 

Restore - You can restore your data. 

Work offline - When you choose this setting, the application will work without connecting to 

Internet. If you send an email, it will be saved and it will be sent after connecting to Internet. 

  

Exit - If you click on this button, the application will be closed. 

  

Back to menu. 

  

Edit 

 

Menu Edit has many items: 

Undo - if you delete something, you can undo the operation of deleting. 

Redo - if you performed undo operation, you can now perform redo and the retrieved operation will 

be deleted. 

Copy - When you click on this button, it will make a copy of head and body of the selected email. 

Select all - All emails will be selected. 

Find - you can perform textual search - either simple, or you can specify advanced options for your 

search. 

 Clicking on Find option will bring up: 

  

Advanced Search Window 

Advanced search represents a smart utility that enables you to search with predefined rules which 
will filter out particular emails from the global folders, i.e. folders where all your emails are stored. 

As you can see in the picture, search window consists of two parts: textual form of query and the 
visual form of query.  



 

  

To learn more about working with search queries and about creating a filtered folder see  

Global Folders - > About Search Folders 

Find in Body - Use find in Body do find particular words within the selected email,  

  

Back to menu. 

  

  

View 

 

  

Menu view has many items: 



Columns... - You can select columns which you want to see in the list of emails. You can also 

change the order of columns. 

 

  

Layout - You can change position of the panel with messages - Messages on the bottom, Messages 

on the right, Messages panel off.  

Sidebar- You can change layout of the sidebar. 

Conversations - Enables you to customize and specify conversations. 

Previous message - The selected item is changed to previous message. 

Next message - The selected item is changed to next message. 

  

Message 

  



 

Actions menu differs according to the section where you currently are (mail, calendar, tasks, 
contacts etc.) 

  

Actions Menu has several items: 

Reply... - When you click on this button, you will reply to a selected email. 

Reply All... - When you click on this button, you will reply to all people in a selected email. (for 

example to people in CC) 

Forward... - You can send a selected email to another person. Moreover you can choose from 

three actions: Forward... (Ctrl+F) Forward as Attachment... (Ctrl+Alt+F) and Forward as Original... 

Follow Up - by clicking this, you will add a flag to your message (event etc.) - for example to 

mark the emails you need to reply to etc. 

Categorize - you can choose a color tag that will be added to the message (contact, event ...) 

Mark as Read... - You can mark your unread email as read. 

Mark as Unread... - You can mark your email as unread. It is useful when you read an email but 

you don't have a time to answer it so you can mark it as unread. 

Mark All as Read - You can mark all your emails as read.  



Move to Junk - You can select from three options: Move to Junk, Move to Junk and blacklist 

email, Move to Junk and blacklist domain.  

Move to Folder... - You can move a selected item to another folder. 

Copy to Folder… - You can copy a selected item into another folder.  

Download Selected - You can download selected items. 

Create Meeting from Message - You can create a meeting directly from the message. 

Create Task from Message - You can create a task directly from the message.  

Delete - Deletes the message. 

Empty Trash - Empties the trash. 

  

 Back to menu. 

  

Tools 

 

  

Menu Tools has many items: 

Subscribe to Internet Calendar…  You can set up a calendar access directly from here. 

Operations - You can bring up the Operations window.  

 

  



Contacts... - Clicking on contacts... will bring up the Address Book (see below). This feature can 

be used for selecting the particular contact that you want to send a message to. Start writing 
contacts's initial letters to search for particular contact. 

  

 

  

Rules... - You create rules here. For example - Emails from Thomas - If you don't want to get 

emails from Thomas, you can simply filter them out. You can find further information about creating 

rules in the topic Rules. 



 

  

Tags... - Here you can manage your tags active in the eM Client. You can find more information 

about managing tags in the topic Working with Tags.  

  

Deduplicator... - Deduplicator is a tool which enables you to get rid of duplicate (multiple) items 

in following areas: mails, events, tasks, contacts. Click on Deduplicator to bring up following 

window:  

 

  

Select the item type and click on Next: 

  



 

  

Here you can select folders that will be searched for duplicate files and moreover you can specify 
whether you want to search for duplicates in each idividual folder or over a group of folders. When 
you are finished click on the Next button. 

  

 

  

Here specify the action to be done for duplicated items found. Click on Finish to finish the process.  



  

Settings... - When you click on this button, a window with settings will appear. You can find more 

information about settings in the topic Settings. 

  

Accounts... - When you click on this button, a window for working with the accounts will be 

displayed. You can find more information in the topic Accounts. 

  

In this window, you can authorize a chat contact or ignore it. 

  

Help 

 

  

Menu Help has several items: 

Contents - When you click on this button, a window with documentation to this product will 

display. 

License - here you can activate or deactivate your license. 

Check for Update - if you click on this option, the application will try to look for updates online. If 

an update is found a list of new features will be displayed and you will be prompted to confirm that 
you want to install the update. 

Get support - depending on the license you have (free or corporate) you will be redirected either 

to the forum (free licenses, forum.emclient.com) or to a support web page (corporate licenses, 
support.emclient.com). On the forum you can find posts from other users and on the support web 
page, you can submit a ticket with your problem and our programmers will preferentially try to 

solve it.  



Invite to eM Client - when you click on this button, a window with invitation to eM Client for your 

friends will appear. You can invite them using: email, Twitter or Facebook.  

About - You can click on this button to see more information about this product. 

 

  

Back to menu. 

  

eM Client supports touch-operated devices 

  

eM Client now supports the touch-operated devices, if your device has such utility, you will be able 
to switch to touch-operated mode by clicking on the appropriate icon in the right upper corner of eM 
window: 

  

 

  

If you switch to the touch mode, all icons and features of the application will become a little larger 

in order to easily control the application. 

In the touch mode: 

1) You can scroll in all menus by touch movement (context menus etc.). 

2) In calendar view you can move in all directions by touching the screen. 

3) By the pinch-to-zoom action you can change the number of weeks displayed in the month view of 
the calendar as well as zoom in/out in the week view.  
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Sidebar 

The Sidebar will allow you to quickly access your contacts and their details, your communications 
history with a specific contact, list of tasks that you planned to do and a list of attachments 

exchanged between you and specific contacts. 

  

There are five sections that make up the Sidebar: Search Bar,  Contact details, Agenda, Chat 
and Invitations. 

Invitations are not displayed by default, but this section will display as soon as you receive an 
invitation.  

You can hide the Sidebar by clicking on the arrow near the right edge of the bar. 

 

Just click on the arrow to hide the sidebar. 

Search Bar  

Using the search bar, you can simply search for your emails. A list of several useful command tools 
will appear in the context menu when you type a question mark in the search bar. 

 

  

Click on the pointing down arrow to bring up the context menu for search bar: 

  

 



  

Here you can select or deselect area/areas that you want to be searched.  

  

Contact Details 

 Contact Details window provides you with quick access to contact details of a selected contact that 

include your contact's email address, mobile/telephone number, skype contact details, and chat 
message contacts.  

  

 

  

  

Search Bar - Just start typing and search bar will appear. While using the search bar, you can 

search for all types of messages (i.e. mails, chat messages) that you have exchanged with 
your contact in the past. You can switch between History and Attachments by simply 
clicking on the proper button. 



 

  

 History panel is called so because it gathers all your written conversations with 
the contact. It includes Emails, IM Chat messages and also Skype chat messages into one 

chronological communications log. And thereby provide you with a holistic sense of your 
communications with that particular contact. 

Attachments panel contains all the attachments that are attached in the 

emails exchanged between you and the contact. Attachments are sorted in a chronological 
order, which you can customize(ascending/descending) in the Attachment history Options.  

  

Contact Details settings -You can customize your Contacts Details settings simply by left-

clicking on the Options button. This options button  will appear by hovering with your mouse 

cursor over the area next to the Contact Details header. You can choose the manner in which you 
would like to sort the order of the messages (descending/ascending) and you can also adjust what 
type of messages (mails, chat messages, skype calls) you would like to display or hide. By checking 
the option Include Other Senders you can adjust if you want to include the third party of the 

conversation (f.e. emails , where other participants are included in Bcc or Cc of the particular email) 

and by checking the option Include Entire Domain you can adjust displaying of all emails that may 

have different name of sender/addressee, but the same domain in the particular email address. You 
can select Choose Folders... to select folders from which you would like the contacts to be 

displayed. 



 

  

  

  

Agenda Section 

Agenda section provides you a quick review of the tasks that you planned to do, upcoming 
birthdays, upcoming events and email messages marked as flagged. All those items are sorted in 

the order of the upcoming date, i.e. the most up-to-date items will be always on top.  

Search bar - you can use the search bar for searching within your tasks and events by simply 

starting to write and the search query will appear. Simply enter the "key word" of the item that you 

want to find and the requested item will appear.  

 

  

Adding new task - You can add new tasks directly from the sidebar. First and foremost, write the 

title of the new tasks in the field (lower arrow in the picture) and then press enter. Newly created 
task will appear in the "Date:Today" section. By double-clicking on the task the window with 
possible editing of the newly created item will appear. 

  

For creating and editing tasks see Tasks -> Creating and Editing Tasks for more detailed 

description.  

You can choose folders from which you would like to display upcoming events, birthdays, tasks and 
flagged emails, simply by left-clicking the down-pointing arrow on the left in the upper section of 



Agenda. Context menu will appear and your next step is choose the option Choose Folders... and a 

window with list of various folders will appear as you can see in the following picture.  

  

 

  

Moreover, you can choose the time horizon in which the displayed upcoming birthdays and events 
will be shown. This time horizon can be changed by selecting various points of time from the 

context menu, again the one which is evoked by the small arrow.  

  



 

  

Show of Flagged Mails, Upcoming Birthdays, Upcoming Events and Tasks is active by default.  

  

Contact list/Chat  

This product has built in Instant Messaging support , which will allow you to communicate instantly 

with other users of Jabber Instant Messaging network as well as many other Jabber compatible 
networks such as Google Talk, ICQ, AIM, Facebook, Live Messenger etc. This section allows you to 
view all your added contacts and chat accounts. You can also use the search bar for searching 
within your contact list. 

  

 

Search bar - You can search in your contacts by entering the first few letters (e.g. if you put in "d" 

you will see only those contacts that start with this letter). 

Chat Options - You can customize your chat settings simply by left-clicking on the Options icon 

which will appear by hovering with your mouse cursor next to the chat header. Here you can set up 



several chat options, for example showing/hiding avatars in chat, showing online users 
only or showing groups. You can also sort contacts either alphabetically or by online status. 

However, it is not possible to use groups together with the mode of sorting according to the online 

status. There has been added a special utility - Undock. You may be already familiar with this 

tool from previous versions of this product, where this action was invoked by Detach window 
button. The Undock utility works exactly the same way - by clicking this button you can 
detach the contact window and move it around your screen as you wish. To return it to its 
original position, just click the same button again, or click on the Return back button that 
appeared on the window's original location. When the window is detached, you can toggle 
Always on top to be able to use the window even if the application is minimized. Undock can 
be also evoked simply by pulling the chat header away.  

 

by clicking on the Add contact button you will be allowed to create a new contact - the following 

window will be displayed 

  

 

  

You can type-in a name that you would like to be displayed by the IM contact or you can click on 
Get button by which the application will try to retrieve the username based on the Jabber ID.  

You can also add newly created IM contact to the appropriate group by selecting it from the list of 
groups that you are currently using.  

  



You can move contacts between groups simply by drag-and-dropping them, or by right-clicking the 
contact you wish to move and selecting the group you want to move the contact into from the 
context menu. You can also create a new group and move the contact into it.  

 

  

 

  



 

Click on any contact in the Contacts window and you will find all the details on the selected contact 

displayed in the Contact details window.    

  

For more detailed description of IM see section Instant Messaging. 
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Creating a New Account 

  

 

  

When setting up a new account, you can choose from several options: 

- Automatic setup - In most cases eM Client enables you to set up your account automatically 

with just two simple steps - entering your email address and the password. We strongly recommend 

using this method of setting up your account unless you possess thorough details about your 
account's settings. The first step is typing in the email address of your existing email account as 
well as the account password. The rest of the automatic setup is realized in 3 steps: 

• server settings for pre-defined service providers  

• try to use Auto-discover protocol   

• try to detect server setting by special heuristics 

  

- Connecting to standard email servers: eM Client will attempt to automatically retrieve the 

server settings (this works for the most frequently used email servers i.e. Gmail, Yahoo etc.) 

  

- Auto-discover technology: If eM Client is unsuccessful with the first attempt, it will try to use 

the so called auto-discover technology, which basically tries to assess the predefined credentials of 
email servers. This service is fully automatic and it can autonomously detect the settings if the 
correct email information is provided. 

  



- Predicting less usual email servers: In this case, the application tries to search for access 
to your account details on the internet, it works on predicting how the address of your email 
provider is realized. (For example, this service will be utilized in the cases when a private 
company's email addresses will be prompted to set up.) 

  

If all three services fail you will be prompted to specify the settings manually. Learn more about 

setting up email manually here.  

  

Automatic Account Setup 

Step 1 - Account Details 

In this dialogue you can enter additional information regarding your new account, such as the 
account name and the name that you would like to be displayed in the "From" field of your outgoing 
messages. 

 

  

Step 2 - Set up Encryption (optional) 

Next you’ll be asked if you want to set up PGP encryption [link] for your account. This is an 

advanced feature which encrypts your emails to provide better security and privacy. If you would 
like more information on how to set up encryption, you can read about it here. Otherwise, simple 
click “Continue without encryption” to continue setting up your account. 



 

  

  

Step 3 - Finishing up 

Here you can enable/disable services for this account (Mail, Calendar, Contacts, Chat). These 

settings can be changed at any time in Menu > Accounts 

Depending on if you chose a POP3 or IMAP incoming server, the final options will 
change. 

Sync Options allows you to choose if you’d like to download messages so you can read your 

previously received emails even when you’re not connected to the internet (you will still need to 
reconnect to the internet in order to receive new messages) and you can choose if you’d like the 
search option to also work for your email attachments. 

Finally, you can click on the Finish button to start using the application with your newly added 

account. 

  



 

  

Setting up particular email addresses: 

In this section, you can select particular email accounts that you would like to set up. The first five 
email providers displayed will always be the most used ones in the location where you currently are. 
These five displayed providers will also always have predefined configuration and their server 
settings will be retrieved automatically.  

  



 

  

Manual Account Setup 

In case the automatic setup didn’t work or your email provider isn’t shown, click on the Other 
button to manually set up a different email account. In this case, the setup will be a little more 
complex. It’s performed in seven steps and you will be asked to fill in all the email settings. You can 
find out your account’s server settings by asking your email provider. 

  

Step 1 - Identity: 

Enter your email address to begin. 



 

  

  

Step 2 - Account type and incoming server information 

Select if your incoming mail server type should be POP3 or IMAP. 

Enter your incoming mail server address. 

Enter your username (usually either the whole email address or just the part before the @ sign 
depending on the provider) and your email account password. 



 

  

  

Step 3 - Outgoing server information 

Enter your outgoing mail server address. This section could be prefilled based on what you entered 
for your incoming mail server, but it's possible that you’ll need to change it to something else 
depending on the provider. 

Your username and password will also be prefilled based on your answers in Step 2. Usually the 
credentials stay the same. 



 

  

Step 4 - Testing configuration 

During this step, your configuration will be tested. If your account details were typed in correctly, a 
green checkmark will appear. If there are some problems with the configuration (for example if your 
password was not entered correctly), a red cross will be displayed (as you can see in the picture). 
You can always change your configuration by clicking on the Fix button. 



 

  

Step 5 - Adding additional information about your new account: 

In this dialogue you can enter additional information regarding your new account, such as the 
account name and the name that you would like to be displayed in the "From" field of your outgoing 
messages (e.g. jerry@x1solar.com) 



 

  

Step 6 - Set up encryption (optional) 

Next you’ll be asked if you want to set up PGP encryption [link] for your account. This is an 
advanced feature which encrypts your emails to provide better security and privacy. If you would 
like more information on how to set up encryption, you can read about it here. Otherwise, simple 

click “Continue without encryption” to continue setting up your account. 



 

  

Step 7 - Finishing up 

Account avatar - Choose which image you’d like to have to represent your newly added account. 

You can choose from one of our default avatar images or select your own custom image by 

uploading it from your computer. 

  

Depending on if you chose a POP3 or IMAP incoming server, the final options will 
change. 

  

POP3 option: 

On this final screen you can specify if you want the application to create a separate folder tree for 
the messages for your POP3 account, or if the messages should be stored in Local Folders. 



 

  

IMAP option: 

Sync Options allows you to choose if you’d like to download messages so you can read your 
previously received emails even when you’re not connected to the internet (you will still need to 
reconnect to the internet in order to receive new messages) and you can choose if you’d like the 
search option to work for your email attachments. 



 

Setting up Chat 

Generally, two chat services are supported - you can set up two predefined services Google Talk, 

and generic XMPP/Jabber (both based on XMPP protocol). 

  



 

  

 XMPP/Jabber 

  

You can add an XMPP/Jabber account to eM Client in five easy steps. 

  

Step 1 - You can register a new Jabber account or use an existing account. 

Select "Use existing Jabber account" if you already have a Jabber account registered. 

Select "Register new Jabber account" if you have no Jabber account yet. An account will be 
registered for you on one of the public Jabber servers. 



 

  

Step 2a - Register a new Jabber account - Select a Jabber Server Host from the list. 

Since the Jabber protocol is hosted by decentralized servers much like IRC, you will be asked to 
select a host server to connect to. 

Tip: eM Client will suggest a list of free Jabber Hosts, however you can type in any 
Jabber hosts you prefer. Note, different Jabber hosts offer different transports to 
different networks. 



 

  

Step 2b - Enter your Username and Password. 

Once the Jabber server registration succeeds, you will be asked to provide a username (has to be 
unique) and a password. Once the username and password are accepted, click next to finish the 
registration (skip to step 4). 



 

  

Step 3 - Using an existing Jabber account - enter the Jabber ID 

Enter your Jabber ID and password. If you enter your Jabber ID as an email address, the system 
will attempt to generate your likely server host and username. These can be changed manually now 
by unchecking the “Automatically detect server host and username box” or later in your Account 
settings. 



 

  

Step 4 - Account Details 

The account name is the name that you would like to be displayed in the "From" field of your 
outgoing messages 



 

  



Step 5 - Finish - click Finish to complete the new Jabber account. 

 



  

Setting up your Calendar 

 

CalDAV / CardDAV 

  

CalDAV is a calendar sharing service and CardDAV allows you to share your contacts. In order to set 
up a CalDAV / CardDAV account, you first have to have a CalDAV / CardDAV account on your mail 
server (e.g. IceWarp eMail server). 

Enter the account name, password and its internet location, and you are done! 



 

  

Setting up Contacts 

Here you can set up synchronization with your Google contacts, Yahoo contacts, iCloud Contacts 
and Fruux Contacts. Please note that, in the case of Google, it's Google's native technology, 
whereas in the case of Yahoo and others, this service works on CardDAV technology. 
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Accounts 

  

If no existing accounts are detected, the account wizard will appear automatically, as you can see in 
the following picture. 

  

 

  

Otherwise, the path to create a new account is Menu -> Accounts and then click on New account... 

button.  

  

To add a new account click on Menu and on the drop-down menu select Accounts. You will 
see the following account management window. 



 

  

Here you can create new accounts, delete existing accounts or select your default account. 

  

Please note the two arrows just under the list of accounts. These can change the order of 
accounts which will affect the order of the folders in the main window on the left.  

  

Create a new account  

Click on New account to create an email, Google, CalDav or Jabber account. You can read more 

about creating new accounts in the section: Create New Account . 

  

Account Avatars 

On the right side of your account details you can see an avatar. Account avatars will help you 
determine which email account your messages belong to in mixed views or search results. You can 
also use them for quick navigation when using minimized left pane.  

For more details on how to change the avatar please go to Create New Account . 

  

Delete an existing account 

To delete an account, select the account you wish to delete and click on Delete account button 

. You will be prompted to confirm the deletion.  



  

This action can endanger your data in case of POP accounts. 

POP protocol downloads messages from your server into your device and deletes them from the 

server - this means that deleting this account from your device might delete the only copy of your 
messages. 

We suggest making a backup or exporting your messages before deleting a POP account. 

  

IMAP and Exchange Web Services accounts synchronize data with the mail server, removing 

these accounts is therefor safe. 

  

Set a default account 

Select the account you wish to be set as your default account and click on Set as default 

. The default account will be active when the application starts.  

Default account will be used when a specific account cannot be detected for use. This means the 

Default account will be applied to new messages, contatcs, events, etc. when the focus is set in 
Smart folders or Local folders. 

If you default account does not have its own Calendar and Contacts services you can specify default 

folders in the General tab of the Default account. 
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Accounts 

  

If no existing accounts are detected, the account wizard will appear automatically, as you can see in 
the following picture. 

  

 

  

Otherwise, the path to create a new account is Menu -> Accounts and then click on New account... 

button.  

  

To add a new account click on Menu and on the drop-down menu select Accounts. You will 
see the following account management window. 



 

  

Here you can create new accounts, delete existing accounts or select your default account. 

  

Please note the two arrows just under the list of accounts. These can change the order of 
accounts which will affect the order of the folders in the main window on the left.  

  

Create a new account  

Click on New account to create an email, Google, CalDav or Jabber account. You can read more 

about creating new accounts in the section: Create New Account . 

  

Account Avatars 

On the right side of your account details you can see an avatar. Account avatars will help you 
determine which email account your messages belong to in mixed views or search results. You can 
also use them for quick navigation when using minimized left pane.  

For more details on how to change the avatar please go to Create New Account . 

  

Delete an existing account 

To delete an account, select the account you wish to delete and click on Delete account button 

. You will be prompted to confirm the deletion.  



  

This action can endanger your data in case of POP accounts. 

POP protocol downloads messages from your server into your device and deletes them from the 

server - this means that deleting this account from your device might delete the only copy of your 
messages. 

We suggest making a backup or exporting your messages before deleting a POP account. 

  

IMAP and Exchange Web Services accounts synchronize data with the mail server, removing 

these accounts is therefor safe. 

  

Set a default account 

Select the account you wish to be set as your default account and click on Set as default 

. The default account will be active when the application starts.  

Default account will be used when a specific account cannot be detected for use. This means the 

Default account will be applied to new messages, contatcs, events, etc. when the focus is set in 
Smart folders or Local folders. 

If you default account does not have its own Calendar and Contacts services you can specify default 

folders in the General tab of the Default account. 
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Creating a New Account 

  

 

  

When setting up a new account, you can choose from several options: 

- Automatic setup - In most cases eM Client enables you to set up your account automatically 

with just two simple steps - entering your email address and the password. We strongly recommend 
using this method of setting up your account unless you possess thorough details about your 
account's settings. The first step is typing in the email address of your existing email account as 
well as the account password. The rest of the automatic setup is realized in 3 steps: 

• server settings for pre-defined service providers  

• try to use Auto-discover protocol   

• try to detect server setting by special heuristics 

  

- Connecting to standard email servers: eM Client will attempt to automatically retrieve the 

server settings (this works for the most frequently used email servers i.e. Gmail, Yahoo etc.) 

  

- Auto-discover technology: If eM Client is unsuccessful with the first attempt, it will try to use 

the so called auto-discover technology, which basically tries to assess the predefined credentials of 
email servers. This service is fully automatic and it can autonomously detect the settings if the 
correct email information is provided. 

  



- Predicting less usual email servers: In this case, the application tries to search for access 
to your account details on the internet, it works on predicting how the address of your email 
provider is realized. (For example, this service will be utilized in the cases when a private 
company's email addresses will be prompted to set up.) 

  

If all three services fail you will be prompted to specify the settings manually. Learn more about 

setting up email manually here.  

  

Automatic Account Setup 

Step 1 - Account Details 

In this dialogue you can enter additional information regarding your new account, such as the 
account name and the name that you would like to be displayed in the "From" field of your outgoing 
messages. 

 

  

Step 2 - Set up Encryption (optional) 

Next you’ll be asked if you want to set up PGP encryption [link] for your account. This is an 

advanced feature which encrypts your emails to provide better security and privacy. If you would 
like more information on how to set up encryption, you can read about it here. Otherwise, simple 
click “Continue without encryption” to continue setting up your account. 



 

  

  

Step 3 - Finishing up 

Here you can enable/disable services for this account (Mail, Calendar, Contacts, Chat). These 

settings can be changed at any time in Menu > Accounts 

Depending on if you chose a POP3 or IMAP incoming server, the final options will 
change. 

Sync Options allows you to choose if you’d like to download messages so you can read your 

previously received emails even when you’re not connected to the internet (you will still need to 
reconnect to the internet in order to receive new messages) and you can choose if you’d like the 
search option to also work for your email attachments. 

Finally, you can click on the Finish button to start using the application with your newly added 

account. 

  



 

  

Setting up particular email addresses: 

In this section, you can select particular email accounts that you would like to set up. The first five 
email providers displayed will always be the most used ones in the location where you currently are. 
These five displayed providers will also always have predefined configuration and their server 
settings will be retrieved automatically.  

  



 

  

Manual Account Setup 

In case the automatic setup didn’t work or your email provider isn’t shown, click on the Other 
button to manually set up a different email account. In this case, the setup will be a little more 
complex. It’s performed in seven steps and you will be asked to fill in all the email settings. You can 
find out your account’s server settings by asking your email provider. 

  

Step 1 - Identity: 

Enter your email address to begin. 



 

  

  

Step 2 - Account type and incoming server information 

Select if your incoming mail server type should be POP3 or IMAP. 

Enter your incoming mail server address. 

Enter your username (usually either the whole email address or just the part before the @ sign 
depending on the provider) and your email account password. 



 

  

  

Step 3 - Outgoing server information 

Enter your outgoing mail server address. This section could be prefilled based on what you entered 
for your incoming mail server, but it's possible that you’ll need to change it to something else 
depending on the provider. 

Your username and password will also be prefilled based on your answers in Step 2. Usually the 
credentials stay the same. 



 

  

Step 4 - Testing configuration 

During this step, your configuration will be tested. If your account details were typed in correctly, a 
green checkmark will appear. If there are some problems with the configuration (for example if your 
password was not entered correctly), a red cross will be displayed (as you can see in the picture). 
You can always change your configuration by clicking on the Fix button. 



 

  

Step 5 - Adding additional information about your new account: 

In this dialogue you can enter additional information regarding your new account, such as the 
account name and the name that you would like to be displayed in the "From" field of your outgoing 
messages (e.g. jerry@x1solar.com) 



 

  

Step 6 - Set up encryption (optional) 

Next you’ll be asked if you want to set up PGP encryption [link] for your account. This is an 
advanced feature which encrypts your emails to provide better security and privacy. If you would 
like more information on how to set up encryption, you can read about it here. Otherwise, simple 

click “Continue without encryption” to continue setting up your account. 



 

  

Step 7 - Finishing up 

Account avatar - Choose which image you’d like to have to represent your newly added account. 

You can choose from one of our default avatar images or select your own custom image by 

uploading it from your computer. 

  

Depending on if you chose a POP3 or IMAP incoming server, the final options will 
change. 

  

POP3 option: 

On this final screen you can specify if you want the application to create a separate folder tree for 
the messages for your POP3 account, or if the messages should be stored in Local Folders. 



 

  

IMAP option: 

Sync Options allows you to choose if you’d like to download messages so you can read your 
previously received emails even when you’re not connected to the internet (you will still need to 
reconnect to the internet in order to receive new messages) and you can choose if you’d like the 
search option to work for your email attachments. 



 

Setting up Chat 

Generally, two chat services are supported - you can set up two predefined services Google Talk, 

and generic XMPP/Jabber (both based on XMPP protocol). 

  



 

  

 XMPP/Jabber 

  

You can add an XMPP/Jabber account to eM Client in five easy steps. 

  

Step 1 - You can register a new Jabber account or use an existing account. 

Select "Use existing Jabber account" if you already have a Jabber account registered. 

Select "Register new Jabber account" if you have no Jabber account yet. An account will be 
registered for you on one of the public Jabber servers. 



 

  

Step 2a - Register a new Jabber account - Select a Jabber Server Host from the list. 

Since the Jabber protocol is hosted by decentralized servers much like IRC, you will be asked to 
select a host server to connect to. 

Tip: eM Client will suggest a list of free Jabber Hosts, however you can type in any 
Jabber hosts you prefer. Note, different Jabber hosts offer different transports to 
different networks. 



 

  

Step 2b - Enter your Username and Password. 

Once the Jabber server registration succeeds, you will be asked to provide a username (has to be 
unique) and a password. Once the username and password are accepted, click next to finish the 
registration (skip to step 4). 



 

  

Step 3 - Using an existing Jabber account - enter the Jabber ID 

Enter your Jabber ID and password. If you enter your Jabber ID as an email address, the system 
will attempt to generate your likely server host and username. These can be changed manually now 
by unchecking the “Automatically detect server host and username box” or later in your Account 
settings. 



 

  

Step 4 - Account Details 

The account name is the name that you would like to be displayed in the "From" field of your 
outgoing messages 



 

  



Step 5 - Finish - click Finish to complete the new Jabber account. 

 



  

Setting up your Calendar 

 

CalDAV / CardDAV 

  

CalDAV is a calendar sharing service and CardDAV allows you to share your contacts. In order to set 
up a CalDAV / CardDAV account, you first have to have a CalDAV / CardDAV account on your mail 
server (e.g. IceWarp eMail server). 

Enter the account name, password and its internet location, and you are done! 



 

  

Setting up Contacts 

Here you can set up synchronization with your Google contacts, Yahoo contacts, iCloud Contacts 
and Fruux Contacts. Please note that, in the case of Google, it's Google's native technology, 
whereas in the case of Yahoo and others, this service works on CardDAV technology. 
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Edit existing accounts 

  

Editing an existing Account 

  

General 

 

  

In the Account name field, enter a label for the account. It will not appear on your outgoing 

emails, and is useful if you have multiple accounts. 



In the Name field, enter the name which will be displayed in your outgoing emails and will be seen 

by their recipients.  

In the Email field, enter your email address. 

Click Aliases.. to manage both your server-set aliases or to manually add those that this account 

can use. You will then be able to select these aliases as a From email address. 

 

In the Login name, enter your login name for that account. 

In the Password, enter your password for that account. 

  

Select folder for incoming scheduling messages by clicking on Select... button and choosing arbitrary 

folder. Please, note that this option of "Scheduling", which defines where scheduling messages will 
be saved, will appear in the General section of editing an existing account only when you have not 
set up a calendar account within your account (this is, for example, the case, when you have set up 
only a Mail account). If you have set up a calendar account, this option will appear in the Calendar 
and Contacts section and will be named "Default calendar". 

The box "Include when sending/receiving mails" is checked by default, you can uncheck it to 

temporarily stop using the account (though IMAP and EWS messages will still update when the 
server sends any new information). 

You can enable/disable the account by (un-)checking the specific services in the Services section. 

  

  



SMTP 

 

  

In the Host field, enter the address of your outgoing server. 

In the Port field, specify the port number to be used by the SMTP protocol. Default is port 25 . You 

can read about email protocols in Advanced Information. 

In the Security policy field, select a security protocol. Read more about Security Protocols. 

Select Authentication method: Use Identity credentials or manually fill in user name and 

password. 

  



IMAP 

 

In the Host field, enter the address of your incoming server. 

In the Port field, specify the port number to be used for IMAP protocol. Default is Port 143. You can 

find out more information on Email protocols in Advanced Information. 



In the Security policy field, select the type of security protocol the server uses. For more 

information, check out Security Protocols. 

Select Authentication method: Use Identity credentials or manually fill in login name and 

password. 

You can select Download messages for offline use to download email messages to your computer 

when you are connected to the internet, making the emails fully readable when you work offline.  

Checking the option Include attachments and images will download not only the messages but also 

the attachments and images for use while offline. 

By checking Automatically detect special folder names the folder names for incoming emails will be 

detected automatically. You can also enter your custom settings into the following fields: Sent, 
Draft, Trash, Junk.  

  

POP3 

 

  

In the Host field, enter the address of your incoming server.  



In the Port field, specify the port number you want to use with the POP3 protocol. Default port 

number is 110. You can find more information on email protocols in Advanced Information. 

In the Security policy field, select the type of security protocol you wish to use. Find out more 

about Security Protocols. 

Authentication - select between using your account credentials, or manually filling in the user 

name and password. 

Server settings 

Leave a copy of messages on the server - eM Client will keep a copy of your emails on the 

server after downloading them into your computer. 

Remove from server after x days - when checked, eM Client will remove your emails from the 

server after a specified number of days after they are downloaded to your computer. 

Remove from server when deleted from "Deleted" folder - your emails will be removed 

from the server when you delete them from the Deleted folder.  

  

Tip: For POP3 Email users, it is safer to have the "Leave a copy of messages on server" box 
checked. Make sure that you check the space left in your mailbox from time to time. 

You can learn more about email protocols in chapter Email Protocols. 



  



Chat 

 

  

Server 

In the Host field, enter the address of the XMPP host server.  

In the Port field, enter XMPP service port value, you wish to be used. Default XMPP service port 

value is 5222.  

Authentication - Select between using your identity credentials, or manually filling in the 
user name and password. 

Check in SSL (Secure Socket Layer) if you want your messages to be encrypted. This should be 
checked if you want to keep your data secure. 

  



CalDAV/CarDAV 

 

  

CalDAV is the standard calendar and personal data sharing protocol. Read more about Calendaring 

Protocols. 

Server 

In the URL field, enter the CalDAV/CardDAV server address you want eM Client to synchronize your 

calendar with.  



Tip: For Gmail users, the URL address is 
https://www.google.com/calendar/dav/yourusername@gmail.com. 

Authentication 

Select a method of Authentication - Anonymous or manually specify login name and 

password. 

Folders 



Select the default calendar to which mail invitations to Events, Tasks and Contacts will be 
saved.  

Delegation 

This option will enable you to entrust other users with the privilege to share Calendar and Contacts 

with you. You can specify accounts you can access as well as users who can access your account.  



  



Diagnostic 

 

  

In this section you can verify your account settings and attempt to fix potential problems with the 
setup.  

The Diagnose button will prompt eM Client to try different Port settings to connect to your server. 

  

You can also specify for which of the following would you like to enable diagnostic logs: SMTP, IMAP, 
XMPP, CalDAV / CardDAV. 
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Settings 

eM Client offers a wide range of settings that allow users to customize even the most technical 
details under the hood and tailor the program to their preference. 

To access Settings, select Tools in the main menu and then select the Settings... option from its 

drop-down menu. 

The Settings window: 

  

 

  

Settings are divided into 10 section, while each of the sections contains several subsections. This 
change has been made for your easier orientation, while you are customizing your application:  

  

General: 

• General 

• Language 

• Notifications 

• Confirmations 

• Storage 

• Password protection 



• Backup 

• Spell Checker 

• Print 

• Shortcuts 

Appearance: 

• Layout 

• Themes 

• Lists 

Mail: 

• Read 

• Send 

• Compose 

• Replies and Forwards 

• Templates and Signatures 

• Spell Checker 

• Privacy 

• Receipts 

• Attachments 

• Automatic archiving 

Signing and Encryption: 

• General 

• Account policies 

• Certificates and Keys 

Calendar: 

• General   

• Weather 

Tasks: 

• General 

Contacts: 

• General 

Chat: 

• General 

Widgets: 

• General 

Advanced 

• Logging 



You can switch between these sections and subsections by clicking on the bookmarks in the left-
most vertical panel of the Settings window. When you click on any of these bookmarks, the central 

panel of the window will change and it will display the settings of the selected section. 
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General 

The General subsection of the general section of the Settings window contains four sub-panels: 

General,Synchronization, Operations Window, Default Email Application: 

  

 

  

General 

Minimize application to tray 

Usually, the default behavior of an application window when minimized (e.g. by pressing the 
minimize [dash] button in the top right corner of application window), it goes to the taskbar. But 
when this field is checked, the application will minimize to the tray at the lower right corner of the 
taskbar instead. To restore the application window simply double-click the application's icon (in the 

shape of orange envelope) in the tray. 

Close application to tray 

When checked, the application will minimize to tray (instead of closing) when you click the 
close button (cross). To restore the application window simply double-click the icon in the 

tray. 

Run on Windows startup 

By checking this option, eM Client will automatically start on Windows startup. 



Empty Trash on exit 

By checking this option you will set the application to automatically empty the trash when you exit 
the application.  

Show Favorite Folders 

By un-checking this field, you can hide Favorite Folders from the main view. 

Show Local folders 

By un-checking this field, you can hide Local folders from the main view.  

Show on startup 

Here you can choose (from the following drop-down menu) what you want to display in the 
central panel upon startup. 

 

  

Synchronization 

Synchronize items at startup 

When checked, the application will automatically synchronize your items at startup. 

Synchronize items every X minutes 

Check this field to automatically synchronize your items in every X minutes . This action will be 
performed every given number of minutes and you can change this frequency in the numeric field to 



the right of the checkbox. 

Note: IMAP and EWS accounts will synchronize even outside of this interval if the server 
pushes an update. 

  

Operations Window 

Show window on send and receive  

When checked, an Operations Window will appear displaying the operation details during sending 

and receiving Emails. 

Hide window when send and receive completes 

When checked, the Operations Window will close itself automatically after sending and receiving 
Emails. 

Show window when error occurs 

When checked, the Operations window will only appear when encounters errors during sending and 
receiving Emails. 

Default email application 

  

Click on Make default button to make this product the default email client.  
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Language 

The Language subsection of General section of the Settings window: 

  

 

  

In this section you can select the installed language for the application. 
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Notifications 

The Notifications Settings window: 

  

 

  

You can use default settings or modify the settings for all enabled accounts separately. 

  

An icon without a red cross means direct settings and an icon containing the red cross means 
explicitly forbidden. 

  

You can set three forms of notifications, Popup windows, notification icons in tray and playing 
sounds. 

Option notification icon in the tray area is discrete and the least intrusive, suitable for less important 
events. 

Show popup windows will display a popup window containing all the relevant information about the 
event. 

You can specify a different sound file to be played for each type of event by choosing the option 
Play sound. 

You can disable notifications when a full-screen application is detected running on the computer by 
checking the appropriate box. 



You can cause pop-up windows to be hidden after a certain period of time by checking the 
appropriate field and specifying the time value in milliseconds. 

  

  

There are many types of events that you can set notifications for. You may choose a combination of 
notifications for each event according to their level of importance to you. 

Moreover, you can disable /enable the appearance of sound and popup notification while the main 
window is active.  
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Confirmations 

In this menu you can specify (by checking/un-checking the appropriate field) which actions will 
require confirmation by the user and when the user will be notified of important events. 

  

 

  

You can also set up your Move to Junk Action by selecting one of the 4 options. Action that you 
select here will be automatically performed when you hit the Move to Junk button. 

  

 

  

Move to Junk button can be found in the toolbar in the Junk E-mail section.  
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Storage 

Here you can specify the path to the Database directory, in which all your data will be stored. 

If you are moving the database you need to manually move the files - or eM Client will create a 
new, empty database on the new location. 
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Password protection 

  

 

  

Here, you can set up the password protection when starting up the application by 
checking/unchecking this option. Here you can also set the password you want to use.  



Backup 

Here you can set up an E-mail backup.  

  

 

  

Check Enable Backup to allow backup in your email client. 

Target directory: 

click on  to select target directory for backing up your files. 

  

Frequency: 

Set up your frequency of backup from the range of 1 day to 6 months. When the frequency which 
you have chosen will elapse, eM client will ask you if you are willing to back up. 

The time of backup can be changed in Windows Task Scheduler. 

Preserve last:  

You can select from 1 to 5 backups, which you would like to preserve saved and ready to be 
restored if needed.  



  

  

  

Live Backup- since version 7.1 eM Client can create backups while the program is running. 

  

  



Spell Checker 

The spell checker can help you to avoid typos. It is turned off by default but you can simply turn it 
on by checking the field Use automatic spell checker in individual areas. If you check this field, 

make sure to choose the appropriate Language. Note, that you can use spell-checker also for 
Instant Messaging.  
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Print 

Here you can set up printing preferences. 

  

 

  

Check Print each mail on a separate page to set the application to print each mail on a 

separate page when you are for example printing larger conversation with some email user.  

Check Print user name in page header to adjust the application to display the application 

account's name in the header of the printed page. This can be, for example, useful when various eM 
Client users print emails on a single printing machine.  



Shortcuts 

In this section of general settings you can adjust various shortcuts that you want to function in your 
application.  

Shortcut section is divided into three subsections: Main, Mail and Send Mail. 

  

 

  

  

Click on Reset to default to reset the single selected function (for example Paste, Find... etc.) to the 

setting by default.  

Click on Reset all to default to reset all shortcuts to the setting by default. 

  



Swipe 

Please note that swipe gestures are currently only supported for the Windows version of eM Client 
on touch screen devices. 

 

Swipe Options 

This allows you to enable/disable long swipe mode for left or right swipes. 

A short swipe gives you a chance to confirm if you want to take the swipe action by doing a short 

swipe and then a tap on the icon that appears. 

 

A long swipe will take the swipe action without confirmation. 

 

Mail 

Set the swipe actions in the mail view for left and right swipes. 

Notes 

Set the swipe actions in the Notes view for left and right swipes. 



Layout 

Layout settings window: 

  

 

  

Here you can set up if you would like to have the messages displayed on the bottom, on the right or 

if you would like to have the messages panel off.You also can choose between three options of the 

visual display of your sidebar. If you check the option Expanded your sidebar will appear in its full 

size on the right-hand side. By checking options Minimized and Hidden you can make your sidebar 

minimize or even disappear. 



Themes 

In this menu, you can adjust the look of the user interface - you can choose among Modern, 

Classic, Arctic, Mystic, Pink, Bordeaux, System themes, pick a different color, or import any 

custom theme from a file with *.emtheme extension. Just specify the path to the directory that 
contains your themes by clicking on Import... button.  

  

 

  

  

By clicking on the Advanced button following context menu will appear: 

 

You can save the current theme (however modified) into a file by clicking the appropriate option. 
You can later customize this file by means of simple XML editing - you can individually set up up to 
about 120 colors. This way, you can create a theme based on one color and later manually 
customize everything else. If you require further information regarding customizing your themes, 

visit forum.emclient.com. 

You can also search for custom themes by clicking on Change theme directory.... 
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Lists 

In this menu you can specify the appearance settings for the individual parts of the application. The 

changes you will make here will show in following parts of the application: General, Mail, 

Calendar, Tasks, Contacts, Sidebar. Using these options you can customize the appearance so 

that it fits your personal preferences. 

The settings and options you choose here will affect the appearance of the information displayed in 
all parts of the application (in messages, calendar etc.) 

  

 

Lists Properties 

Use alternating colors for rows - if checked, the messages in the list will be displayed on a 

background of alternating colors. 

Show grid in list - by checking/unchecking this option, you can show/hide a grid in the list of 

messages. This grid is more visible if you uncheck the previous option.  

Use color of tag as text color - by checking this option you can choose if you would like to 

display the text of an entry in the same color as is the entry's tag in which it is classified.  

Allow in-cell editing - this option applies for editing in main window. If checked, you will be able 

to edit the parameters of the items (contacts, events, tasks) inside the appropriate cell. 

  



Fonts & Row dimensions 

  

In these two sections you can specify the font that will be used, as well as the height of the rows. 

  



Toolbars 

There are many toolbars which exist in eM Client and some of them (especially for Mail) have so 
many available options that we let users customize them to fit their specific needs. 

 

  

Main Toolbar 

This is the Main Toolbar that appears at the top of the Mail View in eM Client. By clicking 
Customize… you can change which buttons appear in this toolbar and in what order. 

 

Mail Compose Window Toolbar 

This is the toolbar which appears when you are writing an email to enable you to quickly change 
things about the email message, such as adding formatting (Bold, Italic, Underline) or adding an 
attachment. 

By clicking Customize… you can change which buttons appear in this toolbar and in what order. All 

the options which you don’t pick to be included in this toolbar can still be accessed by clicking on 
the … button on the far right side of the compose message window. 



 

  

Mail Detail Toolbar Window 

This is the toolbar which appears at the top of the message window when you open an email. It’s 

similar to the Main Toolbar for Mail, but has some added options such as moving to the 
previous/next message in the folder to open another email. By clicking Customize… you can change 

which buttons appear in this toolbar and in what order. 

 

  

Toolbar Alignment 

Main toolbar alignment 

This lets you choose if the Main Toolbars which appear at the top of the page should be aligned 
towards the left or center. 

Other toolbars alignment 

This lets you choose if the other toolbars (besides the Main Toolbars) that appear at the top of a 

window should appear at the center or left side of the window. 



Read 

The Read Settings window. Here you can change the look of your messages. 

  

 

  



Read 

Mark message read after displaying for X seconds 

The application tries to track which emails you have read and which you haven't by marking an 
email as "read" after it's been opened for a certain amount of time. You can specify the amount of 
time in seconds in the numeric field after which you would wish to mark the currently opened email 
as "read".  

Mark messages read after opening in separate window. 

The application will mark messages as read after opening them in separate window.  

Read all messages in plain text 

Check this box if you wish all incoming messages to be displayed in plain text format. 

Replace text smilies with emoticons 

Check this box if you wish to replace text smilies with animated emoticons. 

Show email address in email header 

Check this box if you want to have the email address displayed in the email header.  

Close original message window after deleting the message 

If you check this option, the original opened message window will be closed when you delete the 
message. If you leave this option un-checked, the original opened message window will still remain.  

Show tag bar 

Check this box to show tags in the Message detail header. 

Show unsubscribe bar 

Check this option to show the unsubscribe link contained in the message header. 

  



Preferred style  

Set a style you wish to have your plain text emails to be displayed in. 

Preferred font for messages 

Click "Select" to choose a preferred font for your plain text emails to be displayed in. 

Preferred text color 

Click "Change" to choose a preferred text color for your plain text emails to be displayed in. 

Preferred background color 

Click "Change" to choose a preferred background color for your plain text emails to be displayed in. 

By (un-)checking the very last option in the window you can enforce using the mono-space font for 
preformatted plain text messages. 

  



Message list 

Show messages in groups 

Check this option if you want your messages to be displayed in groups. Your messages will be now 
sorted in groups like "Older" , "Two weeks ago" etc. 

Show full date 

If you check this option, the full date of receiving your message will be displayed (including day, 
month, year and exact time instead of the default day and month) 

Set date sort order 

You can choose whether you want your message to be displayed on the top or on the bottom from 
the drop down menu: 

 

In addition there is also the Preserve current setting option, which is selected by default. This option 

preserves current setting, which means that the settings which you have for various mail folders will 
be preserved. But on the other hand if you for example choose New messages on the top option in 

this section, the setting will be changed for all your message folders.  

Use compact layout in widths smaller than X pixels  

Here you can customize your compact layouts by selecting the number of pixels.  
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Send 

The Send Settings window: 

  

 

  

Save a copy of sent messages in "Sent" folder 

Check this box to automatically store all your sent messages in the "Sent" folder. 

Don't close application before all messages are sent 

By checking this option you will prevent the closing of the application until all messages are sent.  

Send messages immediately 

Check this box to have your emails sent as soon as you click the Send button in the upper left 

corner of the New message window. 

Otherwise the messages will be stored until you click the Send and Receive All button on the 

toolbar. 

  

Send later - Pro feature 

Enable Send later for all messages - All messages will be sent with a specific delay set in the 

X minutes field 
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Compose 

Compose section enables you to adjust the email lookout.  

  

 



  



Compose 

Automatically complete email addresses when composing  

Check this box to let the application attempt an auto-completion of the email address you are typing 
in. 

This function enables you to quickly insert the receiver's address when composing a new email. 
Simply type the first few letters of the desired receiver's address into the email's To: field and the 

application will display a list of all the contacts from your address book whose email addresses begin 
with what you have typed in. 

 

  

Automatically save emails to drafts every X minutes  

Check this box to have the application periodically save the email message you are currently 

composing in the Drafts folder. Thus if you are interrupted while writing an email, you can recover 

the unfinished email from the Drafts folder. 

In the numeric field you can specify how often the application saves your unfinished email. 

Show CC and BCC field when composing  

By checking or un-checking this field you can show/hide the CC and BCC fields in the message 
window when you are composing a message. 

Capitalize first letter of sentences 

This utility works on a principle that every first letter of a new sentence will be automatically 
capitalized. (This can basically save your time, in means that you do not have to pay attention 
whether you have written capital letter at the beginning of a new sentence or not.) 

  



Mail Format 

New mails format as:  

You can set a permanent mail format for your new messages. Choose from the two following 
options: 

 

You can choose between HTML or Plain text emails. A HTML email can retain any customized 

formatting that you apply to your email (font, colors...), a plain text email will contain only the text 
with no colors, font and so forth.  

Mail format for reply: 

 You can also set a permanent mail format for your reply messages. Choose from three options: 

 

  

You can choose between HTML or Plain text emails. A HTML email can retain any customized 

formatting that you apply to your email (font, colors...), a plain text email will contain only the text 

with no colors, font and so forth. You can also use the utility to auto-detect the format from the 
original message. 



  



Preferred Style  

Here you can define the preferred font, font style and size that you want to be used 
automatically when you are composing a message. 

  



Recipients History 

This utility can store the addresses that you type into the recipient fields of your emails and eM 
Client can further use these stored addresses to suggest and auto-finish the recipient fields in the 
future, regardless whether the recipients are in your contact list or not. 

For privacy reasons, you can click on Clear recipient history... to clear the list of stored recipients. 

   

  

  

  



Replies and Forwards 

Here you can adjust many preferences for your reply messages and forward messages. This section 

is divided into four subsections: General, Subject modifications, Reply Header, Forward 
header. 

  

 

  

General 

Check/Un-Check Close original message window when replying or forwarding to Close/ 

leave the original message when you are replying or forwarding. 

You can choose from various actions (see below) in "When replying to a message" section: 

 



You can also choose from various actions (see below) in "When forwarding a message" section: 

 

  

Subject modifications 

Here you can define the style to be used in the "Subject" field in replies and forwarded messages. 

  

Reply header 

Here you can choose the style of format for your reply headers (see below), there are three 
possibilities: Standard, Short and Custom (editable as you wish in the preview section).  

 

  

Forward header 

Here you can the style of the format for header when forwarding a message (see below), there are 
again three possibilities: Standard, Short and Custom (editable as you wish in the preview section). 

 

  

  

  

  



Templates and Signatures 

You can customize your mail templates and signatures in this section. 

  

Here you can see how Templates and Signatures menu looks like: 

  

 

  

By (un-)checking Attach signature to emails sent from external applications you can enable/disable 

attaching signatures to emails sent from external applications in this device.  

By (un-)checking Attach "Sent from eM Client" signature to every mail you can enable/disable 

attaching this signature to every mail that you send.  

  

Mail Templates  

  



 

  

A Mail template is a set of font and color settings that you can first store and then collectively apply 

to your email messages. You simply choose your favorite type of font, color of background or even a 
picture for the background, store this information in the application's Templates window and the 

selected template will be automatically applied to all your future emails. 

By clicking on the Mail Templates... button the Templates window will appear: 

  



 

  

This is where you manage your email templates - you can modify, import, remove existing, or 
create new templates here. 

Templates: 

Templates contain all of your existing mail templates. If you want to modify or remove an existing 
template, select it from the list and click on the corresponding button located on the right. (wheel or 
trash icon) 

Preview: 

This window displays a preview of the mail template you have selected in the Template List. 

+New 

Click on New button to bring up the New Template window: 



 

  

Enter the name of your new template in  Name field. 

Enter any pre-defined recipients into To, Cc or Bcc fields. 

Enter the Subject of your template in to the Subjectfield.  

  

Font type 

Font settings can be changed by clicking on the down-pointing arrow. A standard font settings 
window will open, where you can adjust the font's size, style (bold, italic...) and type (Arial, Courier 
New etc.). 

  

Font Color 

Select the text color you would like to set for your template by clicking on down pointing arrow in 

the font color section, and select the preferred font color from the roll-down menu.  

  

Background 

You can also preset the background of your mails. Simply click on the down-pointing arrow and 

select from set of simple color. It is also possible to use custom color by clicking on the Custom 

color... button and then defining your own color.  

If you want to use a picture, click on , click Browse picture... button and select the desired image 

file from the file explorer.  

At the very bottom there is a Template window, where you can edit your template and 

simultaneously see how will your emails look with the given template. 



Click OK to finish creating the new template, which will be added to the template list. 

  

Attachments 

Add any files you want to include in your messages by default, this can be useful for inserting your 
own contact file, CV, public keys for encryption or anything that you want to send out with each 
message that you cannot include in a signature. 

  

Import 

Import a template from an .emltfile. 

Save as 

Save a selected template into an .emltfile. 

Edit 

  

 Clicking on Customize (wheel icon ) will bring up the same signature construction window as 

Add template and will also allow you to modify an existing template. 

Delete 

  

To delete an existing template, click on the trash icon. 

  



Signatures 

  

 

  

Signatures are texts, pictures and even web links that can be automatically appended to the end of 
your email messages as your signature. You can create and save any number of signatures in the 
Signatures window and select a signature to be used for all your future emails. 

Select signature for account:  

Select the account for which you want to use the signatures selected in the edit boxes below. 

Signature for new mails: 

This drop-down menu contains a list of all your saved signatures. Select one to be used for all the 
new messages you create. 

Signature for replies:  

This drop-down menu contains a list of all your saved signatures. Select one to be used for all the 
reply emails you create. 

Signature for forwards:  

This drop-down menu contains a list of all your saved signatures. Select one to be used for all the 
forwarded emails you create. 



note: Check the Attach "Sent from eM Client" signature to every mail option if you want to have 

"Sent from eM Client" signature in each of your mails.  

Signatures... button 

By clicking on the Signatures... button the Signatures  window will appear: 

  

 

  

You can modify and remove or create new signatures here. 

Signatures: 

Signatures contain all your existing signatures. If you want to modify or remove an existing 
signature, select it from the list and click on the corresponding button located to the right. (wheel or 
trash icon) 

Preview: 

In this field will be displayed the preview of the signature you have selected in the Signatures field. 

+New  

Click on New to bring up the New Signature window: 



 

  

Enter a name for your new signature in the  Name field. 

In the field below construct a signature as you would in any text editor. Confirm the changes by 
clicking OK and your new signature will be created and added to the signature list. 

Import 

Import a signature from an .htmlfile. 

Save as 

Save a selected signature into an .htmlfile. 

Edit 

 Clicking on Edit will bring up the same signature construction window as New, which will allow 

you to edit an existing signature. 

Delete 

To delete an existing signature, select it in the Signatures field and click on Remove (trash 

icon). 
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QuickText 

  

QuickText enables you to insert pre-made chunks of text (for example snippets) to your messages 
within seconds. This spares you from having to type the same phrases, sentences or even whole 
emails over and over again.  

  

 

  

Click on + Add Quick Text button which will bring up an editor window for customization of your new 

quick text: 

  



 

  

Here you can customize your own QuickText, enter the name and then customize the text in the 
text window.  

Once you have finished your QuickText, click on the OK button to finish the process. 

  

How to use QuickText 

  

QuickText button is located directly in the email window (see below). Once you have created your 
own QuickTexts you will be able to implement them into your text by a simple double-click. 

  



 

  

Note that you can also use shortcuts to quicken the process even more.  

  

  



Privacy 

Privacy settings window: 

  

 

  

Here you can customize the settings concerning the privacy and unsafe content in received 
messages. To maximize the level of safety of your computer, it is recommended to check the Block 
unsafe content in all messages option, which will automatically block unsafe content in all 

messages. Moreover you can also choose from other two options which offer you either to Display 
unsafe content in messages from people in contact list or Display unsafe content in all messages. 

These settings are present in the application in order to prevent you from external threat. For 
example when an email contains external images or another external content, the sender is 
informed about successful delivery and reading of the email simply by your downloading. This is 
often abused by the so called "spammers". Therefore when you select the last option - Display 
unsafe content in all messages, no unsafe content will be blocked then, which can gradually lead to 
higher amount of spam messages that you will receive. 

  

Clear sender whitelist... 

Right-click on this option if you wish to clear sender whitelist. Whitelist is basically a list of accepted 
email senders, the people you trust.  

Show whitelist.... 

Right-click on this option to display your whitelist.  



  



Receipts 

The Receipts Settings window:  

  

 

  



 Delivery Receipts 

Check the Request a delivery receipt for all sent messages box to have an auto-generated 

confirmation message sent back to you when your message has been delivered to the recipient's 
server.  



Read Receipts 

Check the Request a read receipt for all sent messages box to have an auto-generated confirmation 

message sent back to you when the recipient of your messages has opened and read your 
messages. 

Returning Read Receipts  

Here you can specify whether you wish to Never send a read receipt or to be notified for 
every read receipt request or to always send a read receipt for your incoming emails.  



Attachments 

In the Attachments settings you can set default actions for received files as well as specify your 
settings for attachments saved in Cloud storage. 

 

  

Default Actions for attachments 

Here you can delete predefined actions that you have set up for various attachment file types. 

Delete the predefined action by clicking on the cross icon:  

  

Cloud Storage Attachments 

Add a Cloud Storage Service 

eM Client currently supports these cloud storage providers: 

• OneDrive 

• Google Drive 

• DropBox 

• OwnCloud 

• Nextcloud 



IMPORTANT: To use these services in eM Client, you first need to install the cloud storage 
application of the provider on your computer. 

You can add these services by going to Menu > Settings > Mail > Attachments and clicking the Add 
button. You will then select the provider. 

 

Add, Remove and Set as default buttons for Service providers. 

 
Add Cloud storage set up 

 

Cloud Provider selection. 

  

The first time you use cloud storage in eM Client on your device, you will be asked to log in to the 
service and give consent for the eM Client to access the service. Depending on the selected service, 
the login will appear differently. 

  

Remove a Cloud Storage Service 

To remove a cloud storage service, simply go to Menu > Settings > Mail > Attachments > Select 

the service > Remove 

  

Set as default 

If you add a large file (>10mb) into an mail and try to send it, eM Client will ask if you would like to 
upload the file to a cloud service. 
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Automatic Archiving 

In this section you can enable /disable automatic archiving of the messages.  

Automatic archiving moves message older than selected threshold to archive folder stored locally. 
This reduces amount of storage required on the server and at the same time helps you to keep your 
folders clean. 

  

w 

  

Automatic Archiving 

  

Enable automatic archiving - check this option if you want to enable automatic archiving. 

Ask before archiving - check this option if you want to be asked first before the archiving 

process will be launched. 

Archive every - here you can specify the time span in which you would like your messages to be 

archived. 

Archive messages older than - here you can set up the age of the messages which you wish to 

be archived. 

Click on Perform Archiving to start the process. 

  



For Archiving to be performed you also need to set the Archiving scope for each of your accounts 

under Account preferences. 



Translation 

In this section you can disable or enable message translating. Furthermore you can set default 
actions (Ask or Never) for every language in the list and specify the target language (the language 
to which you want the source language to be translated) as well.  

 

  

How does translation work? 

  

When you receive an email written in language different than in the language of the application, eM 
Client will automatically detect and ask you if you want to translate the foreign language to your 
default language.  

 

  

Translations are powered by Microsoft Translator API. 

  



General 

Security is our big priority but you need S/MIME Certificates or PGP keys to digitally sign and 
encrypt your emails, or decrypt and read encrypted emails from others. You may get the necessary 
certificates from your company's intranet system, from an independent security source like 
VeriSign, or from your correspondence that encrypts his or her Emails.  

With our new PGP support you can even create your own PGP keys directly inside eM Client - go to 
the Certificates and Keys section to find out more about that. 

  

General settings for Signing and Encryption determine how long will your password for your 

certificate/key be remembered within the application and which format of encryption is to be 
preferred. 

  

 

  

PGP Support 

Remember entered key passphrase: 

Until Application Exit 

For 5 minutes 

Never  



  

Format of PGP: 

Autoselect (PGP/MIME or Inline PGP) 

Only use PGP/MIME 

Only use Inline PGP  

  

PGP/MIME format lets you encrypt and sign the whole message, including attachments. 

Inline PGP encrypts the OpenPGP sections directly inside a email message and cannot 

encrypt/sign attachments. 

  



Account policies 

Account policies will determine when messages are to be signed or encrypted automatically. 

  

 

  

Encrypt messages by default 

Digitally sign messages by default 

Include certificates/keys in outgoing messages 

  

The All Accounts setting will be applied to all accounts by default. 

You can manually change the settings for individual accounts and aliases below. 

  

If you do not have a certificate/key corresponding to an email address/alias the settings will not be 

available and a message "No matching certificate/key found for this account" will be displayed 

instead. 



Certificates and Keys 

 

  

My certificates/keys tab will show your certificates and keys, those you can use to Sign and 

Encrypt your messages. 

Others' certificates/keys tab will show Other certificates of your recipients and 

senders. You can import these manually or directly from a received message (if the 
original sender attached their public key in their message). 

  

Add certificate/key...  

With this option you can import your existing Certificates and Keys. 

If the imported file contains only a Public key/certificate it will be saved in the Others' 
certificates/keys section. 

If the file also contains your own Private key/certificateit will be imported into the My 
certificates/keys section. 

  

Create PGP certificate  

With this option you can create your own PGP keypair inside eM Client. 

All you need to do is select the mail address/alias you want to generate the keypair for and input 
your own data. 



eM Client currently generates PGP keypairs with no Expiration date. 

 

  

Make sure to remember your password as you will need it to encrypt and sign your messages. 

  

When you have a created/imported keys you have few options on what to do with them. 

Clicking the Details button  will open the following information window: 

 

  

Here you can see all the information about your certificate/key but also Export them or Send your 

public key to a contact with whom you wish to converse via encrypted messages in the future. 



 

  

You can export the whole keypair or just the public key into an .ASC file. 

  

You can also right-click the certificate/key using the right mouse button to open the Details or 
access its features. 

 

  

Clicking the Delete button  will remove the certificate/key from eM Client. 

  

  



eM Keybook 

 

Enable eM Keybook support: option that enables/disables eM Keybook support service 

Search in eM Keybook: Search for specific keys by email address 

  

Enable eM Keybook support 

We let users upload public keys to eM Keybook and then when another user wants to send 
encrypted email to that person, he does not have to ask for a public key. Instead eM Client will 
search for their public key in the eM Keybook and offer to download it for you automatically. When 

this option is disabled, eM Client won’t ask you if you want to import public keys available in our eM 
Keybook. 

  

Behavior when Enable eM Keybook support is checked: 



 

  

Behavior when Enable eM Keybook support is NOT checked: 

 

Search in eM Keybook 

Here you can search for public PGP keys which have been uploaded by our users. Just search for 
their email address and if they have a public key available, you can then choose one of these 
options 

• Import: import it into your own keybook to easily send them an encrypted message 

• Details: See details of the public key (and export it as an .acs file or send it to someone) 

• Send Public Key: Send the public PGP key to someone else via email 

  



 

  

Details of a PGP public key: 



 



 Calendar  

You can access the calendar's settings by right-clicking anywhere on the calendar's main panel and 
selecting Calendar Preferences from the context menu, or by selecting Menu -> Settings from the 

main program window and selecting the Calendar section in the Settings window. 

  

  

 

  

The Calendar Settings window consists of four sub-sections: Calendar View, Work Week,, 

Balloons and Agenda (Events List). 



Calendar View  

Go to Today every time calendar is opened: 

If you check this option, then the current day will always be in focus when you open the calendar 
section. 

Show week numbers: 

If you check this option, there will always be displayed a number of the week according to the 
current year in the month view of the calendar.  

Granularity: 

This option allows you to choose the granularity of the day and week view layouts. 

The days are divided into hours by default. If you want to plan your time more accurately, you can 
split the hours into slices of 5, 10, 15, 20 or 30 minutes. This time unit is important when you are 
moving and resizing events by Drag&Dropping event boxes because you can't adjust the events by 
smaller time units than defined here. 

Show Range: 

This option allows you to set the "height" of your calendar's layout. The value specified in this field 
determines how many hours will be visible at one time in the calendar's central panel. 

So, if you set 24 hours in this field, you won't have to scroll at all in your calendar's central panel, 

leaving you plenty of room for your nocturnal activities. 

Source of event's color in multi-calendar mode: 

You can define the source of the color of an event while you are in multi-calendar mode. This option 
is there for a case when you are working with more than one calendar. You have three options:  

Tag then calendar - will prefer tag color and neglect calendar color. 

Calendar then tag - will prefer the color of a calendar and the tag color will be displayed only by tag 
indicator. 

and Calendar only - will display calendar color primarily while you have selected one calendar only.  

Work Week  

In this section, you can define the parameters of the work week. When it starts, when it ends and 
which days it contains. 

Balloons panel 

In this panel you can define the behavior of the popup balloons which appear when you hover the 
mouse pointer over an event box. These balloons contain the events' info. You can learn more about 

Balloons in the Calendar Views section. 

Agenda (Events list) 

Check Show groups in agenda to have groups displayed also in Agenda (Events list) 

Defaults 

In this panel you can set default meeting lengths and reminder lengths. Consequently select 
whether you want to apply it to all folders or only to the selected ones.  
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Weather 

In this panel you can define the settings for a feature which displays reliable weather forecast 

information for several upcoming days in the calendar. Specify the city you are located in and 
choose whether you would like to have the temperature displayed in degrees Fahrenheit or 
Celsius. 
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Tasks 

Here you can choose whether you would like to show groups in tasks list. 

  

 



Contacts 

Contacts settings window:  

  

 

  

Here you can set up whether you want to file new contacts as Surname, Name; Name, Surname; 

Surname Name or Name Surname. Then click on the Update Contacts... button to activate the 

manner in which the contact should be filed. The very last step is to select the contact folder(s) that 
you would like to update. You can also adjust whether you want your contacts to be shown in 
groups in contact list. 

Moreover, you can set to download contacts' avatars from Facebook automatically (is predefined). 
Remember that if you want to use this function, the must is a Facebook chat account set up. 

  

Avatars 

  

eM Client automatically downloads and displays avatars for your contacts from the web. We 

download images from Gravatar, domain icons and more. 

  

If no image is saved for your contact on server or in your Contacts section, the contact's initials or 

empty icons will be shown instead, depending on these settings: 

https://gravatar.com/


  

Download avatars from external sources: 

This option will determine if images from external sources are downloaded or not. 

This does not include images from your Contacts  

  

Show monograms when no other avatar is found: 

This option determines if initials are shown. If you uncheck the option only a basic silhouette icon 
will show instead. 

  

  



Notes 

This feature is available only to the Pro license users. 

 

  

Show Tag Bar:This settings will toggle displaying the Tag Bar in the upper right corner of your 

Notes. This makes it much easier to quickly see and manage your Tags within Notes. 

Show notes in groups:You can check if you want your messages to be displayed in groups. Setting 

is currently available only for 'Last Modified' argument. Your Notes will be now sorted in groups like 
"Older" , "Two weeks ago" etc. 

Show full date: This extends the date of when the note was last modified. 

Use compact layout in widths smaller than [ ] pixels: Here you can customize your compact layouts 

by selecting the number of pixels. 

Compose 

Automatically save notes every [ ] minutes: This adjusts how frequently notes are autosaved. The [ ] 

value can be set between 1 and 99 minutes, or disabled completely by unchecking the box. 



Chat 

In this menu you can specify the settings for your communication via Instant Messaging. You can 
for example set up sending messages on pressing Enter, showing quick answer in message 
notification or using automatic status changing which involves specifying the amount of time after 
which your status will be automatically changed to  

"Away" and "N/A". 

If you check the "Auto accept incoming files" field, any files coming in through Instant Messaging 
will be automatically accepted and stored in the directory that you specify below. 
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Online Meetings 

Add an Online Meeting Provider 

To add online meeting integration, you can go to Menu > Settings > Online Meetings > 

General. 

Then click the Add button at the bottom of the window and select the online meeting 

service you wish to add. 

 

  

Next, you will sign it to your online meeting service using your normal login credentials. 

Then, you will need to accept the permissions for eM Client to connect to the online 

meeting service 



Finally, the service will be added to your list of online meeting providers, and you can 

select that service when creating an online meeting. 

  

Google Meet 

By default, users who have enabled Google Calendar access already have Google Meet 

added as an Online Meeting provider for every one of their Google Accounts in eM 

Client, and they can only be removed by disabling the Google Calendar service for that 

account. 

  

Microsoft Teams login and permissions: 

 



 

  

Zoom login and permissions: 

Adding Zoom to eM Client may require a manager’s permission, depending on the setup 

of your organization’s Zoom account, otherwise (as a single user with Admin rights) you 

will need to click the Pre-Approve button. 



 

 

Then you will be able to Authorize the account for eM Client: 

 

  



If you don’t have admin rights for your Zoom account, or eM Client isn’t pre-approved in 

Zoom by your organization, this means that you will need to set up Zoom in eM Client 

twice. First to send the pre-approval request, then to actually add the Zoom service. You 

will need to take the following steps. 

1. Initially try to add Zoom to eM Client 

2. Send the approval request to the Zoom admin 

3. Click Cancel in eM Client because the application locks up while approval is being 

sought 

4. Wait for the request to be approved (you will receive an email upon approval) 

5. Add Zoom to eM Client again. 

Remove an Online Meeting Provider 

 To remove Microsoft Teams or Zoom, select them from the list of providers and click 

the Remove button.  

 

Because Google Meet is tied to the Google Calendar function, the only way you can 

remove the service from eM Client is by disabling your Google Calendar service, which 

means your Google Calendar will no longer appear in eM Client.  

If you still wish to remove it, you can go to Menu > Accounts > Select your Google 

account > General Tab > Services > Uncheck the box for Google Calendar. 
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Widgets 

Widgets are useful add on applications that can be customized to personalize your account. You can 
use them to display your favorite web pages or to read the latest news from a RSS feed.  

The Widgets Settings window: 

  

 

  

To create a new RSS widget, click the Add New button, select the RSS Widget and press Next >. 



 

  

Enter an arbitrary name for your new widget and enter the URL of the desired RSS feed. A sample 
CNN news feed is shown in the picture below, you can find many RSS feeds using your favorite web 
search engine. The form of the URL may vary depending on the RSS feed provider. 

 

  

To create a new Web widget,click Add New Widget, select Web Widget and press Next >. 



 

  

Enter a name for your new widget and enter the URL of the web page that you want to display. 

 

  

You can simply delete existing widget by clicking on Remove Widget button and modify existing 

widget by clicking on the Modify Widget button. 

By clicking on Modify Widget button, following window will appear: 



 

You can arbitrarily change the existing Widget's URL or name. 
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Logging 

Logging enables generating of very detailed log files into the selected logging directory. With every 
startup a new log file is created. Logs are generally useful for power makers. 

  

 

Logging 

By clicking on this button  you can specify the directory in which you wish your logs to be 
saved.  

Log the following 

You can choose to log following: Database, IMAP, CalDAV/CardDAV, Outlook Import, XMPP and 
Network communication, STMP and POP3 from your active accounts and consequently the log will 
be created.  

By clicking on the  button an email with the log files attached to it will be created and 
sent to the power makers of this product. 

  



Main menu and toolbar 



Toolbar 

 

  

Toolbar provides you with different quick-access options depending on which section of the 
application you are currently working in. When you are in the email section, the email toolbar is 
displayed, which provides you with quick access to various email operations. The same toolbar will 
provide you with different options to perform different operations when you are in calendar mode or 
task mode. 



Menu 

 

  

The Menu contains six further options- File, Edit, View, Message, Tools, and Help. 

Those further options can be brought up only by clicking on the menu button first.  

  

File 

 

  

Menu File has many items: 

Open - You can open a saved email (an eml file). 

Save as - You can save a chosen email to an eml file. 

Import - You can import data to the application. 



Export - You can export data from the application. 

Print - you can directly print your messages, calendar, events or contacts. 

Print Preview - brings up the preview where you can adjust many aspects of the final layout of 

the page about to be printed.  

Backup - You can backup your data. 

Restore - You can restore your data. 

Work offline - When you choose this setting, the application will work without connecting to 

Internet. If you send an email, it will be saved and it will be sent after connecting to Internet. 

  

Exit - If you click on this button, the application will be closed. 

  

Back to menu. 

  

Edit 

 

Menu Edit has many items: 

Undo - if you delete something, you can undo the operation of deleting. 

Redo - if you performed undo operation, you can now perform redo and the retrieved operation will 

be deleted. 

Copy - When you click on this button, it will make a copy of head and body of the selected email. 

Select all - All emails will be selected. 

Find - you can perform textual search - either simple, or you can specify advanced options for your 

search. 

 Clicking on Find option will bring up: 

  

Advanced Search Window 

Advanced search represents a smart utility that enables you to search with predefined rules which 
will filter out particular emails from the global folders, i.e. folders where all your emails are stored. 

As you can see in the picture, search window consists of two parts: textual form of query and the 
visual form of query.  



 

  

To learn more about working with search queries and about creating a filtered folder see  

Global Folders - > About Search Folders 

Find in Body - Use find in Body do find particular words within the selected email,  

  

Back to menu. 

  

  

View 

 

  

Menu view has many items: 



Columns... - You can select columns which you want to see in the list of emails. You can also 

change the order of columns. 

 

  

Layout - You can change position of the panel with messages - Messages on the bottom, Messages 

on the right, Messages panel off.  

Sidebar- You can change layout of the sidebar. 

Conversations - Enables you to customize and specify conversations. 

Previous message - The selected item is changed to previous message. 

Next message - The selected item is changed to next message. 

  

Message 

  



 

Actions menu differs according to the section where you currently are (mail, calendar, tasks, 
contacts etc.) 

  

Actions Menu has several items: 

Reply... - When you click on this button, you will reply to a selected email. 

Reply All... - When you click on this button, you will reply to all people in a selected email. (for 

example to people in CC) 

Forward... - You can send a selected email to another person. Moreover you can choose from 

three actions: Forward... (Ctrl+F) Forward as Attachment... (Ctrl+Alt+F) and Forward as Original... 

Follow Up - by clicking this, you will add a flag to your message (event etc.) - for example to 

mark the emails you need to reply to etc. 

Categorize - you can choose a color tag that will be added to the message (contact, event ...) 

Mark as Read... - You can mark your unread email as read. 

Mark as Unread... - You can mark your email as unread. It is useful when you read an email but 

you don't have a time to answer it so you can mark it as unread. 

Mark All as Read - You can mark all your emails as read.  



Move to Junk - You can select from three options: Move to Junk, Move to Junk and blacklist 

email, Move to Junk and blacklist domain.  

Move to Folder... - You can move a selected item to another folder. 

Copy to Folder… - You can copy a selected item into another folder.  

Download Selected - You can download selected items. 

Create Meeting from Message - You can create a meeting directly from the message. 

Create Task from Message - You can create a task directly from the message.  

Delete - Deletes the message. 

Empty Trash - Empties the trash. 

  

 Back to menu. 

  

Tools 

 

  

Menu Tools has many items: 

Subscribe to Internet Calendar…  You can set up a calendar access directly from here. 

Operations - You can bring up the Operations window.  

 

  



Contacts... - Clicking on contacts... will bring up the Address Book (see below). This feature can 

be used for selecting the particular contact that you want to send a message to. Start writing 
contacts's initial letters to search for particular contact. 

  

 

  

Rules... - You create rules here. For example - Emails from Thomas - If you don't want to get 

emails from Thomas, you can simply filter them out. You can find further information about creating 

rules in the topic Rules. 



 

  

Tags... - Here you can manage your tags active in the eM Client. You can find more information 

about managing tags in the topic Working with Tags.  

  

Deduplicator... - Deduplicator is a tool which enables you to get rid of duplicate (multiple) items 

in following areas: mails, events, tasks, contacts. Click on Deduplicator to bring up following 

window:  

 

  

Select the item type and click on Next: 

  



 

  

Here you can select folders that will be searched for duplicate files and moreover you can specify 
whether you want to search for duplicates in each idividual folder or over a group of folders. When 
you are finished click on the Next button. 

  

 

  

Here specify the action to be done for duplicated items found. Click on Finish to finish the process.  



  

Settings... - When you click on this button, a window with settings will appear. You can find more 

information about settings in the topic Settings. 

  

Accounts... - When you click on this button, a window for working with the accounts will be 

displayed. You can find more information in the topic Accounts. 

  

In this window, you can authorize a chat contact or ignore it. 

  

Help 

 

  

Menu Help has several items: 

Contents - When you click on this button, a window with documentation to this product will 

display. 

License - here you can activate or deactivate your license. 

Check for Update - if you click on this option, the application will try to look for updates online. If 

an update is found a list of new features will be displayed and you will be prompted to confirm that 
you want to install the update. 

Get support - depending on the license you have (free or corporate) you will be redirected either 

to the forum (free licenses, forum.emclient.com) or to a support web page (corporate licenses, 
support.emclient.com). On the forum you can find posts from other users and on the support web 
page, you can submit a ticket with your problem and our programmers will preferentially try to 

solve it.  



Invite to eM Client - when you click on this button, a window with invitation to eM Client for your 

friends will appear. You can invite them using: email, Twitter or Facebook.  

About - You can click on this button to see more information about this product. 

 

  

Back to menu. 

  

eM Client supports touch-operated devices 

  

eM Client now supports the touch-operated devices, if your device has such utility, you will be able 
to switch to touch-operated mode by clicking on the appropriate icon in the right upper corner of eM 
window: 

  

 

  

If you switch to the touch mode, all icons and features of the application will become a little larger 

in order to easily control the application. 

In the touch mode: 

1) You can scroll in all menus by touch movement (context menus etc.). 

2) In calendar view you can move in all directions by touching the screen. 

3) By the pinch-to-zoom action you can change the number of weeks displayed in the month view of 
the calendar as well as zoom in/out in the week view.  
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About Favorite Folders  

Favorites folders (formerly called Smart Folders) are folders which by contain Inbox , Outbox, 

Sent, Drafts, Junk Email, Trash, Unread, Flagged, Snoozed, and Unreplied messages and 

from all accounts that are active (i.e. Favorites Folders enable you to have a complete overview of 
all kinds of messages that you exchanged with your contacts.) 

  

 

  

You can enable or disable this feature by going to Menu > Settings > General and 

checking/unchecking the box for Show Favorite folders. 

 

  

By right clicking on a particular Favorite folder you can perform various actions: Apply Rule... , 
Hide, Display. 



 

  

By clicking on Apply Rule... you can apply arbitrary rule to the particular Favorite folder. For more 

about applying rules see chapter Apply Rule  

By clicking on Hide, you can hide the particular Favorite folder, thereby it will not be displayed 

anymore in the selection of Favorite Folders. 

By clicking on Display a context menu will appear, showing which of Favorite folders can be 

displayed at one time (see picture).  

  



 

  

How to add your own folders to Favorites Folders 

In eM Client Version 8, you can add links to your most used folders from your specific accounts so 
you can quickly access them. 

For example, if your work email account has a folder called Invoices which you use a lot, you can 
add a copy of that folder to the Favorites Folders section so that you can quickly access it. This copy 
of the Invoices folder will automatically update when the original Invoices folder is updated, and 
vice versa. 

You can easily add account folders to your Favorites folders by dragging and dropping that folder to 
the Favorites Folder Section. Or you can right click on the folder and select Add to Favorites from 

the context menu. 



 

How to remove folders from Favorites Folders 

You can remove an added account folder from the Favorites Folders section by right clicking on the 
folder and selecting Remove from Favorites from the context menu. 
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Favorites folders (formerly called Smart Folders) are folders which by contain Inbox , Outbox, 

Sent, Drafts, Junk Email, Trash, Unread, Flagged, Snoozed, and Unreplied messages and 

from all accounts that are active (i.e. Favorites Folders enable you to have a complete overview of 
all kinds of messages that you exchanged with your contacts.) 

  

 

  

You can enable or disable this feature by going to Menu > Settings > General and 

checking/unchecking the box for Show Favorite folders. 

 

  

By right clicking on a particular Favorite folder you can perform various actions: Apply Rule... , 
Hide, Display. 



 

  

By clicking on Apply Rule... you can apply arbitrary rule to the particular Favorite folder. For more 

about applying rules see chapter Apply Rule  

By clicking on Hide, you can hide the particular Favorite folder, thereby it will not be displayed 

anymore in the selection of Favorite Folders. 

By clicking on Display a context menu will appear, showing which of Favorite folders can be 

displayed at one time (see picture).  

  



 

  

How to add your own folders to Favorites Folders 

In eM Client Version 8, you can add links to your most used folders from your specific accounts so 
you can quickly access them. 

For example, if your work email account has a folder called Invoices which you use a lot, you can 
add a copy of that folder to the Favorites Folders section so that you can quickly access it. This copy 
of the Invoices folder will automatically update when the original Invoices folder is updated, and 
vice versa. 

You can easily add account folders to your Favorites folders by dragging and dropping that folder to 
the Favorites Folder Section. Or you can right click on the folder and select Add to Favorites from 

the context menu. 



 

How to remove folders from Favorites Folders 

You can remove an added account folder from the Favorites Folders section by right clicking on the 
folder and selecting Remove from Favorites from the context menu. 
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About Search Folders 

Search Folders represent a smart utility that enables you to create a new folder with predefined 
rules which will filter out particular emails from the Favorite Folders. If you receive a new email that 

fulfills the rules of the search folder you created, then it will be automatically included in to the 
folder. Search folders can be also created for messages, tasks, events and contacts.  

Search folders will not show the unread message count. 

Creating a Search Folder 

You have three options how to create a search folder. You can either click on Menu ->  Edit -> 
Find from the Menu (shortcut Ctrl + Shift + F) and define the rules for a new search folder or you 

can right-click on the Search Folders button and select New Item... or the third way to create 

search folder is to right click on the arrow mark next to the search bar and select Create 
Search Folder... (as in the following picture).  

  

 

  

  

Following window will appear. Notice that this window consists of two parts: textual form of the 
Query and the visual form of the Query. 



 

Folder Name - enter name of the folder. 

Search Query - this represents a textual form of the query that you defined. Search Query 

consists of keys and values. If you modify this query textually and it is valid, then also the visual 
form of the query will be updated. 

Folder - you can choose between searching in all folders or you can select a custom folder in which 

you would like to search. 

Adding Rules and managing rules 

You can add rule by clicking on the Add Rule button . When you do so a new 

rule will appear in the visual form of the query. You can customize the rule in any way you need. 
Remember that the rule can contain more than one value. For example in the picture (rule for tag) 
are selected 2 different tags : Green Tag and Friends- this means that the query will search emails 
within these 2 tags.  



Deleting Rules - to delete any rule click on the delete button: . 

To finish the creative process of the search folder click on the Ok button. Once the search folder is 

created, it will appear in the Email section of the Navigation Bar. Search folders can be arbitrarily 
renamed or deleted. 
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Managing Email 

You can create emails by clicking on the New button on the toolbar. 

Notice that if you type in a contact that is paired with a Chat contact, you will be able to see 
whether this contact is online (green dot) or offline (red dot). 

  

 

  

Menu 

The roll-down menu after you click on the Menu button at the top of the email window will contain 

following options: 

  

File 

• Save- saves the message into a draft.  

• Save as- saves the message into an .eml file.  

• Print 

• Close 

Edit 

• Undo 

• Redo 

• Cut 

• Copy 

• Paste 



• Paste as text 

• Find... 

• Replace... 

• Edit Source...  

Message 

• Send 

• Send as Mass Mail - PRO feature - sends one email per recipient, so it in result gives an 

impression that the email has been composed for each recipient separately. Inserting a 
Variable is interrelated with sending mass emails (see below). 

• Send later... - PRO feature - with this setting you can send the message at a later time. Just 

specify the time and date when you wish the message to be sent.  

• Flag 

• Tag 

• Reply to address - select from your available addresses or add a custom address 

• Request Read Receipt 

• Request Delivery Receipt 

• Format 

• PGP Format 

• Delete  

Insert 

• Signature  

• QuickText - QuickText enables you to insert pre-made chunks of text (for example snippets) 

to your messages within seconds. For more information see QuickText settings section.  

• Date and time 

• File... 

• Image... 

• Image as Link... 

• Link.... 

• Text... 

• HTML... 

• Table... 

• Symbol... 

• Line 

• Variable... - Variable is a function that allows you to insert for example variable date, 

variable contact name etc. For example when you select variable full name, following text 
will appear: "{Full Name}". Now insert any number of recipients, and when the email is sent, 
the name of each single recipient will appear instead of the variable. In other words {Full 
Name} will be displayed as John Doe, Alex Brown etc. Fallback option is there when the 
target field is blank or not found, for example when you want to insert "Given Name" and 
add several contacts to recipients and some of them don't has the field "Given Name" filled 
in, the fallback value (for example "Customer" is then used. 

• My public PGP key 



You can insert several types of items, for example Inserting image as link will allow you to 

insert image that is uploaded on the Internet or you can Insert a table, parameters of which you 

can further specify.  

Tools 

• Spell Check Language 

• Use Automatic Spell Check 

• Check Spelling 

• Translate with Bing Translator 

Help 

• Contents 

Email Header 

To: 

Enter the recipient of this email here. 

Subject: 

Enter a basic description of the Email.  

Add Cc & Bcc:  

You can click on  button to bring up two additional lines for: 

Cc: (Copy) 

Enter the email addresses you wish to send a copy of this email to. 

Bcc: (Blind copy) 

Enter the email addresses you wish to send a blind copy (the recipient of blind copies won't be able 
to see your email address) of this email to. 

Toolbar  

Components of toolbar are separated into two sections. First section concerns more with the 
elements of the message and the second part is more concerned with the editing of the message 
(Email Editor). The separation of the two sections is also indicated by the design of the email 
window itself.  

Send  

Click this button to send your email. 

In the drop-down menu you can also select to send the message as Mass mail or to Send it later, if 
you use PRO version of eM Client. 

 



Account drop-down menu 

You can choose an email account from which you want this email to be sent from (it is set to your 
default Email account by default). 

Attachment  

You can add the attachments to your email by clicking on small paperclip icon. 

Important  

Clicking this icon will set your email to be urgent . 

Signature  

Click this button to choose the signature you wish to use for the message (you can set up your 

signatures in Settings - Signatures, or you can access the signatures management window by 

choosing the Manage option from the menu). 

QuickText  

Click on this button to insert predefined QuickText of yours. For more information about how to 

create QuickText visit the QuickText settings section. 

Watch for Reply  

You can set up a notification either for when a reply to this message is received or if the recipient 
has not replied to your message in a specified amount of time. 

Sign  

Click to digitally sign your email with a security certificate so that the recipients can verify its 

authenticity. For more details refer to Security Certificates and how to configure security settings. 

Encrypt  

Click to digitally encrypt the contents of your email with a security certificate. The recipients will be 
able to decrypt your message with the attached security certificate if you have properly configured 

your security profiles. For more details refer to Security Certificates and how to configure security 
settings. 

Flag  

  

Email Editor 

 

  

Bold - The selected text will be bold. 

../../../Content/Settings/Certificates.htm
../../../Content/Settings/Certificates.htm
../../../Content/Settings/Certificates.htm


Italic - The selected text will be written in italic. 

Underline - The selected text will be underlined. 

Paint Format - Select certain area of the text while holding right mouse button, click on the Paint 

Format button, and then hover over different area of the text to transfer the format of the original 
text to the newly selected area. 

Font Style - click on the Font Style button to bring up following menu  

  

 

  

Ordered list - create a numbered list 

Unordered list - create a list of points 

  

 

  

Left Align - justify the text to the left. 

Center - justify the text to the center. 



Right Align- justify the text to the right. 

Justify Both Sides - justify the text on both sides 

Emoticons - add emoticons, gifs or stickers to your email. 

  

Click on the  button to bring up following additional features that could not fit in the 
toolbar: 

  

 

  

Read Receipt-Add read receipt to your email. Read receipt represents a notification that is 

delivered to you after the recipient opens your email  



Delivery Receipt- Add delivery receipt to your email. Delivery receipts confirm that the email has 

been delivered to recipient's mailbox.  

Reply to address - Set a different Reply-to address if you need the recipient to send a reply to 

different address than the one used for sending. 

Tags- Mark your email with arbitrary colorful tag. 

Save - Save the message to drafts 

Check spelling.. - Open the Check spelling window 

Print 

Format - Select Plaint text or HTML formatting for your message 

Paint Format - Copies format from selected part of the text, then you can apply it to another 

selection 

Cut - Cut a part of text to clipboard. 

Copy - Copy a part of text to clipboard. 

Paste - Paste the text from clipboard. 

Remove Format- Remove all formats from selected text.  

Undo - erase the last change done to your email.  

Redo - repeats the most recently undid action. 

Outdent - Move selected text to the left (if this text was indent before). 

Indent - Move selected text to the right. 

Left to Right 

Right to Left 

Insert Link - add a hyperlink to your email. 

Insert Image- add an image to your email. 

Insert Table - add a table to your email. 

Insert Symbol - add a symbol to your email.  

Spellcheck language - Change the spell check language 

Customize- customize the layout of your email window. 

  

Please note that you can customize what tools you want to have present on the toolbar by clicking 
on customize button from the roll down menu.  
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Reading E-mails 

This is a picture of the application window. 

  

 

  

 In the middle section you can see your messages (in this case, these are grouped according to date 

- more on grouping here). In the default setting, you can see the contents of the selected message 

below the list of messages. This can be changed in View > Layout  

 

you can either have the message displayed right of the message list, or turn the message panel off 
altogether. 

  

The message list changes from one line layout to two-line layout if the width of the list is lower than 
the value specified in Menu >Settings in Mail section (where it can also be turned off). This settings 

panel can also be accessed by right-clicking the column header and clicking Customize current view. 

  

You can change the order of the columns in the message list, or add/remove columns by right-
clicking the column-header and choosing Columns configuration from the context menu. (more on 

columns - see here). 



Email Context Menu 

If you right-click on an email, the email context menu will be displayed. You will be offered a list of 
several actions that you can execute with an email. Utilizing most of them is quite straightforward, 
however, let's hold on for a moment at the option Download Selected. If you click on this option, 

the whole email will be downloaded, including embedded content and attachments. Thus the email 
will be available to work with when you turn offline.  

  

 

  

To open a message, double-click on it in the message list - the following window will pop up: 



 

Below the section that contains the fields Subject: From: etc. you can see the attachment bar. On 
this bar, all the attachments enclosed to the email can easily be accessed. To open/save the file, 
just double click it and select from the dialog window. 

  

If you receive an email that contains pictures that are online, these will be initially blocked by the 
application, as a measure of security (to download the pictures, your computer needs to access the 
server, which is an ideal situation for any evil scripts that are waiting to gather your personal 
information. However, if you trust the webpage, you can easily un-block the content by clicking the 
appropriate button. 

  

 

  



Changing message format 

If you need to switch between the HTML and Plain text message format for a specific email (for 
example if it's unreadable in one of the formats) you can easily do so either via 
Menu>Message>Format or via right-click inside the message and use the Format selector. 

 

Default Action for Attachments  

You can also adjust the actions that you would like to implement with different types of files while 
downloading attachments to your computer. For example when you receive a picture (e.g. .jpg) as 

an attachment and you click on the file, you will be asked whether you want to save or open it. 
Notice the checkbox which says "Do not ask me again for the attachments with the same 
extension." If you check this box and then click on one of the actions (Open/Save) the action you 
choose will be remembered for every .jpg file you receive in future without asking. 

  

 

If you want to cancel the action that you established for a specific attachment file type, then go to 

Tools -> Settings -> Attachments and just click on the red cross button (on the left)  and 

the default action will be canceled. 

  



 

  



Automatic Resizing of Images 

If you receive an image attached to your email it will be automatically displayed in the bottom of 
the email preview. There is a smart utility that automatically and simultaneously resizes the 
attached image as you resize the window of the email preview. If you want to display the image in 
its original size but still keep the email preview window arbitrarily resized, then click on the arrow 
symbol which can be found in the left upper corner of the image as you can see in the picture. 

  

 

  

Move to Junk Button  

  

 

  

Move to Junk button has three options: Just move to Junk, Move to Junk and blacklist email and 

Move to Junk and blacklist domain. To perform one of those actions, you have to click on the little 

arrow on the right. 

  

Note: Remember that if you enter the Junk E -mail section there will be Move to Inbox button 

which works in the same way as the Move to Junk button. The only difference, of course, is 
that you remove emails from Junk back to Inbox.  

  

Move to Junk: Moves the email to Junk, does not blacklist email (will not block emails from the 

sender in the future) and also does not blacklist domain. 



  

Move to Junk and blacklist email: Moves the email to Junk and blacklists the sender, but the 

domain will not be blacklisted (so for example emails from user john.black@activitycenter.com will 
not be received any more, but still some emails from the domain "@activitycenter.com" will be 
received. 

  

Move to Junk and blacklist domain: Moves the email to Junk and blacklist the domain, so you 

will not receive emails from the blacklisted domain any more.  

  

Clicking on the Move to Junk button without predefined action 

  

If you click on the Move To Junk button for the very first time or when you do not have predefined 
action for move to junk button, following window will appear:  

  

 

  

Here you can pre-define the action by ticking Don't ask me again option and selecting one of the 

tree options displayed. Since you have made the decision, selected action will be always performed. 
You can, of course, change your pre-definition by clicking on Tools -> Settings -> Confirmations. 

  

  

Removing blacklisted users from Blacklist  

  

If you want to remove blacklisted users from blacklist, simply click on Tools -> Rules and following 

window will appear:  

  



 

  

Double-click on the Blacklist item and following window will appear: 

  

 

  

Click on the Remove button and the action is complete.  

  

Removing Junk content via Move to Inbox button 

  



While you are browsing Junk section of your emails, you can use Move to Inbox button to restore emails 
from junk back into the Inbox.  

  

 

  

If you are restoring content which email is blacklisted you will be asked by following window 
whether you want just move it to Inbox or if you want to move it to Inbox and remove blacklisted 

email.  

  

 

  

Choose one of the two options and finish the process.  
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Conversations 

  

eM Client enables you to view your messages in three different conversation modes. To set 

particular conversation mode go to Menu -> View -> Conversations and here you will be able 

to choose from three different modes: Show Conversations in All Views, Show 

Conversations in Message Details Only, Disable Conversations. Lets explore the different 

modes one by one: 

  

Show Conversations in All Views: 

  

If you select this option you will be able to see conversations in the left panel. Every conversation 
will also display a number that indicates number of individual messages contained.  

 

  

If you click on the particular conversation all the messages contained will be displayed in the right 
panel. If there exist more unread messages in the conversation, the most up-to-date unread 
message will be selected and displayed as first. In case there is just a single unread message, it will 
be that message which will be selected and displayed. The last scenario is that all messages in 
conversation are marked as read. In such case the most up-to-date message will be displayed. Also 
note that those messages that are unread will be expanded (rest collapsed). If there are no unread 
messages then most up-to-date message will be expanded (rest collapsed). 

  



 

  

Show Conversations in Message Detail Only: 

  

If you select this option you will be able to see all inbox messages ordered according to the date of 
receiving. If you select any message in the right panel and it is included in a conversation then all 
messages from the particular conversation will be displayed. If there will be more unread messages 
in the conversation then all of them will be expanded. If all conversation messages are read the 
most up-to-date message will expand.  

  



 

  

Disable Conversations: 

  

If you select this option then conversations will not be applied and you will encounter what you 
might have been familiar with if you have been using eM Client before the version 7: in left panel 
the messages are ordered according to the Received date and what is displayed in the right panel is 
always only the selected message with the previous conversation displayed in classic textual form 
(see example below). 

  



 

  

By clicking on the little down-pointing arrow on the right, you will bring up a menu which relates to 
the displayed message only. Therefore in order to reply to or forward a particular message in a 
conversation you have to select the appropriate action from the list of this drop-down menu:  



 

  

  

  



Send and Receive 

  

There are several different operations you can perform on an Email. 

  

Refresh 

Click Refresh button to download and upload new data to all your accounts - this data can be new 

messages, change of Flags or Read status, etc. 

Click on the little triangle next to Refresh to bring up following drop-down list 

 

  

Click on Send and Receive to send all your outgoing emails and check for incoming emails at the 

same time. 

Receive all  

Check your email accounts for incoming emails. You can setup a regular time to check for new 

emails under Tools -> Setting -> General -> Synchronization 

Send all 

After you have completed writing an email, you can send it by click the Send button. You can also 

send saved emails. 

  

  

 

Reply 

Reply an incoming email by selecting it in the main panel and clicking Reply in the mail toolbar or 

select Menu -> Message -> Reply 

Reply All 

Reply all recipients of original email.  

  

Forward 

You can forward an email by selecting it in the email list and clicking Forward in the mail toolbar 

or select Menu -> Message ->Forward 

Note that you can forward the email either as Attachement or as Original. This can be selected 

from the drop down menu: 



 

  

Mark 

Select how would you like to mark your email from the drop down menu: 

 

Follow Up 

Manually mark your email if you want to follow up on it in future.  

Mark as read 

Manually mark an email you haven't opened as read by Right-Clicking it and select Mark as read. 

Mark as unread 

Manually mark an email you have already opened as Unread (perhaps to remind yourself to read 
more carefully later) by Right-Clicking it and select Mark as unread. 

Move to Junk 

You can select from three following moves: Move to Junk, Move to Junk and blacklist email, 

Move to Junk and blacklist domain 

Delete 

You can delete an email by Right-clicking it and select Delete, or simply press the Delete button on 
your keyboard. 

Tag 

Assign tag to your email. 

  

Click on the down-pointing or up-pointing arrow to move to previous or next email, subsequently.  

  

Various functions are also displayed when you right-click on email in your inbox. Following drop-
down menu will appear, where most of the functions are already explained above and those which 
are not, are listed and explained below: 



 

  

  

Move to folder... 

You can move your emails to another folder by Right-clicking the selected email(s) and select Move 

the folder. 



 

In the mini-explorer that pops up, select an existing folder or create a new one to which you wish 
your email(s) to be moved to. 

Copy to folder... 

Same as move to folder, except a copy of the selected email(s) will also be kept in the original 
folder. 

Show mail header... 

Opens a window with the header of the selected email. 

Show mail source... 

Opens a window containing the source of the selected email. 
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Managing Email 

You can create emails by clicking on the New button on the toolbar. 

Notice that if you type in a contact that is paired with a Chat contact, you will be able to see 
whether this contact is online (green dot) or offline (red dot). 

  

 

  

Menu 

The roll-down menu after you click on the Menu button at the top of the email window will contain 

following options: 

  

File 

• Save- saves the message into a draft.  

• Save as- saves the message into an .eml file.  

• Print 

• Close 

Edit 

• Undo 

• Redo 

• Cut 

• Copy 

• Paste 



• Paste as text 

• Find... 

• Replace... 

• Edit Source...  

Message 

• Send 

• Send as Mass Mail - PRO feature - sends one email per recipient, so it in result gives an 

impression that the email has been composed for each recipient separately. Inserting a 
Variable is interrelated with sending mass emails (see below). 

• Send later... - PRO feature - with this setting you can send the message at a later time. Just 

specify the time and date when you wish the message to be sent.  

• Flag 

• Tag 

• Reply to address - select from your available addresses or add a custom address 

• Request Read Receipt 

• Request Delivery Receipt 

• Format 

• PGP Format 

• Delete  

Insert 

• Signature  

• QuickText - QuickText enables you to insert pre-made chunks of text (for example snippets) 

to your messages within seconds. For more information see QuickText settings section.  

• Date and time 

• File... 

• Image... 

• Image as Link... 

• Link.... 

• Text... 

• HTML... 

• Table... 

• Symbol... 

• Line 

• Variable... - Variable is a function that allows you to insert for example variable date, 

variable contact name etc. For example when you select variable full name, following text 
will appear: "{Full Name}". Now insert any number of recipients, and when the email is sent, 
the name of each single recipient will appear instead of the variable. In other words {Full 
Name} will be displayed as John Doe, Alex Brown etc. Fallback option is there when the 
target field is blank or not found, for example when you want to insert "Given Name" and 
add several contacts to recipients and some of them don't has the field "Given Name" filled 
in, the fallback value (for example "Customer" is then used. 

• My public PGP key 



You can insert several types of items, for example Inserting image as link will allow you to 

insert image that is uploaded on the Internet or you can Insert a table, parameters of which you 

can further specify.  

Tools 

• Spell Check Language 

• Use Automatic Spell Check 

• Check Spelling 

• Translate with Bing Translator 

Help 

• Contents 

Email Header 

To: 

Enter the recipient of this email here. 

Subject: 

Enter a basic description of the Email.  

Add Cc & Bcc:  

You can click on  button to bring up two additional lines for: 

Cc: (Copy) 

Enter the email addresses you wish to send a copy of this email to. 

Bcc: (Blind copy) 

Enter the email addresses you wish to send a blind copy (the recipient of blind copies won't be able 
to see your email address) of this email to. 

Toolbar  

Components of toolbar are separated into two sections. First section concerns more with the 
elements of the message and the second part is more concerned with the editing of the message 
(Email Editor). The separation of the two sections is also indicated by the design of the email 
window itself.  

Send  

Click this button to send your email. 

In the drop-down menu you can also select to send the message as Mass mail or to Send it later, if 
you use PRO version of eM Client. 

 



Account drop-down menu 

You can choose an email account from which you want this email to be sent from (it is set to your 
default Email account by default). 

Attachment  

You can add the attachments to your email by clicking on small paperclip icon. 

Important  

Clicking this icon will set your email to be urgent . 

Signature  

Click this button to choose the signature you wish to use for the message (you can set up your 

signatures in Settings - Signatures, or you can access the signatures management window by 

choosing the Manage option from the menu). 

QuickText  

Click on this button to insert predefined QuickText of yours. For more information about how to 

create QuickText visit the QuickText settings section. 

Watch for Reply  

You can set up a notification either for when a reply to this message is received or if the recipient 
has not replied to your message in a specified amount of time. 

Sign  

Click to digitally sign your email with a security certificate so that the recipients can verify its 

authenticity. For more details refer to Security Certificates and how to configure security settings. 

Encrypt  

Click to digitally encrypt the contents of your email with a security certificate. The recipients will be 
able to decrypt your message with the attached security certificate if you have properly configured 

your security profiles. For more details refer to Security Certificates and how to configure security 
settings. 

Flag  

  

Email Editor 

 

  

Bold - The selected text will be bold. 

../../../Content/Settings/Certificates.htm
../../../Content/Settings/Certificates.htm
../../../Content/Settings/Certificates.htm


Italic - The selected text will be written in italic. 

Underline - The selected text will be underlined. 

Paint Format - Select certain area of the text while holding right mouse button, click on the Paint 

Format button, and then hover over different area of the text to transfer the format of the original 
text to the newly selected area. 

Font Style - click on the Font Style button to bring up following menu  

  

 

  

Ordered list - create a numbered list 

Unordered list - create a list of points 

  

 

  

Left Align - justify the text to the left. 

Center - justify the text to the center. 



Right Align- justify the text to the right. 

Justify Both Sides - justify the text on both sides 

Emoticons - add emoticons, gifs or stickers to your email. 

  

Click on the  button to bring up following additional features that could not fit in the 
toolbar: 

  

 

  

Read Receipt-Add read receipt to your email. Read receipt represents a notification that is 

delivered to you after the recipient opens your email  



Delivery Receipt- Add delivery receipt to your email. Delivery receipts confirm that the email has 

been delivered to recipient's mailbox.  

Reply to address - Set a different Reply-to address if you need the recipient to send a reply to 

different address than the one used for sending. 

Tags- Mark your email with arbitrary colorful tag. 

Save - Save the message to drafts 

Check spelling.. - Open the Check spelling window 

Print 

Format - Select Plaint text or HTML formatting for your message 

Paint Format - Copies format from selected part of the text, then you can apply it to another 

selection 

Cut - Cut a part of text to clipboard. 

Copy - Copy a part of text to clipboard. 

Paste - Paste the text from clipboard. 

Remove Format- Remove all formats from selected text.  

Undo - erase the last change done to your email.  

Redo - repeats the most recently undid action. 

Outdent - Move selected text to the left (if this text was indent before). 

Indent - Move selected text to the right. 

Left to Right 

Right to Left 

Insert Link - add a hyperlink to your email. 

Insert Image- add an image to your email. 

Insert Table - add a table to your email. 

Insert Symbol - add a symbol to your email.  

Spellcheck language - Change the spell check language 

Customize- customize the layout of your email window. 

  

Please note that you can customize what tools you want to have present on the toolbar by clicking 
on customize button from the roll down menu.  
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About Cloud Attachments 

Cloud attachments are attached files uploaded to a cloud storage service, so instead of 

sending the file directly, you are only sending a link to the given file to the recipient, 

which he can then use to download the file from the Cloud server. This way the message 

you are sending is much smaller in size and this can be especially useful when sending a 

large files or a big amount of files. 

Linked attachments have also a number of other perks - since you have instant access to 

your cloud storage you can update or remove the file at any time. You can also protect 

your file with a password or set an expiration date. This gives you better control over 

your data and makes sending files safer overall. 

  

eM Client currently supports these cloud storage providers: 

• OneDrive 

• Google Drive 

• DropBox 

• OwnCloud 

• Nextcloud 

  

You can set up your preferred Cloud Providers in Attachments settings and read about 

using Cloud attachments in your messages. 
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Cloud attachments are attached files uploaded to a cloud storage service, so instead of 

sending the file directly, you are only sending a link to the given file to the recipient, 

which he can then use to download the file from the Cloud server. This way the message 

you are sending is much smaller in size and this can be especially useful when sending a 

large files or a big amount of files. 

Linked attachments have also a number of other perks - since you have instant access to 

your cloud storage you can update or remove the file at any time. You can also protect 

your file with a password or set an expiration date. This gives you better control over 

your data and makes sending files safer overall. 

  

eM Client currently supports these cloud storage providers: 
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Using Cloud Attachments 

eM Client currently supports these cloud storage providers: 

• OneDrive 

• Google Drive 

• DropBox 

• OwnCloud 

• Nextcloud 

Depending on the setup and capabilities of each provider, you will have different options 

for what you can do with the cloud storage attachment, by right clicking it and selecting 

from the context menu. Some options are only enabled from a certain provider if you 

have a subscription to that cloud storage service. These options are available at the 

providers’ discretion. 

  

Add a Cloud Attachment 

To attach a file from your cloud storage as a link, first click the Attachment button the 

same way you would attach files normally. 

 

Then go to a cloud folder set on your device and choose a file you wish to add to your 

email as a link. 

Tip: Remember that you first need to download the cloud storage provider’s application 

on your computer and add it to eM Client 



 

  

A dialogue box will open, giving you a choice to link the file instead of physically 

attaching it. To link the file, click 'Yes'. 

 

Additionally, the option to attach the files uploaded to cloud storages only as links can be 

set as default behavior by clicking the box for Don’t ask me again. This default can be 

managed in Menu > Settings > Mail > Compose > Cloud Storage Attachments 

The credentials of your cloud storage account are required to proceed the first time. The 

password can be saved and remembered. Depending on the selected service, the login 

will appear differently. 

  

Upload attachment to a Cloud Storage 

You can also first add your attachment and then upload it to the set up cloud service via 

the right-click option Upload to cloud storage.  



 

Attachment options before upload 

  

After the file is uploaded to your prefered Cloud storage you also get a number of other 

options, namely Setting a password, Setting an expiration date for your download link 

and Allowing editing for text files. 

 

Attachment options after upload 

Open attachment 

This option is always available for all attachments, regardless of whether they are locally 

attached or attached with a cloud service. It opens the attached file, in case you want to 

check it one more time before sending the email. 



Send as a cloud storage link 

This will send the attachment as a link via your selected cloud service, instead of a 

locally attached file. Unchecking this option will revert the attachment back to being 

locally attached. 

Set password 

Available for Dropbox, Nextcloud, OneDrive, OwnCloud. 

This will enable you to set a password to protect the linked attachment. This ensures that 

no one except the intended recipient who knows the password can open the attachment 

link. There’s no way to recover this password if you forget it, but you can just send the 

same file again with a new password (or without one). 

 

  

Set expiration date 

Available for Dropbox, Nextcloud, OneDrive , OwnCloud. 

This option allows you to set an expiration date for the attachment link. After this date 

and time has passed, the recipient will no longer be able to access the file from the link in 

your email. 

Allow editing 

Toggle between read only and editable mode for documents of supported editable file 

types (for .rtf, .doc, .docx, .xls, .xlsx, .ppt, and .pptx files) 

The remaining options are always available for all attachments, regardless of whether 

they are locally attached or attached with a cloud service 

Save As 

It allows you to save the file on your computer. 



Copy 

This copies the attached file so you can paste it. 

Remove 

Removes the attachment 

Select All 

Selects all the attachments instead of just a single one. 

Save All Attachments 

It allows you to save all the attached files on your computer. 

Open All Attachments 

It opens all the attached files 
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Rules 

In this day and age, email has overtaken the copy machine, the notice board, and memo slips to 
become the main mode of communication in the corporate environment. With various departments 
passing on orders, counter requests, and memos, the daily email traffic in a large company can 
easily run into the hundreds. Or if you are a person like me, that has interactions with my Facebook 
friends, bosses, colleagues and parents all converging in my Inbox, then you would need something 

to help compartmentalize your emails. You would need Rule based filtering. 

  

Rules are special logical statements that can be used as guidelines for the application to separate 
your incoming emails into different groups. For instance you can make a rule like "All emails from 
your friend Bob go to a special folder called 'Bob's emails'" or "All emails from the accounting 
department with the Keyword 'weekly report' in the subject to go to the folder 'weekly accounting 

report.'" All you have to do is to make those two rules and apply them, and all the emails from Bob 
and all weekly accounting reports will be taken out of your Inbox and put into their respective 
folders. 

  

You can create and manage your rules by selecting Menu -> Rules... 

You can make a new rule, modify or remove the existing ones. You can also change the priority of 

rules and apply rules... 

  

In the window you can see a list of your rules, their names, when they are to be invoked and on 
which accounts. 

  

 

  

There are two types of Rules in eM Client: Local and Server side rules. 

  

Local rules 

Local rules are only applied when eM Client is running, and the changes are only synced to the 
server once eM Client is connected to the internet. Therefore, if you set up a local rule "After a 
message has been received from bob@example.com, move to folder "Bob's emails" then this rule 
will only be applied once you check your email in eM Client. It will not be applied if the eM Client 



application is closed and you check your email via webmail instead. Local rules are usually applied 
directly after an email has been received/sent, but you can apply Local rules to old emails at any 
time in eM Client by clicking the Apply button within the rules window, or by right-clicking an email 

folder and selecting “Apply rule”. 

  

There are two pre-made Local rules in eM Client: 

Spam filter - This is a default SPAM filtering rule that takes suspicious messages and moves them 

to a Junk folder. This rule cannot be altered. 

  

Blacklist - This rule is created the first time you use the 'Move to Junk and blacklist email /domain' 

feature and you can add more addresses and domains into it (or remove them). 

  

Server side rules 

Currently available for Exchange/Office 365 and IceWarp mail servers 

Server side rules are applied directly on the mail server. This means that the server rules you create 
in eM Client will show up and be applied in other places where you check the email, such as webmail 
or your phone. The available rule creation templates are fewer for server side rules (such as not 
being able to set a rule for when an email is sent) because of the limitations of the providers’ APIs. 

Additionally, there are some rule conditions available from servers that aren’t supported yet by eM 
Client’s UI. This doesn’t mean that the rule won’t be applied, it just means that you won’t be able to 
edit the conditions of that rule within eM Client. Finally, it’s important to know that server side rules 
are only applied on incoming messages. It’s not possible to apply a server side rule on old messages 
within eM Client. Running server rules on old messages must be done within your webmail. 

You can switch between your lists of Local and Server side rules (if available) by clicking on the 
drop-down menu next to the + New rule button. If this drop-down menu isn’t available, that means 

that you haven’t added a mail account which supports server side rules in eM Client. 

 

  

Edit or remove rules 

You can edit rules by selecting the rule and clicking the Edit button. The edit window is the same as 

the rule creation window you see when you create new rules - you can define conditions, actions 

and exceptions. 



Removing the rules is quite easy - just select the rule from the list and click Remove rule. 

Change priority of rules 

Just select the rule in the list and click  Move up or Move down. 
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Rules 

In this day and age, email has overtaken the copy machine, the notice board, and memo slips to 
become the main mode of communication in the corporate environment. With various departments 

passing on orders, counter requests, and memos, the daily email traffic in a large company can 
easily run into the hundreds. Or if you are a person like me, that has interactions with my Facebook 
friends, bosses, colleagues and parents all converging in my Inbox, then you would need something 
to help compartmentalize your emails. You would need Rule based filtering. 

  

Rules are special logical statements that can be used as guidelines for the application to separate 

your incoming emails into different groups. For instance you can make a rule like "All emails from 
your friend Bob go to a special folder called 'Bob's emails'" or "All emails from the accounting 
department with the Keyword 'weekly report' in the subject to go to the folder 'weekly accounting 
report.'" All you have to do is to make those two rules and apply them, and all the emails from Bob 
and all weekly accounting reports will be taken out of your Inbox and put into their respective 
folders. 

  

You can create and manage your rules by selecting Menu -> Rules... 

You can make a new rule, modify or remove the existing ones. You can also change the priority of 

rules and apply rules... 

  

In the window you can see a list of your rules, their names, when they are to be invoked and on 

which accounts. 

  

 

  

There are two types of Rules in eM Client: Local and Server side rules. 

  

Local rules 

Local rules are only applied when eM Client is running, and the changes are only synced to the 
server once eM Client is connected to the internet. Therefore, if you set up a local rule "After a 
message has been received from bob@example.com, move to folder "Bob's emails" then this rule 
will only be applied once you check your email in eM Client. It will not be applied if the eM Client 



application is closed and you check your email via webmail instead. Local rules are usually applied 
directly after an email has been received/sent, but you can apply Local rules to old emails at any 
time in eM Client by clicking the Apply button within the rules window, or by right-clicking an email 

folder and selecting “Apply rule”. 

  

There are two pre-made Local rules in eM Client: 

Spam filter - This is a default SPAM filtering rule that takes suspicious messages and moves them 

to a Junk folder. This rule cannot be altered. 

  

Blacklist - This rule is created the first time you use the 'Move to Junk and blacklist email /domain' 

feature and you can add more addresses and domains into it (or remove them). 

  

Server side rules 

Currently available for Exchange/Office 365 and IceWarp mail servers 

Server side rules are applied directly on the mail server. This means that the server rules you create 
in eM Client will show up and be applied in other places where you check the email, such as webmail 
or your phone. The available rule creation templates are fewer for server side rules (such as not 
being able to set a rule for when an email is sent) because of the limitations of the providers’ APIs. 

Additionally, there are some rule conditions available from servers that aren’t supported yet by eM 
Client’s UI. This doesn’t mean that the rule won’t be applied, it just means that you won’t be able to 
edit the conditions of that rule within eM Client. Finally, it’s important to know that server side rules 
are only applied on incoming messages. It’s not possible to apply a server side rule on old messages 
within eM Client. Running server rules on old messages must be done within your webmail. 

You can switch between your lists of Local and Server side rules (if available) by clicking on the 
drop-down menu next to the + New rule button. If this drop-down menu isn’t available, that means 

that you haven’t added a mail account which supports server side rules in eM Client. 

 

  

Edit or remove rules 

You can edit rules by selecting the rule and clicking the Edit button. The edit window is the same as 

the rule creation window you see when you create new rules - you can define conditions, actions 

and exceptions. 



Removing the rules is quite easy - just select the rule from the list and click Remove rule. 

Change priority of rules 

Just select the rule in the list and click  Move up or Move down. 
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New rule 

  

A rule is made up of four parts: invocation condition, condition, action and exception. 

Invocation Condition: whether the rule is to be invoked when mail is received or when a mail is 

sent. Click on the underlined word receivedto change the condition of invocation. 

Condition: logical conditions which when met will trigger the rule. 

Action: action to be taken on the messages fitting the rule. 

Exception: conditions that act as exceptions to the rule. 

  

Basic rules 

There are seven basic types of rules that you can modify to suit your needs. Some rule templates 
are only available for Local rules: 

1. Move message from someone to a folder 

 

  

With keywords: received, people, folder. Click on each keyword to define when (received) a rule is 

applied, from whom (people) the email comes, and to which folder you wish the emails to be moved 

to. 



  

2. Move message with defined words in subject to a folder 

With keywords: received, words, folder. Click on each keyword to define when (received) a rule is 

applied, containing which wordsin subject, and to which folder you wish the emails to be moved to. 

  

3. Move message with defined words in body to a folder 

With keywords: received, words, folder. Click on each keyword to define when (received) a rule is 

applied, containing which wordsin message body, and to which folder you wish the emails to be 

moved to. 

  

4. Move spam messages to Spam folder (Local rule only) 

With keywords: received, X-Spam-Status: Yes, X-Spam: yes, Junk E-mail 

  

5. Set tag for message from somebody (Not available for IceWarp) 

With keywords: received, from, tag. Click on each keyword to define when (received) a rule is 
applied, from which senders (from people) and which tag is to be assigned to all such 

messages. 

  

6. Apply custom rule on message I receive 

Using this template you can customize a rule that will apply to received messages. Check the 

conditions and exceptions you would like to include in your rule and then specify the values by 
clicking on the underlined blue text. 

  

7. Apply custom rule on message I send (Local rule only) 

Using this template you can customize a rule that will apply to sent messages. Check the 

conditions and exceptions you would like to include in your rule and then specify the values by 
clicking on the underlined blue text. 

  

  

Additional Conditions 

Click next to proceed to the rule customization window. Here you can add additional conditions to 

your rule. Rules are made up of keywords and you can combine these keywords to form arbitrarily 

complex rules by checking the conditions you need from the list, and clicking on the underlined 

words in Rule preview to specify the parameters. 

  



 

  

Available rule components include: 

• with words found in subject 

• from people 

• processed with account 

• sent only to me 

• my name is in the To field 

• my name is in the Cc field 

• my name is in the To or Cc field 

• my name is not in the To field 

• sent to people 

• with words found in body 

• with words found in body or subject 

• with words found in header 

• with size in specified limits 

• has attachment 



  

When using the from people condition you can set the full email address, just the domain or any 

smaller part of it using these options: 

• Exact match 

• Domain 

• Contains 

• Starts with 

• Ends with 

• Wildcard 

 

Actions 

Click Next to define the actions to be taken for this rule: 

  



 

  

• move to folder 

• move copy to folder 

• delete mail 

• permanently delete mail 

• forward to people 

• mark message as read 

• stop processing other rules 

• set tags 

• skip notification 

  

Exceptions 

Click on the button Next to define exceptions for the rule: 

  



 

  

• except with words found in subject 

• except from people 

• except when sent only to me 

• except when my name is in the To field 

• except when my name is in the Cc field 

• except when my name is in the To or Cc field 

• except my name is not in the To field 

• except when sent to people 

• except with words found in body 

• except with words found in body or subject 

• except with words found in header 

• except with size in specified limits 

• except when the message has attachment 

Finally, click Next to give the rule a name and select whether you wish to enable the rule right 

away. Click Finish and save your new rule. 
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Apply rule 

Only Local rules can be applied. 

  

When you select Apply  button in the Rules explorer window, you will be prompted to 

specify the rule and the folder on which to apply the rule: 

  

 

  

Select folder(s) by clicking on Select folder(s): 



 

  

Click on Run to execute the rule on the selected folders. 

  

You can also apply rule by right-clicking on particular folder and selecting Apply Rule... from the 

context menu.  

Just as you can see in the picture.  
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Automatic Replies 

Automatic replies, also called Vacation responder or Out of office messages is a feature which 

enables you to set a message which will be automatically sent as a reply to any received email 
within a set timeframe. 

This feature can be accessed in Menu>Tools>Automatic replies. 

 

  

You can then select an account in the Account: drop down menu. 

  



 

  

Enabled: check this option to enable the automatic replies and uncheck when you want to turn the 

feature off 

First day: Set a first day when the replies start being sent  

Last day: Set a last day on which the messages are to be sent 

Target: 

All 

Only to my contacts 

Subject: You can set a custom Subject line to your Automatic reply 

Message: Content of the Automatic reply, usually to explain reason of your unavailability. We also 

suggest including a day of your return, so the recipients know not to contact you again before 

you're back. 

  



This feature is currently available only for users with Gmail accounts, IceWarp accounts and 

accounts which use Exchange Web Services protocol. 

  



Mail Forwarder 

  

This feature can be accessed in Menu>Tools>Mail Forwarder and is currently only available for 

IceWarp accounts. 

 

  

You can then select an account in the Account: drop down menu. 

 

  

Forwards all email to: The email address your messages should be forwarded to 



Do not forward spam: Check this option so that messages marked as spam on the server are 

not forwarded 
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Watch for Reply 

This feature is available only to the Pro license users. 

  

The Watch for reply feature is a new button available in the toolbar of the New message window. If 

you expect a reply for an important email you can set up a special reminder in eM Client thanks to 
this option. 

You can either get a reminder for when such a reply is received to draw your attention to it, or you 
can get reminded after a specific time frame that your message was not replied to, so you can 
reach out to the recipient again. 

After you enable Watch for Reply, a copy of the message will be saved in a special Favorite folder 

called Unreplied, so you can check which replies you're waiting for at any time. 

You can also disable the reminder from this folder, should the recipient reach out to you via other 
means and the reminder if no longer needed. 

 

  

How to enable Watch for Reply 

While composing a message 

Click on the eye icon and select if you want to be notified when the recipient has replied, or hasn’t 
replied within a certain amount of time. 

 



  

After sending a message 

Go to your Sent folder and right click on an email you’ve sent. Select Watch for Reply select if you 
want to be notified when the recipient has replied, or hasn’t replied within a certain amount of time. 

  

Please note that the Watch for Reply option will not be available if you’ve already received a reply to 
the email. 
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Snooze 

This feature is available only to the Pro license users. 

  

The Snooze feature is a powerful productivity tool that allows you to temporarily remove emails 

from your Inbox when you don’t have time to respond to them. When an email has been snoozed 
within eM Client, a copy of the message will be saved in a special Favorite folder called Snoozed, so 
you can check which emails you’ve postponed replying to at any time and see until when the 
message is scheduled to be snoozed. You can also disable the reminder from this folder, if you find 

time to reply to the snoozed email sooner than expected and the reminder if no longer needed. 

  

 

  

Once the Snooze timer is finished, the message will reappear back in your Inbox like a normal 
incoming email, except it will have some indication that you snoozed it, such as a bell icon or a 
different color for the time. You can then choose to leave it in the Inbox and finally reply to it, or 

snooze it again. 

 

  

How to Snooze and email 

Right-click the message and pick the option for Snooze and then select until when the message 
should be snoozed for. 



 

  

Or click the Snooze option from the Main Toolbar at the top of the page. Unless you pick a specific 

time, the default snooze will be until tomorrow at 9:00 am 

 

  

How to unsnooze an email 

Go to the Snoozed folder under Favorites, right-click the message and pick the option for Snooze > 
Unsnooze 

Or click the Unsnooze option from the Main Toolbar at the top of the page. 
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PGP 

Pretty Good Privacy or PGP is a public key encryption program that has become the most popular 
standard for email encryption - it follows the OpenPGP standard (RFC 4880) for encrypting and 

decrypting data. 

Pretty Good Privacy uses a variation of the public key system- each user has an encryption key that 
is publicly known and a private key that is known only to that user. To send encrypted messages 

you need the public key of your recipient. To decrypt a message sent to you, you will use your 
private key to decrypt it. 

  

To explain how sending/receiving such encrypted message works, let's set and example with two 
users, Jerry and Clara: 

  

• Jerry generates a PGP keypair for his email directly in eM Client and selects his passphrase 

• Jerry sends the public part of his keypair to Clara 

 

  



 

  

• Clara receives Jerry's email with his public key and is asked if she wants to import Jerry's key 
to eM Client 

 

  

  

Clara import the key and from now on, she can send Jerry encrypted emails. 

• She composes a new email. 

• Adds Jerry to recipients. 

• Clicks on the encrypt icon in toolbar, which is available because she has her own keypair 
setup. 

• And sends the message 

  



 

  

• The message is sent through the internet completely encrypted, and only Jerry is able to 
read it 

• Jerry receives the encrypted email, types the right password and is able to read the message 

 



 

  

Find more instructions on creating keys and managing them in the Certificates and Keys. 
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Spell-checker and Translator 

This product comes with a build-in spell checker that will enable you to make sure that there are no 
typos or mistakes in your emails. The spell-checker is turned off by default and it can be turned on 

in Menu -> Tools ->Settings -> Spell Checker (see here). 

You can also access spell-checker settings in the message composition window - in Tools. 

  

 

  

You can either choose to use automatic spell check (the system language will be used), or select the 
language manually from the list. The spell-checker works pretty much in the same way that you are 

used to (from MS Word etc.). It will underline the words that do not match its dictionary. By right-
clicking the underlined word, you access a list of suggestions and you can also choose to add the 
word into the dictionary to avoid its being underlined again and again. To save time you can click on 
Check Spelling in Tools, the following window will pop up: 

  



 

  

Translator 

This product allows you to translate your messages from and to a number of languages by 
using Bing Translator. This function is accessible from the Tools menu in the message window. 

  



 

  

If you click on Translate with Bing Translator, following window will appear: 

  

 

  

First you need to specify the source language (by default, the auto-detect function is turned on). 
Then specify the target language by selecting destination language and then click Translate - and 

the process of translation will execute automatically as you can see on illustrative example bellow. 
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What is Archiving? 

Email archiving is the process of removing emails from your Inbox to be stored in a separate, yet 
easily accessible location. 

There are two types of Archiving within eM Client. The first type is server-side (manual) 
Archiving which moves your messages to a newly created Archive folder within your email account 

or in a Gmail account, the messages are stripped of their labels and moved to the All Mail folder. 

The messages are still saved to your account, but they no longer appear in your Inbox.  

This type of archiving is for IMAP and Exchange (EWS) accounts. 

  

The second type of archiving is Automatic (local) Archiving. For this type of archiving, older 

messages are automatically periodically removed from your email accounts, and placed into a Local 

Folder within eM Client. This means that the archived messages will no longer sync with your 
account and will only be locally available within eM Client.  

This type of archiving is good for people with a small amount of storage available in their email 

server. 

  

Server-side Archiving 

Simply click on the Archive button in the toolbar , or right click the message and 

select Move to Archive. 



 

The messages will be moved to an Archive Folder within your account. If you’re using IMAP or EWS 
protocol, this archive folder will also be synced to your other devices where you check your email. 
The only exception to this rule are Gmail and Google Workspace accounts. 

  

Gmail Archiving 

We support the native Gmail Archive function. This is a specific function which removes the 'Inbox' 
label from a message in Inbox, leaving the message accessible in the 'All Mail' folder. 

You can read about Gmail's native archiving and what it means on Google support. 

  

Local Automatic Archiving 

eM Client contains an Automatic Archiving feature which allows you to download all messages 

older than a selected number of days from the server and keep them stored on your local drive. 

You can find this option under Menu > Settings > Mail > Automatic Archiving. Make sure to set 

Archiving scope under Account Preferences before you enable or perform archiving. With the 

archiving scope, you set what folders and accounts the archiving will be performed on. You can then 
set how often the archiving will be made and how old the messages affected must be. 

https://support.google.com/mail/answer/6576


 

  

The messages are moved to a locally stored Archive Folder. 
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About Contacts 

The Contacts section is where you store your most valuable asset, your contacts. 

Here you can store both contacts from your Email correspondence as well as those from your 
instant messaging networks. You can pair the two kinds of contacts to create a centralized contacts 
list for your quick access. 

Find out more about creating new contacts, managing your contacts, and our Contact Avatar 
downloading. 
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New Contact 

There are three ways to add a new contact. The first is to click on the top line (the line is separated 
by thick line, see screen shot bellow), fill in required fields and press enter. This is the fastest way 

how to add new contacts. (applicable also for tasks and events). 

 

  

 The the secondis to click on the arrow button New and select Contact... 

 

  

And the third way is to right click on the Contacts panel, then select New Contact. 



 

  



New Contact window 

 

  

Overview tab:  

  

You can set full name of the contact by clicking on the button Full Name...This window will 
show: 

 

  

You can fill the boxes with information about your contact.  



  

Company: 

Enter the name of the company this contact works for. 

Tag: 

Assign particular tag to your contact. 

Job title: 

Enter the contact's job position E.g. Financial Consultant. 

File as: 

Enter a name you wish the contact to be shown in your contact list, doesn't necessarily have to be 
his or her full name. For example feel free to file your new contact under his nickname.  

E-mail 

You can enter up to three different email addresses for the contact by clicking on the Add Email 
button (the cross sign) 

 

  

Display as: 

you can bring up Display as option by clicking on corresponding icon:  

  

 

  

The display name for the contact's email addresses can provide a way to identify the Email in case 
the email address does not contain any distinguishing identifiers or your personal preferences. 

  



 

  

  

Phone numbers 

Many types of phone numbers can be filled. You can for example add phone numbers for Work, 
Home, Fax, Mobile but also select among many other types. 

 

  

Add IM: 

You can add several types of IM to the contact: jabber, ICQ, skype etc. Click on the button Add IM 

to bring up following window:  

  



 

  

click on the down-pointing arrow in the Instant Messaging service to bring up following roll-down 
menu which displays full list of available IMs to add contact to: 

  

  

Add Webpage:  

If a contact has a personal web site, you can enter it here by clicking on the Add Webpage button 

(Cross sign). 

  

Add Address: 

You can change the type of address by clicking on the Add Address button and selecting from 
custom fields provided: 



 

  

Attachments and Browse files: 

  

Like with Events and Tasks, you can attach files to your Contact profiles. 

 

Click on Browse files... to add any files relevant to this contact. Any image, power point, document 

files that are related to the person or his work can be added here. 

Details Tab 

The details tab is where you can store all the professional and personal details about the 
particular contact. 

 

Most of the fields in the General tab of contact are straightforward (full name, company, tag etc.) 
However, note the option at the very bottom, where you can easily change the folder for a 



particular contact. If you do so, the contact will be automatically moved to the desired folder. This 
utility works also for editing Tasks and Contacts. 

  

Also note that the fields present in the picture (File as, Nickname, Birthday etc.) are the default 
ones and you can easily customize the Contact Details tab by adding more of them. Simply click on 
Add Personal Details to bring up following window: 

  

 

  

or on Add Business Details to bring up following window: 

  

 

Most of the additional fields are self-explanatory, however following tags are worth mentioning: 

  

Freebusy URL: Part of calendar service. Can contain the contact's daily schedules, helpful when 

arranging events with this contact. 



Calendar URI & Calendar Request URI: These are web locations to which calendar requests are sent. 

This is handled automatically, only in rare cases need to be filled in manually. 

  

  

Certificate Tab 

  

In the Security Tab you can import and manage security certificates to be used to encode 
messages sent between you and the contact. 

 

  

Here in this tab you can import, select and set default security certificates to be used for 
communications with this contact. Certificates received in the incoming mails from this contact will 

be automatically stored here too. 

You might want to read more about security certificates in the Certificates section. Or learn about 

Security configurations in the Security section. 
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Distribution List 

  

eM Client enables you to create so called distribution list, which is basically a list that can contain 
any number of contacts. Once you have created the distribution list, you can use it by filling in its 
name in to the recipient field, while you are writing a new message, and the message will then be 
simply sent to all contacts that are contained in the particular distribution list. To create a 

distribution list click on New -> DistributionList and the following window will appear.  

  

 

  

In the List name, fill in the name of the new distribution list.  

By clicking on the Add member button, you can choose to add an email address manually or 
open list of your contacts to select from them: 

  



 

  

Check any number of contacts and then click on the OK button.  

Once you have selected some contacts they will be displayed in the in the central field of the 
Distribution List window. 

You can also assign tag to your distribution list. Simply click on the down pointing arrow in the Tag 

field and assign arbitrary tag to your distribution list. Check Private field, if you want the distribution 

list to be private. 

By clicking on the Remove button (trash bin icon) next to particular contact, you will remove 

corresponding contact from the distribution list. 

By clicking on the  Folder icon at the very bottom of the window, you will be able to select a folder 

in which you wish your distribution list to be located.  

Click on the Save button to finish the process.  

  

You can also drag and drop contacts from the main window onto the Distribution list creation 
window to add them. 

  

Working with Distribution List 

  

Write the name of the distribution list to the recipient field while you are filling in the addressee 
field. Once you have selected the distribution list, you can click on the plus sign icon next to the 
name of distribution list to display the full list of included contacts . 



  

 

  

Once you click on the plus sign, following self-explanatory window will appear: 

  

 

  

  

  



Contact views 

There are three Contacts views in eM Client, which you can navigate between by using the Main 
Toolbar at the top of the window 

 

People view 

This is the default Contacts view in eM Client 8. Here you can easily see your list of contacts for 
each account by name, email address, and photo. 

When you select a contact from this list, you will be able to select three additional options which will 
give you more personal details about the contact and your email and attachment history with them. 

 

Contact - shows you their personal details and allows you to add notes about them 

History - shows your entire email history with them and allows you to search directly within it. 

Attachments - shows your entire attachment history with them and allows you to search directly 

within it. 

 

Business Cards view 

The Business Cards view allows you to see your various contacts and their most important details in 
a display that looks like a business card. It includes details like their photo, name, display name, 

email address, telephone numbers, organization and job title, as well as any applied Tags. 



 

List view 

The final Contacts view is the List view. This displays your contacts’ information in a series of rows 
and columns like a spreadsheet or classic database. 

Each of the columns have headers which tell you what type of information is contained in that 
column, such as full name, email address, phone number, tag. 

 

Tip: There are some pre-selected sorting systems available for you to use, such as by 
phone, company, or location. Selecting Custom will allow you to view all possible 
fields and you can click on any column header to sort by that column. 

  

Copyright © 2021 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 

Czech Republic  

support@emclient.com  



Managing Contacts 

You can access your contacts by navigating to your specific accounts under the contacts bookmark 
in the Left Navigation Panel or in the Contacts section of the Sidebar. Browsing the Contacts 

bookmark will display your contacts in the main panel, browsing the Contacts section of the Sidebar 
will display your contacts in the Sidebar. 

  

Main panel contact overview: 

 

Once the contacts are listed, you can delete contacts by pressing delete on your keyboard or by 
clicking on the delete button on the toolbar, or you can drag and drop your contacts to any folders 
under your other accounts. 

  

Pairing Your Contacts: 

  

There are basically 3 ways how to pair your contacts: 

1. Adding a chat contact to your contact list in Contact Card Window. 

 2. Pairing regular contacts to your chat contacts while using Contact Pairing 
Assistant.  

3. Drag-and-dropping chat contact on regular contact and vice versa. 

  

ad 1: Adding IM contact to contact list via Contact Card Window 

  

Double click on a contact to bring up the Contact CardWidow. In the Add IM section on the right 

hand side, click Add...(the cross sign) to add the IM account(s) associated with this contact. 

  



 

  

  

By clicking on the Add... button you will display following window:  

  

 

  

In the Instant Messaging service section you can select service from which you would like to 

pair a chat account with your regular account. Select "Jabber" if you know that for example an ICQ, 
MSN, AIM etc. account is set up on the particular chat account then the service will be ready to use. 
Please note that the list of services contains Jabber protocol services enlisted particularly - ICQ, 



MSN, AIM etc., which will not be ready to use, when you set them up for the regular account - your 

paired account will only contain information about the other ICQ, MSN, AIM account. Click on OK 

button to finish the process.  

  

Also, please, note that if you select for example ICQ from the Contact Service list, you will be 
asked to type-in Contact ID manually.  

  

  

ad 2: Pairing a contact card to an imported instant messaging contact 

  

When you log on to your Jabber service for the first time, you will be prompted to import your 
contacts. 

Later you can select Chat Contacts Pairing Assistantin chat settings option. Following window 

will pop up: 

  

 

  

 After you have selected the Chat account from which you wish to import your contacts, all the 

contacts contained in this chat contact list will be displayed in the list below. 

To pair a particular chat contact with a regular contact, select a regular contact by clicking on 

it to bring out a drop down list (you can see it in the picture below). There are two other 
options on this list:  

Take no Action- nothing happens with the chat contact 



New Contact- creates a new contact in the selected folder and pair the chat contact with this 
new contact. 

  

 

  

Once you have chosen the regular contact, click on Pair Contacts to pair the Chat contact with 
a regular contact. Now the process of contact pairing is complete.  

  

ad 3: Drag-and-dropping chat contact on regular contact and vice versa: 

  

Please note that there is also an easier way - just drag a contact (a Chat contact) and drop it 
on the contact you wish to pair it with (we are speaking about contacts in the Contact list/Chat 
bar). You will be prompted to confirm the pairing with the following window: 

  

 

  

Contact Properties 

  

To get to the contact properties window, right click on particular contact folder and select 
Properties...  

Following window will appear:  

  



 

  

Here you can customize your contacts' display, you can select up to two options - Show in 
Agenda and Show in All Contacts folder.  

If you check Show in Agenda, events such as birthdays of the users from particular contact folder 

will be displayed in agenda.  

If you check Show in All Contacts Folder, particular contacts from selected folder will be also 

displayed in All Contacts folder. By un-checking this option, the particular contacts will not be shown 
in All Contacts folder. 
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Avatar downloading 

eM Client automatically downloads and displays avatars for your contacts from the web. 

We download images from Gravatar, domain icons and more. 

  

If no image is saved for your contact on server or in your Contacts section, the contact's initials will 

be shown instead. 

  

  

You can manage these options in Contacts settings. 

https://gravatar.com/


About Calendar 

The Calendar offers an easy way to keep track of appointments, schedule your time and share your 
calendar with other people through the CalDAV protocol, as well as contacts through CardDAV 
protocol (if available). 

You might ask, "what's wrong with conventional calendars, you know, the ones made of paper?" To 
which we say, you might as well have asked, what's wrong with the telegram? Or the steam engine? 
This product's calendar does everything that conventional calendars do and a large number of other 
advanced and useful features - for example up-to-date weather forecast for a few upcoming days. 

Events recorded in the calendar can be reminded by visual alerts. The calendar can be arranged into 
various layouts. One can hardly get paper calendars to switch between day, week or month layouts 
or to send out invitations and collect responses for organizing meetings and other events, or even 
fill itself up with your regular events! Yet this product's Calendar can do all that with a few mouse 
clicks. 

The following links will show you - how to get started or work with more than one calendar, how 

to work with the calendar's toolbar and different layouts, how to change the calendar's preferences 

and especially how to work with events, and add event requests. 

  

  

Creating Search Folders for Calendar 

It is possible to create a search folder from relevant search process by right-clicking on the down-
pointing arrow next to the search bar and selecting Create Search Folder... from the context menu.  

  

 

  

Please note that this is the only way to create search folders for calendar.  
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Getting Started 

eM Client sets up a default calendar for you when you create an account. Its default name is 
"Calendar" and it can be found under Local Folders in the Calendar bookmark on the left vertical 

panel of the interface.  

 

A new sub-panel will appear, consisting of two parts: 



 

  

The upper part contains a hierarchical tree of your calendars. In the calendar management window, 

you can create new calendars and edit or delete existing ones. See Using More Than One Calendar 
to find out how to fully utilize the Calendar to organize your day. Select a calendar by clicking on it 
to display the contents of each calendar in the central panel. 



The lower half of the calendar sub-panel is the calendar page of the current month. The days 

displayed in the current calendar's layout in the central panel are highlighted here. You can also 

select the day/week/month (according to the layout view currently selected in the calendar's 
toolbar) to be displayed in the central panel by clicking the corresponding place in the small 

calendar in the sub-panel (you can cycle through the months with the two arrow buttons next to the 
name of the month). 

Calendar's central panel 

When you have selected a calendar in the left vertical panel, its contents are displayed in the 

Central Panel. Depending on which layout view you have chosen for your calendar in the calendar's 
toolbar, your events in the selected calendar will be displayed in the Day, Week, or Month calendar 

in the central panel. 

The central panel is where you create and edit events pertaining to a specific calendar, see Working 

with Events. 

To learn about how to change the appearance of the calendar's central panel by selecting between 

different layout views see Calendar Views. 

  

Calendar Properties 

You can access Calendar properties by clicking on particular Calendar on the Sidebar and selecting 

option Properties...  

Following window will appear:  

  



 

  

You can change the Calendar Color used inside the application. 

  

You can also choose Default reminder time and Default meeting length for a specific 

calendar. 

  

There are two additional settings that can be checked - Show reminders and Show in 
Agenda.  

  

If you check Show reminders, the reminders from calendar folders will always be added to the 

list of reminders. If you want to deactivate this function, keep the checkbox un-checked.  

If you check Show in Agenda, the events from the particular calendar that are up-to-date will be 

displayed in Agenda.  
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Calendar Views 

As mentioned at the beginning of this chapter, eM Client's calendar supports multiple layout views. 

You can select a view type which suits your schedules the most. In this section, we will walk you 
through the individual view modes. 

Before we start the tour through the individual views of the calendar, let us present one useful tip 

for calendar users - you can create a completely custom view by simply holding the Ctrl key and 
left-clicking on particular days in the small calendar window in the bottom left corner in order to 
select or deselect the days.  

Day View 

  

 

The day view is the most detailed as it focuses on the shortest period of time. 

The arrows on top of the central panel switch between upcoming and previous days.  

Next to the arrows is a label indicating which day (or week/month in the case of week view /month 

view) is currently selected and displayed.  

  

Schedule in the central panel is divided into hours which are divided according to the value specified 

in the granularity drop down menu in Calendar preferences.  

  

Calendar events are ordered in a vertical timeline. Each event is colored (you can pick any color you 
wish in the toolbar by clicking on Calendar Color) and contains the basic information (subject, start 

time, tag, recurrency and reminder settings).  



  

Events that last the whole day or span several days are displayed in the upper section of the 
calendar, before the timed schedule (so that these events don't interfere with the daily schedule). 

You can zoom in and out by holding Ctrl and using the scroll wheel. The layout of the calendar will 
expand or condense accordingly. 

  

 

  

Events in the main panel can be drag-and-dropped on a different time or resized to a different 
length.  

To move an event, click on an event box with the left mouse button and drag the event on another 

time and release the mouse button.  

  

To extend or reduce the duration of an event, move the pointer to the upper or lower area of an 

event and after the pointer changes its shape, click the left mouse button and resize the event as 
necessary. 

Moving events to a diferent date - events can be drag-and-dropped to the small calendar on 

the left. This smart utility is very useful in case you want to change the date of the event but you 
want to keep the same time schedule - just drag and drop the event on the desired date. 

 

  



If you hover the mouse pointer over an event, a pop up balloon tooltip will appear, showing event 
details, including subject, start time, end time and description. This also works in the week view and 
month view. 

  

 

  

Week View 

  

 

  

All the functions offered in Day View can be found in Week View, the only difference is that the 
Week View displays one week at a time. If you want to see the schedule for workdays, select Work 

Week View in the calendar's toolbar. You can also zoom in and out by holding Ctrl and using the 

scroll wheel. The layout of the calendar will expand or condense accordingly. 

  

Work Week View 

  

 

  

Work Week View is the same as Week View except that only the days which you have set up as 

work days will be displayed. To set up your work week go to Menu -> Settings -> Calendar.  

  



Upcoming 

  

 

  

Upcoming View is the same as Week View except it shows today and the next 6 days.  

  

Month View 

The Month View layout allows you to see the events of the entire month. 

  

Events that last less than a single day are ordered the same way as in the other layouts. Daylong 
and multi-day events are displayed before other short events and are sorted by their starting time. 
Notice that today's date is highlighted - this has been added for easier orientation in the month view 
layout.  

  

 

  

Days that contain more events than what can fit into their window will have three little dots 
displayed in the upper right corner (see picture below). Hover over the three dots to see how many 
events are hidden.  

  



 

Agenda 

  

 

  

This layout does not display events in a calendar but instead in a comprehensible list of events, with 
each line containing the details of a single event.  

By default, events are ordered by their starting dates. Recurring events are listed only once, at the 
time of their first occurrence. 

  

 

This view is particularly useful when searching for particular events. It allows you to arrange events 
by different parameters by simply clicking on a column header. Click on the column header again to 
switch between ascending and descending orders. 

You can customize the List View by right-clicking at the column heading. Select Columns 
configuration. 



 

Add the columns you would like to see in your List View window by selecting them and pressing 

Add. You may also arrange the order in which the columns are displayed by first selecting a column 

heading and pressing Move Up or Move Down. 

You can also resize the width of columns by clicking between two columns in the table header and 

dragging the cursor right or left as needed. 

Hide Past button 

 

 Hide Past button automatically hides all the events in calendar that are out of date.  
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Toolbar 

Toolbar is located on the top of the application window and it changes according to what you are 
currently working on. You can customize the individual items you want to be displayed on the 

toolbar by right-clicking on the toolbar and selecting Customize, which will bring up the following 

window: 

  

 

here you can customize what items you want to display in the toolbar. Using appropriate buttons, 

you can Add items from Available items column to Items to show column or subsequently Remove 

them. Click on Set Defaults button to restore default settings. Note that you can add the items in an 
arbitrary order, depending on what order you add them to the Items to show column. 

  

 

New 

This option is common to all four modules of this product, however in Calendar view it will be 
primarily bound to the New Event option. In Calendar mode you can create new events in your 

current calendar by clicking on the New button and New Event window will pop up.  . This will bring 

up the event editing box where you can create a new Calendar event. 

Print 

By clicking the Print button you will be redirected directly to the Print window. To display the 
Print Preview window go to File ->Print Preview (by default Ctrl +Shift + P), where you 

will be able to see a preview of what you are going to print as well as modify any settings to 
customize the layout of the printed page. 

  



 

In the drop-down menu in the top right-hand corner of the window, you can specify 

the view you wish to print (detailed, table, week, month).  

  

In the top left-hand corner of this window you can see the following four buttons: 



 

Print - click this button to print the preview 

Page setup - click to access the following menu, where you can set up the layout of the printed 

page. 



 

  

Print settings - click to access the following menu, which contains three tabs (Week 

View, Month View and Day View) 

 



  

 

  

 

  

If you check the Print only workdays field, Saturdays and Sundays will not be printed. 

Using the drop-down menu, you can define the granularity you wish to use. 

In the Print Range section, you can specify the range you wish to print. If you check the Use 

calendar range option, the calendar settings will be used. 



  

Zoom - Here you can adjust the zoom ratio in which you would like to have the about-to-print 

page. 

  

View Options 

The calendar can switch between several layout views. In the Toolbar, you can select one of four 

ways to display and manage the events in our calendar.   

  

Day View  

The day view displays the most details since it focuses on the shortest period of time. 

The arrows at the top of the central panel switch between upcoming and previous days.  

Next to the arrows is a label indicating which day (or week or month in the case of week view or 
month view) is currently selected.  

  

The schedule in the central panel is divided into hours, these are divided according to the value 
specified in the granularity drop down menu in the Calendar preferences. 

  

 

  



Calendar events are ordered in a vertical timeline. Each event is colored (you can choose any color 
you like on the toolbar) and contains the basic information (subject, start time, tag, recurrency and 
reminder settings).  

  

Events that last the whole day or span several days are displayed in the upper section of the 
calendar, before the timed schedule (so that these events don't interfere with the daily schedule). 

  

 

  

Events in the main panel can be drag-and-dropped on a different time or resized to a different 
length.  

  

To move an event, click on an event box with the left mouse button and drag the event to another 

time and release the mouse button.  

  

To extend or reduce the duration of an event, move the pointer to the upper or lower area of an 

event and after the pointer changes its shape, click the left mouse button and resize the event as 
necessary. 

  

If you hover the mouse pointer over an event, a balloon tooltip will appear showing the details of 
the event, including subject, start time, end time and description. This also works in the week view 
and month view. 

  



 

  

  

Week View 

  

 

  

All the functions offered in Day View can be found in Week View, the only difference is that Week 

View displays one week at a time. If you want to see the schedule for workdays, select Work 
Week View in the calendar's toolbar.  

  

  

Work Week View 

  

 

  

Same as week view except that only the days which you have set up as "days when you work" will 

be displayed. To set up your work week go to Settings -> Calendar.  

  

  

Month View 

The month view layout allows you to see the events of the whole month. 

  



Events that last less than a single day are ordered the same way as in the other layouts. Day long 
and multi-day events are displayed before other short events and are sorted by their starting time. 

  

 

  

Days that contain more events than can be fitted into its window will have three dots in the upper 
right corner of the window. Click on the three dots to switch to day view, allowing you to see all 
your scheduled events in the particular day. 

  

 

  

  

Agenda 

  

 



  

This layout does not display events in a calendar but instead in a comprehensible list of events, with 
each line containing the details of a single event.  

By default, events are ordered by their starting dates. Recurring events are listed only once, at the 
time of their first occurrence. 

 

  

This view is particularly useful when searching for particular events. It allows you to arrange events 
by different parameters by simply clicking on a particular column header. Click the column header 
again to switch between ascending and descending orders. 

  

  

Searching Calendar 

 

To search your Calendar use the Agenda section which you can find on the right-hand side of the 
interface.  
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Calendar Preferences 

Access the calendar's settings by right-clicking anywhere on the calendar's main panel and select 
Calendar Preferences from the context menu, or select Menu ->Tools -> Settings from the main 

menu, then select the Calendar section in the Settings window. 

  

 

  

The Calendar Settings window consists of four sub-sections: Calendar View, Work Week,, 
Balloons and Agenda (Events List). 



Calendar View  

Show week numbers: 

If you check this option, there will always be a week number displayed in the month view of the 
calendar, according to the current year.  

Granularity: 

This option allows you to choose the granularity of the day and week view layouts. 

The days are divided into hours by default. If you want to plan your time more accurately, you can 
split the hours into slices of 5, 10, 15, 20 or 30 minutes. This time unit is important when you are 
moving and resizing events by Drag & Dropping event boxes because you can't adjust the events by 
smaller time units than defined here. 

Show Range: 

This option allows you to set the "height" of your calendar's layout. The value specified in this field 
determines how many hours will be visible at one time in the calendar's central panel. 

So, if you set 24 hours in this field, you won't have to scroll at all in your calendar's central panel, 
leaving you plenty of room for your nocturnal activities. 

Source of event's color in multi-calendar mode: 

You can define the source of the of an event's color while you are in multi-calendar mode. This 
option is useful when you are working with more than one calendar. You have three options:  

Tag then calendar - will prefer tag color and ignore calendar color. 

Calendar then tag - will prefer the color of a calendar and the tag color will be determined only by 
the tag indicator. 

and Calendar only - will display calendar color primarily while you only one calendar is selected.  

Number of weeks in month view: 

 You can set the number of weeks by 3 different ways: in the calendar settings; by pressing ctrl and 
simultaneously scrolling with the mouse-wheel while in month view of the calendar; or by pinch 
gesture in touch mode of the application.  

Work Week  

In this section, you can define the parameters of the work week. When it starts, when it ends and 
which days it contains. 

Balloon tooltips panel 

In this panel you can define the behavior of the popup balloon tooltips which appear when you 

hover the mouse pointer over an event box. These tooltips contain the events' info. You can learn 

more about balloon tooltips in the Calendar Views section. 

Agenda (Events list) 

Check Show groups in agenda to have groups displayed in Agenda (Events list). 

Defaults 

In this panel you can set default meeting lengths and reminder lengths. You can select whether you 
want to apply them to all folders or only to selected ones.  
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Calendar Sharing 

eM Client can synchronize its calendar with shared calendars on the server. This way multiple users 
can access the same calendar. This feature is useful for scheduling public resources. For example, 

employees can log onto a public calendar to book company cars or meeting rooms or check the 
availability said cars or rooms. 

  

To access a shared calendar, you proceed in the same fashion as if you were setting up a normal 
CalDAV account: 

  

Select CalDAV in Account wizard. 

 

Fill in the URL of the shared CalDAV location, your username and your password. 

  



 

  

Finally you need to enter your credentials in the account window or when being prompted 
during account synchronization. 



 

  

You now have a calendar account that is synchronized with a public calendar, any changes you or 

other users make will be uploaded to the same CalDAV server and displayed in your eM Client's 
Calendar. 
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Edit Events 

Resizing and moving events 

All event blocks can be moved to a different time by Drag & Dropping them. All Events can be 
moved and rescheduled in this simple way in all view layouts that are available in Calendar. 

To change the duration of an event in the day or week view, move the pointer to the upper or lower 
area of an event box and when the pointer changes to a double headed arrow, left click and resize 
the box as required. 

When drag & dropping events, remember you can only change the events by the time unit specified 

in the granularity option in the calendar's toolbar. You can't resize/move events by smaller time 

units than the specified units. 

Deleting events 

To delete an event, select the Delete button on the toolbar, the Delete option from its context 

menu or simply click on the event box and press the Delete key on your keyboard. 

You can also Copy, Cut and Paste events like you would do with texts, with the standard Ctrl+C 

(Copy), Ctrl+X (Cut) and Ctrl+V (Paste) hotkeys. 

Event reminders 

For important events, you can set reminders that will regularly send you alerts as the event 
approaches. 

To set up a reminder, open the Event Editor window for a specific event (see working with events), 

in the General tab and enter the amount of time ahead of the event you wish to start receiving 

notification alerts in the Reminder: field. The default value is No Reminder, which means you will 

not receive any alerts before the upcoming event. To set a reminder, click on the drop-down list and 
select a time amount from 5 minutes to 2 days ahead of the event to start receiving reminders.  

  

The event reminder is displayed in an alert window that includes a list of all upcoming events. Each 
row contains the subject of the specific event (task) and time left to the start of the event. 

  

 



  

The alert window offers you several ways to interact with the notification system and the event(s) 
themselves: 

Open Item 

Click the button to open the event's create-and-edit dialog window. 

Dismiss (All) 

Click the Dismiss all button dismiss all displayed reminders in the window or use the bell icon to 

snooze the individual reminder. Reminder alerts will no longer be displayed for the selected events 
with the exception of repeated events. 

Snooze (All) 

Snooze works much like the same button on an alarm clock. Click Snooze (zzz)icon or Snooze All to 

temporarily dismiss the alert. But more alert windows will continue to be displayed at the time 
interval specified in the Snooze Time drop-down list. 

Tip: you can also manually disable event reminders by opening up the Event Editor 

window and setting the Reminder field to its default No Reminder. 

  

Warning: The reminder window is active only when eM Client is running. 
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Working with Events 

Creating and editing events 

Events are the basic entries in your calendars. 

  

To create a new event in a calendar: 

On the calendar toolbar select New>Event . 
If you are using this option for the first time, you will be provided with an option to create Standard 
event or Online Meeting: 

 

  

You can use the Always use this option to lock in your selection for next time and choose each 

time. 
You can also change this setting any time later in Menu > Settings >Calendar>General>Defaults. 

  

Right-click on the calendar itself then select New Event.... 

  

or, double-click the calendar in the Central Panel. 

  

However, by far the easiest way is to draw a rectangular outline of your event by drag and drop 
your mouse on the calendar. 

  

The last way how to create an event is to move with your keyboard arrows from box to box and 
subsequently write a name of the event and ultimately press enter. This way of creating events is 
by far the fastest one if mastered by the user.  

  



 

  

Type in a name for this event and press Enter to create a default one time event with only the time 
and name you have specified. To add more details double click on the newly created event to bring 
up the Event editor window. 

Event settings 

All the basic configuration can be defined in this window: 

  

 

  

At the top you have the Save & Close button used for finishing you event. 

Next to it is the Calendar selection, you can use the drop-down menu to select a different 



calendar. If you do so, the event will be automatically moved to the selected folder. This utility 
works also for editing Tasks, Contacts and Notes. 

 

Simply click on the down-pointing arrow and select desired folder from a drop-down list.  

  

Title 

The subject of the event. This information will be displayed in the calendar window after the event is 
saved, therefore it should be as brief as possible. 

All day event 

In the all day event, the start and end time items are missing. This means that this event will be in 
progress over the entire day, but other events can be still planned for this day. The typical example 
is setting entire-day events like wedding anniversaries, symposiums, vacations, business trips, etc. 

Start  

Start time of the event. Consists of two fields, date and hour. 

End 

End time of the event. 

If the date part of end time of a given event differs from its start time date, a multiple day event 
is created. These events are listed in the upper part of the schedule, under the all day events. This 
way they don't mess into the daily schedule. 

Show as 

You can select a type of your event - You can be busy or you can be free. 



  

Reminder 

Reminder is a special function of the interface, that allows reminding of events. If the reminder is 
set for an event, an alert is displayed at the defined time that informs of an upcoming event. The 
default value is No Reminder, but any different value can be selected from the drop-down list. To 

cancel the reminder, simply choose the No Reminder option in the event's dialog box. For more 

information about working with reminder see section Edit Events. 

Tag 

In the tag drop-down menu, you can assign color-coded tags to the selected event. In the 
calendar's central view, events will be shown colored according to their tags designated here. In 

case of multiple calendars, each calendar is assigned its own tag (see Using More Than One 
Calendar). The tag's color will be shown in the event's heading (Except in a month view layout). For 

more details on Tags see About Tags. 

  

 



Recurrence  

The Recurrence tab is used to set recurring tasks which take place every given number of days, 
weeks or months. 

In this tab you can set how often will the task be recurred and when (if ever) will the recurrence 
terminate. 

 

Frequency 

You can set frequency daily, weekly, monthly or yearly. 

Recurrence range 

You can set here when the event should end. There are three options: 

No end date - The event will recur for ever and ever and ever... 

End after X occurrences - You can set the number X. The event will not recur after X 

occurrences. 

End by - You can set a date. The event will not recur after this date. 

  

Pattern 

Frequency daily - In the pattern you set the number of days when the event should recur, 

  

Frequency weekly - In the pattern you can set the number of weeks when the event should recur. 

You can also choose the days of the  

 week on which the event should recur (e.g. in the following picture, the event will recur every week 
on Monday and Saturday). 

  

Frequency monthly -  In the pattern you set the number of months when the event should recur. 

You can also set a day - you can set the number of day in month, or set for example "second 
Monday". 

  

Frequency yearly - In the pattern you set the number of years when event should recur. You can 

set a date for event or set for example "second Monday of February". 

Location 

Enter the geological or descriptive location of your event. eM Client will automatically offer 
previously used locations once you start typing. 



Participants 

Participants are those contacts that are invited to particular event and their status is determined by 
responding to the event request or not (their status can also be set manually). 

Private event 

If you check Private event, this event will get a private status. 

  

  

  



Event Requests 

Once an Event has been created, you can send attendance requests to others through Email.  
For Calendar providers that have an auto-scheduling feature the Invitations and Event updates will 
be sent automatically by the server. 

  

Sending an email to attendees 

 

  

You can manually send an email, reply or forward the event using the options under Menu>Event. 

  

 
 

Scheduling 

  

In the All attendees list type in the list of potential attendees you wish to be invited to the event. 

  



 

  

Type of resource - select type of resource by clicking on the second icon next to he 
participants name which will bring up a list of options (Required, Optional, 

Resource) form which you can choose and select one:  

 

  

Pick Previous and Pick Next- By clicking on Pick Previous or Pick Next the next or 
previous time window will be found, i.e. time period when all participants actually 
have time. 

  

Refresh- click on  icon to refresh the information when participants have free time 

Options- click on  icon to bring up the list of options for scheduling 

  

 



  

Here you can select if you want to show only working hours/days and you can also zoom in/out.  

  

There are three types of requests that can be sent to each attendee: Required, Optional, and 

Resource. Each can be selected by clicking on the box next to the attendees' emails. 

  

Each time you add a contact to your list of attendees, if you have the Freebusy URL 
for that contact setup (see relevant section in New Contact creation), you can see 

the schedule of the attendee, which can help you organize the event. 

  

A response to your request can be obtained from each attendee in the form of Accepted, Declined, 

or Tentative. which will also be displayed in this window next to each attendee's email address. 

 

  

Once all the necessary details have been entered into the Event editor, click Save to finish editing. A 

prompt will appear asking you whether you wish to send invites to the attendees listed, click Send 
invite to close the editor and send invites. 

  

Tip: Should you delete or make changes to your events after you have sent out your 
event invites, a notice of change/cancellation will be sent to each of the attendees 
accordingly. 

  

Your invitee will receive an invite such as the one below in their email, they can send you a reply by 
clicking on either Accept, Tentative, or Decline respectively, which will show up in your Event 

window. 



 

  

  

  

Tip: if you have a Google account set up in application, your Google Calendar will be 
automatically synchronized to your Calendar. 

  

Description 

To any event it is possible to add a comment referring to various issues such as event details or lists 
of items related to the event. 
The description field contains the same toolbar options as composition of email and other items and 
you can also customize the toolbar to fit your needs. 

Location 

Location of the event - for example: at work, at home, at school... 
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Using More Than One Calendar 

eM Client allows you to create multiple calendars, each of them dedicated to separate aspects of 
your life (one calendar for your work duties and another for your leisure time for example). Multiple 

calendars offer several advanced functions, like simultaneous displaying of events, distinct colors for 
events from the individual calendars or hierarchical structuring of your calendars. 

These features are provided through the Calendar sub-panel in the left-most vertical panel of the 

interface. Open this sub-panel by clicking on the Calendar label in the left-most panel (if the panel 

is already displayed, clicking on this label will minimalize it). 

The Calendar sub-panel consists of two parts: 



 

In the lower part you can see the calendar view of the current month. You can learn more about its 

functionality in the Getting Started section. 

The upper part contains the hierarchical tree of your calendars. All the functionality connected to 
using multiple calendars is provided by this tree. 

The root folder of the tree is created automatically and goes by the name "Calendar". This folder is 
always the top-most in the tree and cannot be deleted or renamed. 



Creating new calendars 

Right-click anywhere into the Calendar sub-panel (if you click on an existing calendar, this calendar 

will be selected as a default parent for the newly created calendar folder in the hierarchical tree). A 
context menu will appear. Choose the New calendar... option and a dialog window will open.  

  

 

Insert the requested name for the new calendar into the Name: field. In the Select where to place 
the folder: panel, you can choose, where the new calendar folder will be situated in the hierarchical 

tree (the default position is determined by the place you have right-clicked in the Calendar sub-

panel). You can also choose the color that will be used for this new calendar. When you're done, 
click OK and a Calendar will be created and inserted into the tree structure. 

Editing existing calendars 

You can also rename calendars, delete them and choose colors for the events contained in them. All 
these options are available via the context menu of the calendars, simply right-click the desired 
calendar and choose the requested option. 



 

Displaying events from multiple calendars 

If you want to display events of multiple calendars at once, tick the checkboxes situated before 
every calendar folder in the hierarchical tree structure. 

By default, only the events of the currently selected calendar are displayed in the central panel. But 
if you check the box before a given calendar, its events will be always displayed, no matter which 
calendar is currently selected. This feature is particularly useful when combined with the usage of 
separate colors for the single calendars. This way you'll always see which event belongs to which 
calendar. The last couple of versions of our product do even enable you to edit events of any of the 
selected calendars, unlike to the previous versions, where you could edit only those events that 
belong to the currently selected calendar. 
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About Tasks 

We have all wondered exactly when our days of youthful vigor turned into a life lived by a to-do list 
stuck on our fridge. We all inevitably have to end such musings with a sigh, check off "get more 

eggs" then go on to "pick up the laundry." What we can do however, is to make that list more 
convenient and more helpful. 

If you are ready for something a little more 21st century than that writing pad on your fridge, eM 

Client is here for you! This product's task management tool is the central storage of all your tasks, it 
can remind you of your duties with automatic alerts, and keep track of the progress of your various 
activities. 

Getting started 

A default task folder is prepared for you when you create your account. You can access it by clicking 
the Tasks bookmark in the left-most vertical panel of the eM Client's interface. 

 

A new sub-panel will open, containing the hierarchical tree of your task folders: 

 

In this panel you can customize and manage your task folders. You can create new task folders, 
rename or delete existing ones. All this is accomplished via right-clicking and selecting the desired 
option from the context menu. 

If you click on any of your task folders in this panel, the central panel will switch to a task list view 

of the chosen task folder. In this view you can see all the tasks from the given task folder and you 

can also create new tasks and edit/delete existing ones here. 

  

Creating Search Folders for Tasks 

It is possible to create a search folder from relevant search process by right-clicking on the down-
pointing arrow next to the search bar and selecting Create Search Folder... from the context menu.  

  



 

  

Please, note that this is the only way, how to create search folders for Tasks.  
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Please, note that this is the only way, how to create search folders for Tasks.  
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Task List Display 

In this product, the tasks are shown in a simple list that contains data such as the subject of the 
task, scheduled deadline and the status of the task. 

 

  

Sorting tasks by columns 

 The detailed information on individual tasks is displayed in the columns. The tasks can be sorted by 
the details listed in individual columns. Click the column heading to sort tasks in the ascending or 
descending order (see the arrow next to the column's name) by alphabet, date or other criterion, 
depending on the column contents.  

Adding and deleting columns 

Users can customize the appearance of the table and the information shown. The columns can be 
added or deleted and their order can be changed. Right-click the table header, select Columns 
configuration... and specify the column settings in the Columns window.  

 

Checked columns will be shown in the dialog box, unchecked columns will be hidden. You can also 
change the order of columns. Just use the Move Up and Move Down buttons in the Columns window 

or simply use the Drag&Drop technique directly in the table header (left-click on one of the column 
headings and drag it onto the heading of the column you want to switch with). 

Adjusting the column width 

The width of the task list's columns can be adjusted. To change the column width, click between two 
columns in the table header and drag the cursor right or left as needed. Another option is to use the 



Columns window (right-click the table header and select Columns configuration...). In there select 

the desired column and specify the requested number of pixels. 

Completing tasks 

After a specific task is solved, it can be marked as solved in the task list using the checkboxes in 
front of every task. When the task is checked, its status is set to completed. 

  

Hide Completed button 

 

 Hide Completed button automatically hides all tasks that have been already completed. 
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Creating and Editing Tasks 

Creating new tasks 

To create a new task, select New in the toolbar, the other way is to right-click a task folder in the 

Tasks sub-panel in the left vertical panel and select New task from the context menu. The last and 

by far the fastest way, when you are in the Task section, is to click on the top line (the line is 
separated by thick line, see screen shot bellow), fill in required fields and press enter.  

 A Task create-and-edit dialog will open. 

General tab 

 

Title: 

The title of the task. This information will be displayed in the task list and therefore it should be as 
brief as possible. 

Location: 

Location of the task. 

Start: 

Start time of the task. Consists of two fields, date and hour. The default value is the current date 
and hour. 



Due: 

Time required for completion of the task. 

Reminder: 

Reminder is a special function of the interface, which allows reminding of upcoming tasks. If the 
reminder is set for a task, an alert is displayed at the defined time that informs of an upcoming 

task. By default the Reminder: checkbox is unchecked, meaning that you won't be reminded of the 

task. But if you check it and set a date and time in the Reminder: fields, an alert will be displayed at 

the specified time. To cancel the reminder, simply uncheck the Reminder: checkbox. 

Tag: 

In the tag drop-down menu, you can assign color coded tags to the task. Tags provide a way for 
you to recognize and assess the nature of a Task at a glance, whether a Task is work related, 

personal or requires immediate attention etc. (For more details on Tags see About Tags).  

  

Status: 

Each task goes through several stages during the process of its completion. Here you can define 
what stage is the selected task currently in. 

Complete: 

Shows what percentage of the task has already been completed. 

Recurrence:  

The Recurrence tab is used to set recurring tasks which take place every given number of days, 
weeks or months. 

In this tab you can set how often will the task be recurred and when (if ever) will the recurrence 
terminate. 

Private task: 

If you check the checkbox, the task will get the private status. 

Assign to: 

Assign the task to any number of your contacts and an invitation will be send to them.  

Description: 

Detailed information can be provided for each task. 

Attachment: 

Like with Emails and calendar schedules, You can add attachments to your tasks, maps, notes, 
power point slides etc. 

Location: 

Specify location of the task.  

Folder:  

you can select a particular folder by left-clicking on the directory at the left bottom corner. If you do 
so, the task will be automatically moved to the selected folder. This utility works also for editing 

Events and Contacts. 

Editing tasks 

Existing Tasks can be edited through the same Task editor window. To edit an existing task, double-
click on it to bring up the Task window. 



Deleting tasks 

To delete a task select it in the task list and press the Delete key. 

  

Displaying Tasks in Agenda and in Calendar tasks 

To customize displaying tasks in your Agenda and in Calendar tasks, right-click on the Task folder 
from one of your accounts and choose Properties... from the contextual menu. 

The following window will appear : 

  

 

Here you have 3 options that can be used: Show reminders, Show in Agenda, Show in Calendar 
tasks 

  

If you check Show reminders, the reminders of tasks in a particular task folder will be shown 

(active), if you uncheck this option, reminders set up in this task folder will not be active.  

  



If you check Show in Agenda, the tasks from a particular task folder will be shown in the Agenda 

section on the right.  

  

If you check Show in Calendar tasks, the tasks from a particular task folder will be show in your 

Calendar view , just as you can see in the picture: 
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About Attachments 

What Are Attachments? 

An email attachment is a computer file sent along with an email message. One or more files can be 
attached to any email message, and be sent along with it to the recipient. This is typically used as a 
simple method to share documents and images. Attachments can also be added to other processes 
in eM Client, such as Calendar events, Notes or Tasks. 

What is the Attachment View? 

In eM Client 8, we added a dedicated Attachment View (similar to the Calendar View or Contacts 
View) where you can centrally manage all of your attachments you’ve sent, received, or uploaded in 
eM Client. 

How to Navigate in Attachment View 

Like the other views in eM Client, you navigate in the Attachment View primarily through the 
account folders on the left side panel. From there you can filter if you want to see attachments from 
all your accounts in eM Client, or if you only want to look for attachments from specific accounts or 
services. 

Additionally, you can filter the type of attachments which are displayed by clicking on the options 
highlighted in the blue box below 

All - displays all types of file attachments 

Images - only displays picture files such as .png, .jpg, or .gif 

Media - only displays video or sounds files such as .mp3, .mp4, .webm or .wav 

Documents - displays document files such as .doc, .xls, .pdf, .txt, .log or .rtf 

Archives - displays compressed files like .zip 

 



Searching Attachments 

After narrowing down the chosen account, service and file type, you can search further for a specific 
attachment using the search bar in the upper right corner. 

A cool new feature of eM Client 8 is that the search now also searches through the text within your 
attached document files. This makes it much easier to find a document, even if you don’t remember 
its name. 

 

Attachment View Main Toolbar 

There are 6 options in the main toolbar at the top of the Attachment View. Like any top toolbar, you 
can right click on it in order to customize the displayed options and their order. 

 

List - Changes your display of attachments to the list style 

Cards - Changes your display of attachments to the card style 

Save as - Saves the chosen attachment locally on your computer 

Forward - Creates a new email with the chosen attachment already attached 

Open Source - Opens a window in eM Client where the chosen attachment comes from, such as 

the email where the attachment was received. 

Delete - Deletes the chosen attachment 
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About Notes 

This feature is available only to the Pro license users. 

 

  

Notes are meant as a place to store information about something. It’s like writing an email without 
a recipient. 

eM Client supports local and server-side Notes. You can write fancy notes with pictures and 

attachments, organize them via tags, and sync notes across all your devices.  

Server-side notes currently work with Exchange, Office365 and IceWarp accounts. 

You can get to the Notes View by clicking on the notepad icon in the bottom left corner of eM Client 

 or by clicking the three dots  in the lower right corner and selecting “Notes” 

  

Individual notes can be exported from eM Client in a vNote file (.ics) format. 

eM Client Notes can also import new notes from vNote .ics files. 
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Creating and editing Notes 

This feature is available only to the Pro license users. 

New Note 

There are three ways to add a new note. 

The first is to click on the top line (the line is separated by a thick line, see screenshot below), type 
a note title and press enter. This is the fastest way how to add a new note. 

 

  

The second way is to click on the arrow button New and select Note... or just click the New button 

when in the Notes section. 

 

  

The third way is to right click the empty space below your other notes and select New 

 

A Note create-and-edit dialog will open. 

Edit Note 

Deleting notes 

To delete a note, select the Delete button on the toolbar, the Delete option from its context menu or 

simply click on the note box and press the Delete key on your keyboard. 



You can also Copy, Cut and Paste notes like you would do with texts, with the standard Copy 

(Ctrl+C), Cut (Ctrl+X) and Paste (Ctrl+V) hotkeys. 

There is no Note Trash folder. 

When a note is accidentally deleted, it can be temporarily recovered with the Undo command, but 

the note will be permanently deleted when you do another operation which supports Undo, or exit 

the eM Client application. Please restore accidentally deleted notes immediately or you risk 
permanent deletion. 

Editing notes 

Existing notes can be edited through the same note editor window. To edit an existing note, double-
click on it to bring up the note window. 

This window will be similar to an email compose window with a lot of the same features in its 
composition toolbar 

Toolbar 

Components of the toolbar in the editing window are separated into two sections, the upper toolbar 
and the composition toolbar. 

Upper toolbar: 

 

Save & Close: Click this button to save your edits to the Note and close the editing window 

Folder selection: You can choose which account’s Note folder you want this note to be saved to. 

Save: This will save your current edits on the note, but not close the editing window. 

Forward: This will generate a new email out of the Note you created. The subject of the email will 

be the Note title and the message body of the email will be the message body of the Note. 

Forward (as attachment): This will allow you to send this Note to someone as an .ics attachment in 

an email. Clicking this will generate a new blank email with the .ics file with the note already 
attached. 

Delete: This will delete the note which is currently open 

  

Composition toolbar 

 

Attachment: You can add the attachments to your note by clicking on the small paperclip icon. 

Private: This marks the note as private and the note will not be included in the folders you share 

with other people (link about folder sharing coming eventually) 

  

Note Editor 

 

Bold - The selected text will be bold. 

Italic - The selected text will be written in italic. 

Underline - The selected text will be underlined. 



Paint Format - Select certain area of the text while holding right mouse button, click on the Paint 

Format button, and then hover over different area of the text to transfer the format of the original 
text to the newly selected area. 

Font Style - click on the Font Style button to bring up following menu 

 

  

Ordered list - create a numbered list 

Unordered list - create a list of points 

  

Left Align - justify the text to the left. 

Center - justify the text to the center. 

Right Align- justify the text to the right. 

Justify - justify the text on both sides 

 



Emoticons - add emoticons to your note. 

  

Click on the Morebutton to bring up the following additional features that could not fit in 

the toolbar: 

 

Cut - Cut a part of text to clipboard. 

Copy - Copy a part of text to clipboard. 

Paste - Paste the text from clipboard. 

Remove Format - Remove all formats from selected text. 

Undo - erase the last change done to your note. 

Redo - repeats the most recently undone action. 

Outdent - Move selected text to the left (if this text was indented before). 

Indent - Move selected text to the right. 

Left to Right - change the character insertion for text to follow a Left to Right pattern (used for LTR 

languages such as English or Russian) 

Right to Left - change the character insertion for text to follow a Right to Left pattern (used for RTL 

languages such as Arabic or Hebrew) 

Insert link - add a hyperlink to your note. 

Insert image - add an image to your notel. 

Insert table - add a table to your note. 

Insert symbol - add a symbol to your note. 

Customize - customize the layout of your note window. 



  

Please note that you can customize what tools you want to have present on the toolbar by clicking 
on Customize button from the roll down menu. 

  

Deleting notes 

To delete a note select it in the note list and press the Delete key. 

  

Note List Display 

In this layout, the notes are shown in a simple list that contains data such as the subject of the 
note, scheduled deadline and the status of the note. 

 

Sorting notes by columns 

The detailed information on individual notes is displayed in the columns. The notes can be sorted by 
the details listed in individual columns. Click the column heading to sort notes in the ascending or 
descending order (see the arrow next to the column's name) by alphabet, date or other criterion, 

depending on the column contents. 

Adding and deleting columns 

Users can customize the appearance of the table and the information shown. The columns can be 
added or deleted and their order can be changed. Right-click the table header, select Columns 

configuration... and specify the column settings in the Columns window. 



 

Checked columns will be shown in the dialog box, unchecked columns will be hidden. You can also 
change the order of columns. Just use the Move Up and Move Down buttons in the Columns window 

or simply use the Drag&Drop technique directly in the table header (left-click on one of the column 

headings and drag it onto the heading of the column you want to switch with). 

Adjusting the column width 

The width of the note list's columns can be adjusted. To change the column width, click between 
two columns in the table header and drag the cursor right or left as needed. Another option is to 
use the Columns window (right-click the table header and select Columns configuration...). In there 

select the desired column and specify the requested number of pixels. 
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Chat 

  

eM Client has built in Chat/Instant Messaging service which will allow you to communicate instantly 
with other users of Jabber Instant Messaging network as well as many other Jabber compatible 
networks such as Google Talk, ICQ, AIM etc. 

  

Instant Messaging service is fully integrated into its Emailing and Contacts managing modules, 
which means you easily browse your chat log like you can with Emails, and send emails to your 
Messaging contacts as easily as you can with your other Email correspondents. Furthermore, the IM 
and Email modules share their contacts pool; this way this product can merge your Email contacts 
with your instant messaging contacts and thereby create a truly integrated contacts roster. 

  

Although application supports only the open Jabber protocol, it supports the use of Transports which 
will enable you to connect to other networks depending on the Jabber host you choose. Follow this 

link to learn more about the use of Transports. Follow this link to find out more about setting up 
your instant messaging system. 

  

../../../Content/Chat/Adding%20other%20IM%20networks.htm


  



About Jabber 

Jabber works in much the same way that Email does. There are hundreds of Jabber servers through 
which a client program can connect. Each Jabber user has his or her own account with one of many 
Jabber services. When a message is sent, the message goes from that person's computer to his or 
her nominated Jabber server. This server then sends the message to the recipient's nominated 
Jabber server. 

This way, the Jabber network can not be "down", whereas if the MSN server goes down for 
maintenance, then all MSN users in the world will be disconnected, if one of the decentralized 
Jabber server goes down, only the users registered to that server are affected.  

  



Choosing a Host Server 

Different Jabber servers support different transports, allowing you to connect to different messaging 
networks, such as MSN, ICQ, AIM etc, as well as some local networks such as weather and news 
networks. Therefore, you may wish to look around and find a server that suits you. 

You can find a list of public Jabber servers here,  

  

  

https://xmpp.net/directory.php


About Transports 

Unless you are an avid open source supporter or a Linux user, chances are you have never heard 
about Jabber. People prefer to use proprietary messaging services such as MSN or ICQ, because 
they think and not without reason that the more well known something is the more people use it. 
Jabber, though it does not enjoy the name recognition that MSN and AIM do, can be used to 
connect to almost any of those networks through the use of Transport services. 

Transports are small computer programs installed on Jabber host servers that translate Jabber 
messages and addresses into other formats like MSN and ICQ and send them through their 
respective networks. Transports allow your Jabber client to connect to other networks depending on 
which transports your host server supports. 

Click here to find out how to install and use transports on your Instant Messaging system. 
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About Chat 

The eM Client Chat/Instant Messaging is built on the Jabber and XMPP protocol, which is the open 
standard for instant messaging. It is used by many networks including Google Talk, Live Journal 

Talk, Nimbuzz, Ovi, and thousands of other services run by companies, ISPs around the world. 

  

  

  



Setting up a Chat Account 

In order to use the Chat function, you need to setup a Jabber or Gmail account, see Create New 
Account. 

Tip: if you have a Gmail account then you do not need a Jabber account in order to 
use instant messaging, since Google Talk is already built on the Jabber protocol. 

  

In the account creation window, you can select from 2 possible chat services - Google Talk and 
XMPP/Jabber. 

  

 

  

Creating Jabber Account 

  

Double-click on XMPP/Jabber option and the following window will appear: 

  



 

  

 Select Use existing Jabber account if you already have a Jabber account, in which case you 

will be asked to provide your account info in the next screen and your Chat account creating will be 
completed. 

If you do not have a Jabber account Register new Jabber account and click Next. 

  



 

  

Since the Jabber protocol is hosted by decentralized servers much like IRC, you will be asked to 
select a host server to connect to.  

Tip: This application will suggest a list of free Jabber Hosts, you can type in any 
Jabber hosts you prefer. Note, different Jabber hosts offer different transports to 
different networks. 

  



 

  

Once registration succeeded, you will be asked to provide a username (has to be unique) and a 
password. Once the username and password are accepted, click next to finish registration. 

  

  

Setting up Google Talk 

  

Double-click on Google Talk option and following window will appear: 

  



 

  

Enter your login information and click on the Next button. Finish  

 

  

  

Once you have a Chat account, click on the Online button on the lower right corner to open the 

Chat console. 

  

Here in the Chat console you can set your status  



 

  

Your Chat contacts will be shown in the Contacts panel on top of the Sidebar. You can choose to 

show online contacts only by clicking Options -> Show Online Users Only. 
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Working with Instant Messaging 

This product provides an integrated Instant Messaging module, through which you can perform all 
the essential tasks you can withstand alone chat clients. In this chapter we will walk you through 
the main functions of Instant Messaging. 

  

Messages 

To send a message to your chat contacts, click on their account in the contacts panel in the Sidebar, 

and in the Chat panel double-click on their name. 

 

This will open the chat window . As you can see, every conversation is tabbed in the chat window. 

 

  

There are three quick access icons on the Chat window: Emoticons, Send file and Profile. 

Emoticon  (Smiley) 

Click on the Emoticon icon to insert an emoticon, aka a smiley, to your text message. Because IM 
system is capable of handling multiple chat networks, smileys are always inserted in their text form. 



 

Send File  

Click on Send File button to initiate a file transfer session. As soon as you click on the button, an 
explorer window will appear through which you can select the files you wish to be transferred. 

Profile  

Click on Profile button to view the personal info page of the IM contact you are chatting with. 

  

Authorization requests 

When your acquaintances add you to their IM clients, be it AIM or ICQ or MSN, an authorization 
notice will be sent to you requesting your permission for them to contact you. 

These Contact subscriptions are gathered and managed in this product's IM Authorization Requests 
system. 

It can be accessed through the Main menu under Instant Messaging -> Authorization Requests. 



 

  

In the Authorization Requests Manager window the contacts will be listed that are requesting to add 

you to their contacts list. 

You may view their user profiles by right-clicking the account name . 

You may select authorize or deny authorization to contacts individually by using the buttons in the 
low right-hand corner.  

Once authorized, your contacts will be able to see you and chat with you through their IM clients. If 
you choose to ignore their subscription request, you are effectively preventing them to 
communicate with you through IM. 

  

  

IM Profile 

You can edit and publish your personal profile for your chat contacts on the Jabber network to see. 

To do this, access the IM Profile editing page from the main menu, Instant Messaging -> Change 
my Profile. And select the Account for which you wish to update your profile. Optionally, you may 
also do this through the IM Menu when you click on the IM button in the lower right corner on the 

interface. 



 

  

In the IM Profile window you can enter general information about yourself and details about your 

work, your address and even write a little paragraph about yourself in each of the four information 
tabs in the IM Profile window. 

 

  



When you have finished editing/updating your profile, click Publish to post your changes to the 
network. 

  

  

The Contextual menu 

Another very useful tool in your arsenal to make the most out of this product is the contextual 
menu. As its names suggests, it offers access to different tools, options, utilities depending on 
where it is evoked and what you are doing at the moment. 

  

When you bring up the contextual menu in your contact list, that is if you right click on any part of 
the contact list panel on the Sidebar, you will see the following contextual menu. 

  

 

  

While most of the options on the context menu are rather self-explanatory, there are two options 
which perhaps deserve special mention and those are Communication History and Privacy. 

  

Communication History  

  

Click on Communication History to view your Chat History with a particular contact. 



 

  

The Communication History window offers the standard utilities found on the main interface. 

You can choose to Filter the messages with specific words or further restrict the filter with two other 
filter options: showing /hiding instant messages and showing /hiding emails.  

  

While most of the options on the context menu are rather self-explanatory, there are two options 
which perhaps deserve special mention and those are Communication History and Privacy. 

  

Communication History  

  

Click on Communication History to view your Chat History with a particular contact. 



 

  

The Communication History window offers the standard utilities found on the main interface. 

You can choose to Filter the messages with specific words or further restrict the filter with two other 
filter options: showing /hiding instant messages and showing /hiding emails.  

  

Privacy  

  

When you right click on one of your chat contacts, and select Privacy in the popup menu, you will be 
given the following five options you can apply to the selected contact. 

  

 

  

Ignore User's Status Changes will block the notice that would usually be displayed every time when 

contact's online status changes. 

Ignore Messages will simply block any incoming messages from this particular contact. 



Become Invisible for the User will make you appear to be offline to this particular contact. 

Ignore Everything (Ban User) effectively cuts off any communication with that contact. 

Ignore Nothing restores a contact to the normal level interactivity. 
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File Transfer in IM 

  

This product's Instant Messaging system supports instant exchange of files as well as text 
messages. 

  

Sending a file 

There are several ways to transfer files between you and your contacts in this product's IM system: 

Right click in the Contact panel of the Sidebar to bring up the context menu. In the context menu, 
select Send File... In the Send File window type in the address of a file or browse to find the file to 

be transferred. 

In the Description window, enter a short description of the file which will be displayed along it to the 

recipient. 

When finished, click Send. 

 

  

Alternatively, you can send a file from an active chat window between you and another contact. 



 

In the Chat window, click on the Send File icon  to open a file selection window, through 
which you can choose the file you wish to transfer to your contact. 

  

Accepting an incoming file 

When you receive an incoming file transfer request, a popup notification will be displayed to inform 
you of the request and all the relevant information about the incoming file. Including the requesting 
contact name (displayed in bold), file name, and a short, optional description text about the file. 



 

  

You may choose to either accept or deny the file transfer request in the notification window. Or 

alternatively, you can click on the notification window to bring up the Incoming File Transfer 
window, which will give you a better view of the details of the request. 

 

  

In this window, in addition to all the information contained in the notification window, you can also 
specify a destination folder to save the incoming file to. 



  

  

File transfer log 

The application keeps track of all the incoming as well as outgoing file transfers, all the relevant 
details and transfer progress. 

You may access the File Transfers log by selecting More -> File Transfers 

 

  

In this log you can view your Incoming and Outgoing files by selecting the respective tabs. You can 
also open the transferred files by double clicking on each of the completed transfer entries or click 
on the small folder icon next to the progress bar to open the folder containing the file. 

Click Clear Completed to clear the completed file transfer entries from the log. 

Click Hide to dismiss the File Transfer log. 
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Adding Transports 

Once you have set up your Jabber account, you can add more transports to your Instant 

Messaging system allowing this application to access other instant messaging networks. 

  

To add a Transport, select More ->Service/ Transport in the chat interface. 

  

 

  

In More -> Services/Transport in chat interface, first select the Jabber account you wish to use, 
and then in the Transport list, select a transport you wish to enable, then Click Register to 
register the transport. Click Close to close the Transports window. 

  



 

  

Once you close the Transport Registration window, one Registration Window for each Transport you 

have enabled. You will be prompted for the user name and password and to configure other options 
associated with that transport such as online status, language settings etc depending on the 
transport. Click OK to finish. 

  



 

  

And you are done. The application will automatically import all your contacts from your newly set-up 
instant messaging account into your Contacts roster. You can now start chatting with your chat 
contacts as they log on. 
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Privacy List Management 

Most modern instant messaging clients offer the option to ignore certain unwelcome contacts or 
shield your activities and online status from them. 

The application offers a way to manage your privacy preferences with regards to each individual 
contact in your IM contact list. 

With the help of the Privacy List Management, you can choose whether to be visible to your 
contacts, and be notified of their online activities. 

  

To access the Privacy List Management, select in the Main Menu: Instant Messaging -> Privacy List 
Manager... 

 

  

For each IM account, there are two global lists each governing the interaction between you and your 
contacts in a particular online status: Primary and Invisibility. 

  

The primary status refers to all the visible online statuses you can set application IM module to, 
such as online, away, busy etc. 

The invisibility status refers to when you set your IM online status to invisible. 

  

For each of the global online status lists, you can set the level of interactivity between you and each 
of your contacts individually.  



Once you've chosen a Privacy List, in the Rules window is the list of all your chat contacts. For each 

contact in the list, there are three elements of interaction you can toggle on and off. Contact 
Presence, User Presence, and Messages. 

  

  Contact Presence - this element controls how aware you will be of the contact's presence, in 

other words, whether you will be notified of any changes in your contact's online status. Toggle it 
off to stop receiving notifications about this contact. 

  

  User Presence - this element controls how aware the contact will be of the user, your 

presence. In other words, whether you will be visible to this contact. Toggle it off to appear off line 
to this contact. 

  

  Messages - toggle this icon on and off to receive or ignore messages sent by this contact. 

  

In the Rules list, click on the column corresponding to each of these three elements in the row 
occupied by each contact to toggle on and off each element for that contact. 

Alternatively, you can choose from four presets to collectively configure all the contacts. These 
presets include: 

  

Ignore all - Turns off Contact Presence and Messages for ALL contacts in the list, effectively 

rendering you oblivious of all activities of your contacts. 

  

Don't Ignore anyone - Turns on all three elements for each contact. 

  

Invisible to all - Turns off User presence for ALL contacts, rendering you invisible to all your 

contacts. 

  

Visible to all - Turns on User presence for ALL contacts, making you visible to all your contacts. 

  

Here you can also add chat contacts to your contact list. Just type in the Jabber ID in the text field 
next to JID:  

Once you've finished typing in the JID, click on the add button  to add the contact. 

  

  

With this two dimensional control scheme, you can easily configure whom you wish to interact with 
when you are actively or passively taking part in Instant Messaging. 

  

  

Copyright © 2021 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  



support@emclient.com  



Start an Instant Online Meeting 

If you’d like to directly start an Online Meeting to quickly set up an unscheduled, ad hoc call, you 
can go to New > Online Meeting > then select Online Meeting Provider. 

This will create an online meeting room within the service of the online meeting provider. You can 
then add more people to the call directly within the online meeting service. 

 

  

Note for MS Teams users, using this method will automatically record an event for the current 

time called “Instant Meeting” in your associated Teams account Calendar, or the Calendar of your 

default eM Client account. 
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Schedule an Online Meeting 

For instructions on how to create an instant online meeting, please read here. 

  

To schedule an online meeting, use the New>Event option or go to your Calendar and click the New 

button or double click on a free space in your calendar. 

There will now be a pop-up asking you to choose which type of meeting you want to create. If you 
would like to create an online meeting with Zoom, MS Teams, or Google Meet, then you would 
select “Online Meeting”. If you don’t want to be asked this question every time you go to create an 
event in your calendar, simply click the “Always use this option” button and select the meeting type 

you want to default to. This can also be changed in Calendar Settings. 

 

  

Then you will set up the subject, date, time and participants of the Online Meeting just as you would 
with a standard event. In the Online Meeting field, you can select the online meeting provider, 

based on the online meeting services you’ve added to eM Client. 



 

  

Once you’ve set up the details of the online meeting and clicked the Save & Close button, the event 

in your calendar will automatically update with a link to connect to your online meeting. All the 
event participants will receive this link in their meeting invite, or you can copy the link to share with 
others. 

You can easily see which events in your calendar are Online Meetings by the camera icon on the 
calendar entry. 

  

To join an Online Meeting, simply click the Join Online Meeting button at the top of the event, or 

click on the meeting Link or login to your online meeting service and you should see the event 
scheduled there and ready to join. 
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What is eM Keybook? 

eM Keybook is a public encryption key directory managed by the company eM Client. It’s an online 
service where you can upload and manage your public keys so anyone can easily send you 

encrypted messages and you can easily get public keys of the recipients you want to send 
encrypted messages to. 

  

eM Keybook stores Public keys that you upload and allows for the exchange of Public keys between 
all eM Client users. If the contact you’re writing a new message to has a Public key in the eM 
Keybook directory, eM Client will automatically download and apply it for you when you enable 

encryption for your message. 

  

eM Keybook does not save nor have access to any of your Private keys or passwords. It does not 
give anyone access to your encrypted messages or save any of your encrypted messages on our 
servers. 

  

You can read more about eM Keybook's settings, how to use eM Keybook or check out the article 

about Signing and Encryption on our website. 
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Using eM Keybook 

  

Uploading your own Public Key to eM Keybook 

You can either upload your public key to eM Keybook during the keypair creation or anytime later 

in Menu > Settings > Signatures and Encryption > Certificates and Keys. In the Manage 
Certificates/Keypairs window you can use the Upload to eM Keybook button to make your public 

key available to all eM Client users. 

  

Uploading during creation: 

 

  

Upload after creation: 

 

  

  

Tip: This button might also be available instead under the “More” button if your window is too small 
to display all the toolbar options at once. 

 

  

After choosing to add your public key to eM Keybook, you will receive an email from 
keybook@emclient.com to verify your public key upload to eM Keybook by inputting your password 
for the PGP key (not your general email account password). 



 

Once this is confirmed, your public key will be added to eM Keybook and any eM Client user can 
easily send you PGP encrypted emails. 

How to Remove your Public Key from eM Keybook 

You can remove your key from eM Keybook in the same section where you uploaded it - Menu > 
Settings > Signatures and Encryption >Certificates and Keys. In the Manage Certificates/Keypairs 

window you can use the Remove from eM Keybook button. 

 

  

You can also remove your keys at any time in the Menu > Settings > Signatures and Encryption > 
eM Keybook section – just look up keys for your email address and then use Remove from eM 
Keybook button to delete them from the service.  

This does NOT delete the PGP keypair, it just remove your public key from eM Keybook 

  

How to use eM Keybook to send other eM Client Users an Encrypted Message 

First go toMenu > Settings > Signatures and Encryption > eM Keybook and make sure Enable 
Keybook support is selected. 

Next, start a new email to your intended recipient and make sure the  Encrypt icon  is 

selected. Compose your message and click Send. 



If you haven’t added that person’s public key to your saved keys yet, there will be a pop-up asking 
if you would like to import this user’s public key. Clicking Yes will allow you to import the user’s 

public key and you can seamlessly send them encrypted messages now. 

 

  

If they have not added their public key to eM Keybook (or you don’t have eM Keybook support 
enabled) then you will receive a message like this, asking if you would like to proceed by sending 
the email unencrypted. If you would still like to send that person an encrypted message, you must 
reach out to them directly to ask for their public key and then import it into your eM Client. 
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About Tags 

In this age of multi-tasking, we ourselves play different roles, and have different responsibilities. 
The ability to compartmentalize has become an essential skill, one that can help us bring order into 

this increasingly fragmented world. And that is exactly what this product's Tags do. 

  

Tags are just flags that you can customize and assign to any item. These are electronic post-it notes 
that can at one glance let you know whether an Email, a contact, an scheduled event or a task is 
work related, personal or if it requires your immediate attention. 

Follow these links to learn more about managing Tags, and how to assign Tags. 
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Working with Tags 

  

Tag Manager 

You can access the Tags Manager window by selecting from Menu> Tags. 

 

  

These four panels: Contacts, Mails, Events, Task allow you to manage tags for those four 

different  

 areas. 

Now you can set up your own shortcuts for particular tags.  

  

Add... adds a new Tag, opens up the Tag Editor window. 

Edit... customizes an existing Tag, opens up the Tag Editor window. 

Remove: deletes an existing Tag. 

Move Up/Move Down: affects the order in which the Tags will be arranged in the tag assignment 

drop down menus. 

  

  



Customize Tags 

This product comes with a set of pre-defined, most commonly used tags, such as Business, 
Personal, School etc. You may of course wish to change the pre-defined tags or add your own. 

You can click Add... to add new tags or Edit... to edit existing tags, you will be brought to the Tag 
Editor window 

 

  

Name: Enter or change the name of the label. 

Color: The color of the label that will appear next to your labeled items. Click on Change... to 
bring up a windows standard color pallet with which you can assign a different color to the 
label. 

 



  

Shortcut: choose from the list of various shortcuts to connect them with various tags.  

Use for: Check each item type for which you wish the label to be available. In the sample case, the 

new tag is going to be assigned to Contacts, Calendar Events, Mails and Tasks. 

  

  

Assigning Tags to items 

Whenever you create or edit an item in, be it an Email, a contact, a Calendar Event, or a Task, you 
can assign tags to it, a way to quickly recognize and assess the nature of the item. 

Once tags are assigned, they will be shown when you view the items. 

  

To assign a tag to an item, select it in the drop-down Tag menu, you can assign multiple tags to an 
item. To remove a tag select it again from the list. 

  

Assigning Tags to Calendar Events 



 

  

Assigning Tags to Tasks 



 

  

Assigning Tags to Contacts 



 

  

You may also assign tags to items in their list views. 

 

  

You can switch from Compact layout to Single-line layout by hiding the Message detail or by 
changing the setting in Menu>Settings>Appearance>Layout. 
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Import 

You can import data from your previous email client through the Import Wizard. 

Select File ->Import:  

  

 

  

This product can import emails, contacts and calendar events from Microsoft Outlook, Microsoft 
Outlook Express, The Bat! as well as from external eml, ics, vcf and Windows Address Book files. 

eM Client now also detects from your device what programs were originally installed, so not all 
Import options might be available in your list. 

  

Find out how to: 

• Import from Microsoft Outlook  

• Import from Microsoft Outlook Express 

• Import from Windows Address Book 

• Import from Windows Mail 

• Import from Windows Live Mail 

• Import from Thunderbird 

• Import from folder with .eml files 

../../../Content/Getting%20Started/Import/Import%20from%20Outlook%20MAPI%20(Legacy).htm


• Import data from The Bat! 

• Import events from iCalendar (.ics) 

• Import contacts from VCard (.vcf) 

• Import from .csv file 

• Import from Mbox (.mbox) 

• Import from XML file 

• Import from Microsoft Outlook (Legacy) 
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Import from Microsoft Outlook 

To import your emails, settings, meeting attendees, free-busy. statuses, account passwords and 

much more from Microsoft Outlook Express select  Menu- >File -> Import in the main menu: 

  

 

  

  

Select Import from Microsoft Outlook and click on Next. 

  



 

  

Import whole account(s)  

  



 

  

Select accounts that you would like to import. Please note that you can also choose whether you 
want to import specific items from the selected account (email messages, tasks, contacts, events, 

tags). 

  

Import selected PST data file 

  



 

  

By selecting Import selected PST data file you can import your data directly from PST files , whereas 
MS Outlook does not need to be installed.  

Click on Next to proceed to next window. 

  



 

  

Here select folders you would like to import and click on the Next button. 

  



 

  

Here you can select if you would like to import items to default folders in a specified account or to 
import data to a specific folder.  

Click on Finish button to finish the process of importing from MS Outlook. 



Import from Outlook Express 

To import your emails from Microsoft Outlook Express select Menu ->File -> Import in the main 

menu: 

  

 

  

Select the Import from Microsoft Outlook Express option and click Next: 

  



 

  

Here you can choose whether you want application to import data to default root folders of the 
selected account by choosing the destination account or you can specify the folder path by clicking 

the Select folder... button. 

  



 

  

Next step is to select the folder which is holding your Outlook Express data. You have two options - 
you can try to detect folder automatically or specify the destination of the folder.  

  

Click on Next to finish the process of importing data from Outlook Express.  
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Import Windows Address Book 

To import contacts from Windows Address Book select Menu ->File -> Import in the main menu: 

  

 

  

Select the Import from Windows Address Book option and click Next: 

  



 

  

You can choose from two options: Try to detect file location or Use specific file. Next select the 

folder in which the contacts will be stored. 

Click Finish to complete the importing process and close the wizard. 
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Import from Windows Mail 

To import your messages from Windows Mail click Menu -> File-> Import, 

 

   

choose the option Import from Windows Mail and click Next: 



 

  

Here you can select either to import whole account(s) or selected folders from Windows Mail. 

Do not forget to specify the folder into which the imported messages will be stored. 

Importing whole account(s) 

Since the process of importing whole account(s) from Windows Mail is the same as in the case of 

Windows Live Mail, please visit this chapter to find out how to do it. 

Importing from selected folders  

Since the process of importing selected folders from Windows Mail is the same as in the case of 

Windows Live Mail, please visit this chapter to find out how to do it.  
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Import from Windows Live Mail 

To import your messages from Windows Live Mail click on Menu -> File -> Import 

  

 

  

choose the option Import from Windows Live Mail and click Next: 

  



 

  

Here you can select either to import whole account(s) or selected folders from Windows Live Mail. 

  



Importing whole account(s) 

 

  

Finally, select accounts you want to import. You can also select what type of data you want to 
import from particular account.  

  

Importing from selected folders 

  



 

  

Choose whether you want to import items to default folders in a specified account like Inbox, Sent 
and Trash or to import data to specific folder. With the first option all other imported folders will be 

created in a root folder of the selected account.  

Click on Next to proceed to the next window. 

  



 

  

Here select Windows Live Mail folders you would like to import and then click on the Finish button 

to finish the process of importing.  

  

  

Copyright © 2021 eM Client s.r.o. 

Thámova 18 
 Prague, 186 00 
Czech Republic  

support@emclient.com  



Import from Mozilla Thunderbird 

To import your emails, events, tasks and rules from Mozilla Thunderbird select File -> Import in the 

main menu: 

  

 

  

Select the Import from Mozilla Thunderbird option, click Next. 

  



 

  

Here you can select either to import whole account(s) or selected folders from Mozilla Thunderbird. 

  

Importing whole account(s) 

  



 

  

Finally, select accounts you want to import.You can also select what type of data you want to import 
from particular accounts.  

  

Importing selected folders 

  



 

  

Here select Thunderbird folder/s which you would like to import. 

  



 

  

Choose whether you want to import items to default folders in a specific account like Inbox, Sent 
and Trash or to import data to specific folder. With the first option all other imported folders will be 

created in a root folder of the selected account.  

Click on Next to finish the process.  
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Import from .eml file 

It's possible to import your emails from an .eml file. This can be done very easily using our import 
wizard. 

Click on Menu ->File ->Import in the main menu and following window appears: 

 

  

Choose the Import from folder with .eml files option and click Next. Another window appears. 

  



 

  

Click Browse...to find the folder in which the .eml files are located.  

If the folder containing your .eml files contains subfolders, check the Include subfolders checkbox 

to import all .eml files contained under the specified location. 

Click Select folder... next to the second address bar to select a mail folder in which your messages 

will be stored. 

Click Finish to complete the importing process and close the wizard. 
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Import from The Bat! 

To import emails from The Bat! select Menu ->File -> Import in the main menu: 

  

 

Select the Import from The Bat! option, click Next. 

  



 

  

Click Select folder... to select a mail folder in which your messages will be stored. 

Click Finish to complete the importing process and close the wizard. 
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Import Events from iCalendar (.ics) 

To import iCalendar events from .ics files select Menu -> File -> Import in the main menu: 

  

 

  

Select the Import events from iCalendar (.ics) option and click on Next>: 

  



 

  

Click on Browse... to specify an Internet location or a local folder containing the .ics files. 

Click on Select folder... next to the second address bar to select a calendar folder in which your 

events will be stored. 

Click on Finish to complete the importing process and close the wizard. 
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Import contacts from VCard (.vcf) 

To import your contacts from external vcf files, select Menu ->File ->  Import in the main menu: 

  

 

  

Select the Import contacts from VCard (.vcf) option and click Next: 

  



 

  

Click Browse...to find the folder in which the .vcf files are located. 

If the folder containing your .vcf files contains subfolders, check the Include subfolders checkbox to 

import all .vcf files contained under the specified location. 

You can also select the folder into which the imported contacts will be stored. 

  

Click Finish to complete the import and close the wizard window. 
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Import from .csv file 

CSV ( or Comma-separated values file format) represents a set of file formats used to store tabular 
data in which numbers and text are stored in plain textual form that the user can read in a text 
editor. This product also allows you to import contacts from this file format.  

To import contacts from .csv files select  File -> Import in the main menu: 

  

 

Now choose the option Import contacts from .csv file and then click on Next> 

  



 

  

Now choose the .csv file from which you would like to import contacts by clicking on the Browse... 
button. 

As you can see, this application also allows you to choose different types of delimiter - choose 
between two options Detect delimiter automatically for automatic detection of delimiter or the 

second option Use semicolon as a delimiter instead of comma. 

  

Click on Select folder...  next to the second address bar to select the folder in which the contacts will 

be stored. 

Click on Next to finish the process of importing. 
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Import from Mbox File 

Mbox is a term used for the file format (.mbox) which holds collections of electronic mail messages. 
These Mbox files can be easily imported. To import Mbox file select Menu-> File -> Import and 

following window will appear. 

  

 

  

This window will appear: 

  



 

  

Now you can easily select an Mbox file (.mbox) that you want to import by clicking on the Browse... 
button and then selecting proper Mbox file. Do not forget to specify mail folder (by clicking on 

Select folder... button) in which you want the selected Mbox file to be imported.  
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Import Settings from XML file 

To import your settings from an external XML file, select Menu ->File -> Import in the main menu: 

  

 

  

Select the XML file by clicking on the Select file button and finally click on the Finish button to finish 

the process of importing. 



Export 

To get to the export menu, click on Menu -> File -> Export... 

eM Client supports export of data into standard files for each item type: 

•  You can export emails to .eml files. 

•  You can export contacts to .vcf files.  

•  You can export events to .ics files. 

•  You can export tasks to .ics files.  

•  You can export settings to .xml file. 
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Export 

To get to the export menu, click on Menu -> File -> Export... 

eM Client supports export of data into standard files for each item type: 
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Export E-mails to .eml Files 

To export your emails from the application to .eml files, click on Menu ->File -> Export in the 

main menu and the following window will appear: 

  

 

Choose the Export to .eml files option and click Next>.  

  



 

  

Check all the items you want to export and click Next>. 

  



 

  

You can change the default location to save the exported .eml files by clicking the Browse button 

and select the desired destination directory. Click Finish to finish exporting your email contents. 
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Export Contacts to vCard Format.  

  

To export your contacts to vCard format, click on Menu ->File -> Export in the main menu and 

following window will appear: 

  

 

  

Choose the Export contacts to .vcf files option and click Next.  

  



 

  

Check all the items you want to export and click Next>. 

  



 

  

You can change the default location to save the exported .vcf files by clicking the Browse button 

and select the desired destination directory. You can also choose whether you want to export all 

contacts into a single file or export each contact into a separate file. Click Finish to finish exporting 

your contacts. 



Export Events to iCal Format 

  

To export events to iCal format, click on Menu ->File -> Export in the main menu and the 

following window will appear:  

  

 

  

 Choose the Export events to .ics files option and click Next. 

  



 

  

Check all the items you want to export and click Next>. 

  



 

  

You can change the default location to save the exported iCal files by clicking the Browse button 

and select the desired destination directory. You can also choose whether you want to export all 

events into a single file or export each event into a separate file. Click Finish to finish exporting 

your events. 

  



Export Tasks to .ics Format 

To export tasks to iCal format, click on Menu ->File -> Export in the main menu and the 

following window will appear:  

  

 

  

 Choose the Export tasks to .ics files option and click Next.  

  



 

  

Check all the items you want to export and click Next>. 

  



 

  

You can change the default location to save the exported iCal files by clicking the Browse button 

and select the desired destination directory. You can also choose whether you want to export all 

tasks into a single file or export each task into a separate file. Click Finish to finish exporting your 

tasks. 

  



Export Settings to .xml File. 

To export settings to xml format, click on File -> Export in the main menu and the following 

window will appear: 

  

 

  

Choose the Export settings to .xml files option and click Next. 

  



 

  

In this window choose the types which you want to export: Settings, Rules, Accounts, Save 
Passwords. Finally click on the Finish button.  

Remember to specify the destination file.  

  

You can also choose to protect your Settings file with a password. 



Widgets 

Widgets are useful add on applications that can be customized to personalize your account. You can 
use them to display your favorite web pages or to read the latest news from a RSS feed. 

You can access your widgets by clicking on the Widgets button on the lower-left-hand corner. 

For information on how to set up your Widgets, see the appropriate Settings section. The same 

settings screen can be accessed by right-clicking any empty spot in the central panel. 

To remove a widget from the central panel, right click the header of the widget you wish to remove 

and click on Remove widget 

The individual widget windows can be resized and moved around the central panel by drag and 
drop. 
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Sidebar 

The Sidebar will allow you to quickly access your contacts and their details, your communications 
history with a specific contact, list of tasks that you planned to do and a list of attachments 
exchanged between you and specific contacts. 

  

There are five sections that make up the Sidebar: Search Bar,  Contact details, Agenda, Chat 
and Invitations. 

Invitations are not displayed by default, but this section will display as soon as you receive an 
invitation.  

You can hide the Sidebar by clicking on the arrow near the right edge of the bar. 

 

Just click on the arrow to hide the sidebar. 

Search Bar  

Using the search bar, you can simply search for your emails. A list of several useful command tools 
will appear in the context menu when you type a question mark in the search bar. 

 

  

Click on the pointing down arrow to bring up the context menu for search bar: 

  

 



  

Here you can select or deselect area/areas that you want to be searched.  

  

Contact Details 

 Contact Details window provides you with quick access to contact details of a selected contact that 

include your contact's email address, mobile/telephone number, skype contact details, and chat 
message contacts.  

  

 

  

  

Search Bar - Just start typing and search bar will appear. While using the search bar, you can 

search for all types of messages (i.e. mails, chat messages) that you have exchanged with 
your contact in the past. You can switch between History and Attachments by simply 
clicking on the proper button. 



 

  

 History panel is called so because it gathers all your written conversations with 
the contact. It includes Emails, IM Chat messages and also Skype chat messages into one 

chronological communications log. And thereby provide you with a holistic sense of your 
communications with that particular contact. 

Attachments panel contains all the attachments that are attached in the 

emails exchanged between you and the contact. Attachments are sorted in a chronological 
order, which you can customize(ascending/descending) in the Attachment history Options.  

  

Contact Details settings -You can customize your Contacts Details settings simply by left-

clicking on the Options button. This options button  will appear by hovering with your mouse 

cursor over the area next to the Contact Details header. You can choose the manner in which you 
would like to sort the order of the messages (descending/ascending) and you can also adjust what 
type of messages (mails, chat messages, skype calls) you would like to display or hide. By checking 
the option Include Other Senders you can adjust if you want to include the third party of the 

conversation (f.e. emails , where other participants are included in Bcc or Cc of the particular email) 

and by checking the option Include Entire Domain you can adjust displaying of all emails that may 

have different name of sender/addressee, but the same domain in the particular email address. You 
can select Choose Folders... to select folders from which you would like the contacts to be 

displayed. 



 

  

  

  

Agenda Section 

Agenda section provides you a quick review of the tasks that you planned to do, upcoming 
birthdays, upcoming events and email messages marked as flagged. All those items are sorted in 

the order of the upcoming date, i.e. the most up-to-date items will be always on top.  

Search bar - you can use the search bar for searching within your tasks and events by simply 

starting to write and the search query will appear. Simply enter the "key word" of the item that you 

want to find and the requested item will appear.  

 

  

Adding new task - You can add new tasks directly from the sidebar. First and foremost, write the 

title of the new tasks in the field (lower arrow in the picture) and then press enter. Newly created 
task will appear in the "Date:Today" section. By double-clicking on the task the window with 
possible editing of the newly created item will appear. 

  

For creating and editing tasks see Tasks -> Creating and Editing Tasks for more detailed 

description.  

You can choose folders from which you would like to display upcoming events, birthdays, tasks and 
flagged emails, simply by left-clicking the down-pointing arrow on the left in the upper section of 



Agenda. Context menu will appear and your next step is choose the option Choose Folders... and a 

window with list of various folders will appear as you can see in the following picture.  

  

 

  

Moreover, you can choose the time horizon in which the displayed upcoming birthdays and events 
will be shown. This time horizon can be changed by selecting various points of time from the 

context menu, again the one which is evoked by the small arrow.  

  



 

  

Show of Flagged Mails, Upcoming Birthdays, Upcoming Events and Tasks is active by default.  

  

Contact list/Chat  

This product has built in Instant Messaging support , which will allow you to communicate instantly 

with other users of Jabber Instant Messaging network as well as many other Jabber compatible 
networks such as Google Talk, ICQ, AIM, Facebook, Live Messenger etc. This section allows you to 
view all your added contacts and chat accounts. You can also use the search bar for searching 
within your contact list. 

  

 

Search bar - You can search in your contacts by entering the first few letters (e.g. if you put in "d" 

you will see only those contacts that start with this letter). 

Chat Options - You can customize your chat settings simply by left-clicking on the Options icon 

which will appear by hovering with your mouse cursor next to the chat header. Here you can set up 



several chat options, for example showing/hiding avatars in chat, showing online users 
only or showing groups. You can also sort contacts either alphabetically or by online status. 

However, it is not possible to use groups together with the mode of sorting according to the online 

status. There has been added a special utility - Undock. You may be already familiar with this 

tool from previous versions of this product, where this action was invoked by Detach window 
button. The Undock utility works exactly the same way - by clicking this button you can 
detach the contact window and move it around your screen as you wish. To return it to its 
original position, just click the same button again, or click on the Return back button that 
appeared on the window's original location. When the window is detached, you can toggle 
Always on top to be able to use the window even if the application is minimized. Undock can 
be also evoked simply by pulling the chat header away.  

 

by clicking on the Add contact button you will be allowed to create a new contact - the following 

window will be displayed 

  

 

  

You can type-in a name that you would like to be displayed by the IM contact or you can click on 
Get button by which the application will try to retrieve the username based on the Jabber ID.  

You can also add newly created IM contact to the appropriate group by selecting it from the list of 
groups that you are currently using.  

  



You can move contacts between groups simply by drag-and-dropping them, or by right-clicking the 
contact you wish to move and selecting the group you want to move the contact into from the 
context menu. You can also create a new group and move the contact into it.  

 

  

 

  



 

Click on any contact in the Contacts window and you will find all the details on the selected contact 

displayed in the Contact details window.    

  

For more detailed description of IM see section Instant Messaging. 
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 Technologies (Advanced) 

The following section contains information about technologies and advanced features in eM Client. 

Calendar protocols 

Email protocols 

Chat 

Security protocols 

Security Certificates 

Startup parameters 
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What is eM Keybook? 

eM Keybook is a public encryption key directory managed by the company eM Client. It’s an online 
service where you can upload and manage your public keys so anyone can easily send you 

encrypted messages and you can easily get public keys of the recipients you want to send 
encrypted messages to. 

  

eM Keybook stores Public keys that you upload and allows for the exchange of Public keys between 
all eM Client users. If the contact you’re writing a new message to has a Public key in the eM 
Keybook directory, eM Client will automatically download and apply it for you when you enable 

encryption for your message. 

  

eM Keybook does not save nor have access to any of your Private keys or passwords. It does not 
give anyone access to your encrypted messages or save any of your encrypted messages on our 
servers. 

  

You can read more about eM Keybook's settings, how to use eM Keybook or check out the article 

about Signing and Encryption on our website. 
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Security Certificates and Keys 

 "Three may keep a secret, if two of them are dead." 

 famously said Benjamin Franklin. We may smile at Mr. Franklin's penchant for the theatrical, and 
admire at the gothic fantasies inspired by the notion of secrets, but in the modern digital world, the 

business of keeping secrets is a much less Shakespearian one. 

  

The exact science behind modern cryptography is beyond the scope of this tutorial, suffice to know, 
that sometime between the death of Jimi Hendrix and the rise of Margaret Thatcher, computer 
scientists mixed a few prime numbers with a dash of mathematical magic, and out came 
Asymmetric key algorithms. 

And the Public-Key Cryptography is a methodology that uses asymmetric key algorithms to protect 
communications or authenticate messages. The concept of asymmetric keys has done away with the 
requirement of a secure initial exchange of one or more secret keys as is required when using 

symmetric key algorithms. 

Lying at the heart of the Public-Key Cryptography is two sets of numbers, the public key and the 
private key. Both the public and the private keys are needed for encryption /decryption but only the 

owner of a private key ever needs to know it. Using this system, the private key never needs to be 
sent across the Internet. 

The private key is used to decrypt text that has been encrypted with the public key. Thus, if I send 

you a message, I can find out your public key (but not your private key) from a central 
administrator and encrypt a message to you using your public key. When you receive it, you 
decrypt it with your private key. In addition to encrypting messages (which ensures privacy), you 
can authenticate yourself to me (so I know that it is really you who sent the message) by using 
your private key to encrypt a digital certificate. When I receive it, I can use your public key to 
decrypt it.  

 

  

Certificates 

In practice, secure messages being passed between computers rely on Certificates and Keys. 
Electronic documents which contain digital signatures to bind together digital keys with an identity 
— information such as the name of a person or an organization, their address, and so forth.  



And Email security is based on digital signatures, encryption and decryption of messages through 
the use of certificates. 

  

eM Client supports S/MIME certificates and PGP keys. 

S/MIME 

Secure / Multipurpose Internet Mail Extensions or S/MIME is a standard for public key encryption 
and signing of emails. 

Before S/MIME can be used, one must obtain and install an individual key/certificate either from 
one's in-house certificate authority (CA) or from a public CA such as one of those listed below. Best 
practice is to use separate private keys (and associated certificates) for Signature and for 

Encryption, as this permits escrow of the encryption key without compromise to the non-repudiation 
property of the signature key. Encryption requires having the destination party's certificate on store 
(which is typically automatic upon receiving a message from the party with a valid signing 
certificate). While it is technically possible to send a message encrypted (using the destination party 
certificate) without having one's own certificate to digitally sign, in practice, the S/MIME clients will 
require you install your own certificate before they allow encrypting to others. A typical basic 
personal certificate verifies the owner's identity only in terms of binding them to an email address 
and does not verify the person's name or business. The latter, if needed (e.g. for signing contracts), 
can be obtained through CAs that offer further verification (digital notary) services or managed 
Public Key Infrastructure service. Depending on the policy of the CA, your certificate and all its 
contents may be posted publicly for reference and verification. This makes your name and email 
address available for all to see and possibly search for. Other CAs only post serial numbers and 

revocation status, which does not include any of the personal information. The latter, at a minimum, 
is mandatory to uphold the integrity of the public key infrastructure. 

  

PGP 

Pretty Good Privacy or PGP is a public key encryption program that has become the most popular 
standard for email encryption - it follows the OpenPGP standard (RFC 4880) for encrypting and 
decrypting data. 

Pretty Good Privacy uses a variation of the public key system- each user has an encryption key that 
is publicly known and a private key that is known only to that user. To send encrypted messages 
you need the public key of your recipient. To decrypt a message sent to you, you will use your 
private key to decrypt it. 
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Security protocols 

TLS and SSL protocols 

Transport Layer Security (TLS) and its predecessor, Secure Sockets Layer (SSL), are cryptographic 
protocols that provide secure communications on the Internet for web browsing, email, Internet 
faxing, instant messaging and other data transfers. There are slight differences between SSL and 
TLS, but they are largely the same. 

TLS involves three basic phases: 

1.  Peer negotiation for algorithm support 

2. Key exchange and authentication 

3. Symmetric cipher encryption and message authentication 

During the first phase, the client and server negotiate cipher suites, which determine the ciphers to 
be used, the key exchange and authentication algorithms, as well as the message authentication 
codes (MACs). The key exchange and authentication algorithms are typically public key algorithms, 
or as in TLS-PSK pre-shared keys could be used. The message authentication codes are made up 
from cryptographic hash functions using the HMAC construction. 
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Calendar protocols 

CalDAV protocol 

CalDAV or Calendaring Extension to WebDAV is a standard allowing the client to access scheduling 
information on a remote server. CalDAV works by modeling events, which may be meetings or 
appointments or other engagements, as HTTP resources. Events are encoded in standard iCalendar 
format and organized into WebDAV collections to allow browsing and synchronization. A CalDAV 

server supports a number of operations such as generating free-busy time reports and expanding 
recurring events. With this functionality, a user may synchronize his or her own calendar to a 
CalDAV server, and share it among multiple devices or with other users. The CalDAV protocol also 
supports other non-personal calendars, such as calendars for sites or organizations. 

WebDAV protocol 

Web-based Distributed Authoring and Versioning, or WebDAV, is a set of extensions to the 
Hypertext Transfer Protocol (HTTP) which allows users to collaboratively edit and manage files on 
remote web servers. The group of developers responsible for these extensions was also known by 

the same name and was a working group of the Internet Engineering Task Force. The protocol 
facilitates "Intercreativity", making the Web a readable and writeable medium. The protocol 
provides functionality to create, change and move documents on a remote server (typically a web 
server or "web share"). This is useful for, among other things, authoring the documents hosted on a 
web server, but can also be used for general web-based file storage that can be accessed from 
anywhere. Important features in the WebDAV protocol include locking (overwrite prevention), 
properties (creation, removal, and querying of information about the author, modified date, etc.), 
namespace management (ability to copy and move Web pages within a server's namespace) and 
collections (creation, removal, and listing of resources). Most modern operating systems provide 
built-in support for WebDAV. With the right client and a fast network, it can be almost as easy to 
use files on a WebDAV server as those stored in local directories. 

  

Some servers can have their own protocols for Calendar, one that we support is Google Calendar. 
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Supported protocols 

IMAP protocol 

The Internet Message Access Protocol (commonly known as IMAP or IMAP4) is an application layer 
Internet protocol operating on port 143 that allows a local client to access email messages on a 
remote server. IMAP4 and POP3 are the two most prevalent Internet standard protocols for email 
retrieval. Virtually all modern email clients and servers support both. 

IMAP supports both connected (online) and disconnected (offline) modes of operation. E-mail clients 
using IMAP generally leave messages on the server until the user explicitly deletes them. This and 
other facets of IMAP operation allow multiple clients to access the same mailbox. Most email clients 

support either POP3 or IMAP to retrieve messages. However, fewer Internet Service Providers 
(ISPs) support IMAP. 

E-mail messages are generally sent to an email server that stores received messages in the 

recipient's email mailbox. The user later retrieves these messages with either a web browser or an 
email client that uses one of a number of email retrieval protocols. While some clients and servers 
prefer to use vendor-specific, proprietary protocols, most support the Internet standard protocols 
SMTP for sending email and POP3 and IMAP4 for retrieving email, allowing interoperability with 
other servers and clients. For example, Microsoft's Outlook client typically uses a proprietary 
protocol to communicate with an Exchange server as does IBM's Notes client when communicating 
with a Domino server, but all of these products also support SMTP, POP3, and IMAP4. 

IMAP allows users to access new messages instantly on their computers, since the mail is stored on 
the network. With POP3, users either download the email to their computer or access it via the web. 
Both methods take longer than IMAP, and the user must either download any new mail or "refresh" 
the page to see the new messages. 

Advantages over POP3 protocol: 

• Connected and disconnected modes of operation 

• Multiple clients simultaneously connected to the same mailbox 

• Access to MIME message parts and partial fetch 

• Message state information 

• Multiple mailboxes on the server 

• Server-side searches 

  

Case-sensitivity for IMAP folders 

Although RFC 3501 (IMAP protocol) treats folder names as case sensitive (with the exception of 
"INBOX" folder) the actual behavior varies with different servers. Some servers allow case sensitive 
folder names, while others treat names differing only in lower/upper case letters to be equal. It may 

depend on the platform or file system the server is running on. Moreover, it may even depend on 
the folder hierarchy where some parts are case sensitive (eg. personal folders), while others are not 
(eg. archive stored on a different file system). RFC 3501 provides no provisions for detecting 
whether a server or particular folder hierarchy is case sensitive or not. This all stems from the 
original design of the IMAP to work on a variety of existing message stores. It doesn't accurately 
reflect the current situation where many IMAP implementations are deployed as cloud services or 
where a message store format is dictated by particular server implementation. 

Similarly, clients don't always handle case sensitivity correctly. For clients that use the local file 
system as folder storage, the case sensitivity of the file system could play a role. Traditional MBOX 
or MailDir storage systems will behave as case-sensitive on most Windows systems thus causing 
issues when server contains conflicting folder names differing in a letter case. 

In eM Client we try to preserve the case of folder names as entered by the user or sent by the 
server. However, we do not allow two folders with the same name differing by the letter case to be 
present at the same level in a hierarchy. We have to work with a large variety of servers and 
interoperate with mailboxes accessed by multiple different clients (including mobile ones). In 
addition, we allow offline operation where we cannot immediately get a feedback from a server on 



what operations succeeded and which one didn't. This involves many use cases where 
interoperability problems could occur if full case-sensitivity was allowed. The number of servers and 
clients properly supporting case-sensitivity folder names was deemed so small that we found 
supporting it was not worthwhile 

  

POP3 protocol 

Post Office Protocol version 3 (commonly known as POP3) supports end-users with intermittent 
connections (such as dial-up connections), allowing these users to retrieve email when connected 
and then to view and manipulate the retrieved messages without needing to stay connected. 
Although most clients have an option to leave mail on server, email clients using POP3 generally 
connect, retrieve all messages, store them on the user's PC as new messages, delete them from the 
server, and then disconnect. 

The fundamental difference between POP3 and IMAP4 is that POP3 offers access to a mail drop; the 
mail exists on the server until it is collected by the client. Even if the client leaves some or all 
messages on the server, the client's message store is considered authoritative. In contrast, IMAP4 
offers access to the mail store; the client may store local copies of the messages, but these are 
considered to be a temporary cache and the server's store is authoritative. 

SMTP protocol 

Simple Mail Transfer Protocol (commonly known as SMTP) is a relatively simple, text-based 
protocol, in which one or more recipients of a message are specified (and in most cases verified to 
exist) along with the message text and possibly other encoded objects. The message is then 
transferred to a remote server using a procedure of queries and responses between the client and 
server. To do this a mail client must use POP3 or IMAP. Another SMTP server can trigger a delivery 
in SMTP using ETRN. 

Either an end-user's email client, a.k.a. MUA (Mail User Agent), or a relaying server's MTA (Mail 
Transport Agents) can act as an SMTP client. An email client knows the outgoing mail SMTP server 
from its configuration. A relaying server typically determines which SMTP server to connect to by 
looking up the MX (Mail eXchange) DNS record for each recipient's domain name (the part of the 
email address to the right of the at (@) sign). Conformant MTAs (not all) fall back to a simple A 
record in the case of no MX. Some current mail transfer agents will also use SRV records, a more 

general form of MX, though these are not widely adopted. (Relaying servers can also be configured 
to use a smart host.) The SMTP client initiates a TCP connection to server's port 25 (unless 
overridden by configuration). SMTP is a "push" protocol that does not allow one to "pull" messages 
from a remote server on demand.  

Tip: If you are not sure whether to use POP3 or IMAP protocol, then use IMAP 
because of significant advantages over POP3. 
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Chat Protocols 

Introduction 

Instant messaging provides the instantaneous communication of a telephone call, while avoiding the 
feelings of directness and confrontation of a face-to-face meeting with the detachment of written 
correspondence, making instant messaging a popular and flexible form of communication. It allows 
two or more users to exchange text information in real time.  

There are a number of IM protocols. The most widely used is the ICQ protocol. However we have 
decided on the Jabber protocol because Jabber has several significant advantages over the ICQ 
protocol. 

The Jabber protocol is particularly popular in the corporate environment. It's hosted on distributed 
servers which provides uninterruptible service, and it's an open source protocol, so it can be 
adapted to work with many other protocols. 

Jabber protocol 

Jabber is a extensible Instant Messaging protocol and it has accumulated various features over time 
such as Voice over IP and file transfer signaling. Unlike most instant messaging protocols, it is an 
open standard, which makes it more reliable. Like email, Jabber is an open system, meaning 
anyone who has a domain name and a suitable Internet connection can run their own Jabber server 
and talk to users on other servers. The standard server implementations and many Jabber clients 
are also freeware or open source software. 

Advantages of Jabber protocol 

• The architecture of the Jabber network is similar to email; anyone can run their own Jabber 
server and there is no central master server.  

• No royalties are required to implement support of these specifications and their development 
is not tied to a single vendor.  

• Jabber servers may be isolated from the public Jabber network (e.g. on a company intranet), 
and robust security (via SASL and TLS) has been built into the core specifications.  

ICQ support 

The support of ICQ is done through the use of a transport, small computer program that sits on the 
server and translates and Jabber messages into other IM formats. In order to communicate with 
ICQ and other IM users, you have to register the transport. This product will help you setup your 

account and customize your account details. 
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Startup parameters 

You can use a number of different startup parameters to simplify your work. 

  

Here is a short overview: 

  

/dblocation PATH 

This parameter will determine which folder will eM Client load the main database from. If the given 
folder does not exist, eM Client will create the folder and a new, empty database in it. Without this 
parameter, eM Client will load the database from the currently set default location. 

  

/localmutex 

Use this parameter when deploying the application in a Remote Desktop Services or Terminal 
Services environment where accessing global mutexes (short for „mutual exceptions“ in 
programming) is forbidden – the application will use local ones instead. 

  

/mailurl RECIPIENT 

Use this parameter to create a new message with a pre-defined email address compliant with RFC 
6068. Example: MailClient.exe /mailurl "mailto:user@example.org?subject=hello&body=bodytext". 

  

/open PATH 

With this parameter you can open any .eml, .msg, .vcf, or .ics file in eM Client. 

  

/newmail 

This parameter will open a window to compose a new mail. 

  

/newcontact 

This parameter will open a window to create a new contact. 

  

/newevent 

This parameter will open a window to plan an event. 

  

/newtask 

This parameter will open a window to create a new task. 

  

/importsettings PATH [-s] [-p PASS] 

This parameter defines a file which contains eM Client settings and its password, which needs to be 
used to import the data. It needs to be an .XML file and can contain application settings, account 
configuration, templates, quicktexts, and rules. PATH is the location of the file. The rest of the 
parameter options are optional. [-s] stands for „silent“ and means that the settings will be imported 

without opening the UI. [-p PASS] is for inserting the password, if there is one protecting the file. 

Example: MailClient.exe /importsettings "c:\Temp\settings.xml" -s -p MyPassword 

  



/activate 

If this parameter is used on startup, eM Client will try to activate a license. For activation to be 
possible eM Client needs to have a LastActivationKey entry in its database with a valid Activation 
key. Usually, the LastActivationKey value is set using the /importsettings parameter. 



 About eM Client 

Company Information 

eM Client Ltd. is a young software company on a mission to provide the best desktop email client for 
Windows and macOS on the market.  

We combine our previous experience with both email and calendaring software to create a powerful, 
but easy to use email client. 

  

Contact Information 

E-mail: 

Support & bugs - support@emclient.com 

Suggestions - suggestions@emclient.com 

Sales Department - sales@emclient.com 

  

Address: 

eM Client s.r.o 

Thámova 18 

Prague, 186 00 

Czech Republic 
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